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Manual E900
Foreword
This manual is a programming and function description for the 
operator terminals E900 and E910 and the programming soft-
ware MAC Programmer+. MAC Programmer+ and SW-MTA-
WIN are the same programming software. In the manual we 
assume that a PLC system from Mitsubishi Electric is connected 
to the terminal. When using other PLC brands we refer to the 
respective driver manual for the PLC for specific details. The 
functions in the terminals are the same, regardless of the termi-
nal used. Beside this manual, the following manuals are also 
available:
– MELSEC FX, Programming manual

– MELSEC FX, System manual

– A-CPU, Programming manual

– E900/E910, Installation

– IFC PBDP, Manual

– IFC 128E

– IFC MC

– IFC PI

– IFC ETTP, IFC ETCX

 MITSUBISHI ELECTRIC EUROPE B.V. 2000

All examples in this manual are used solely to promote understanding of 
how the equipment works and its operation. Mitsubishi Electric Europe b.v. 
take no responsibility if these examples are used in real applications.

Because of the great many application areas for this equipment, the user 
himself must acquire the appropriate knowledge needed to use the equip-
ment correctly for particular applications.

Mitsubishi Electric Europe b.v. absolves itself of all responsibilities for dam-
age and injuries that may occur during installation or use of this equipment.

Mitsubishi Electric Europe b.v. absolves itself of all responsibilities for any 
damage caused by modifications made to the equipment. 





Safety precautions
Safety precautions

General
– Check the delivery for transport damage. If damage is found, advise 

your supplier.

– The product fulfils the requirements of article 4 of EMC directive 
89/336/EEC.

– Do not use the product in an environment with high explosive hazard.

– Modifications, changes, additions and/or alterations to the product are 
forbidden.

– Use with this product only parts and accessories manufactured accord-
ing to specifications of Mitsubishi Electric Europe b.v.

– Read the installation and operating instructions completely and 
carefully prior to installation, use, or repair of this product.

– This equipment should only be operated by qualified personnel.

At installation
– The product is designed for stationary installation.

– Install the product according to the accompanying installation instruc-
tions.

– The product must be grounded according to the accompanying instal-
lation instructions.

– This equipment must be installed by qualified personnel.

– High voltage, signal and supply cables must be separated. 

– The product should not be installed in direct sunlight.

In use
– Keep the equipment clean.

– Emergency stop and other safety functions should not be controlled 
from the terminal.

– Do not touch the keys, displays, etc. with sharp objects. 
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Service and maintenance
– The agreed warranty applies. 

– Clean the display and face with a soft cloth and mild detergent. 

– Use batteries specified by Mitsubishi Electric Europe b.v. Batteries 
should be changed by qualified personnel. The person changing the 
batteries should be grounded during the operation; e.g. with a 
grounded wrist strap. 

– Repairs should only be made by qualified personnel. 

At disassembly and scrapping
– Local regulations apply concerning recycling of products or part.

– Please note that the electrolyte condenser and display contain hazard-
ous substances.
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Introduction
1 Introduction

The pace of production in today’s industrial work environment increases 
steadily. At the same time, the operator’s job responsibilities increase and 
become more comprehensive. Quickly and simply, the operator must get 
machine status information and, equally simply, must be able to control 
the machine’s operation. The PLC system’s functions increase and become 
more advanced, making it possible to effectively and efficiently control 
complicated processes. With the operator terminal from Mitsubishi Electric 
Europe b.v., human-machine communication is made simple and safe – 
even for the most advanced processes. 

The graphical operator panels were developed to meet the requirements 
of man-machine communication for supervision and control in a variety 
of usage areas in manufacturing and process industries, etc. The terminal 
simplifies the operator’s work because it is easily adapted to the opera-
tor’s work environment. This means that the operator can continue to use 
the terms and protocols he or she is familiar with. 

In the terminal, projects can be built up as menu hierarchies, or as sequences. 
A menu hierarchy comprises a main screen (with, for example, an over-
view) and a number of subsequent screens with more detailed infor-
mation for a particular section. The operator can select which screen is 
displayed. 

In the operator terminal, a screen is called a block. 

Main menu

Recipe Motor status Temperature Film quality
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A sequence starts with a main menu, from which the operator chooses a 
sequence where the blocks are displayed in a pre-set arrangement. Nor-
mally, the blocks are controlled by the PLC program. 

The terminal’s functions enable either graphical or alphanumeric presen-
tation and control. Additionally, there are functions for alarm handling, re-
port printout, realtime trend, recipe handling, time control, and more. 

The terminal’s functions are not only simple to manage, they also provide 
clear cost advantages compared to conventional systems with buttons, 
indicator lamps, time relays, preset counters, and seven-day clocks. The 
terminal also offers functions which facilitate a more comprehensive use 
of the PLC system. 

Main menu

Prewash

Main wash

Rinse

Spin drying

End of 

Settings

program



Introduction
1.1 Programming
The terminal is programmed through a PC using the MAC Programmer+ 
software. Hereafter this product is referred to as the PC software. It is also 
possible to program the terminal through the built-in keyboard. The E910 
is a terminal with a touch screen and has no built-in keyboard which 
means that the E910 must be programmed using the PC software. Func-
tionally the terminals are identical.

For the most part the terminal is object oriented, that is its work is based on 
an object, and the functions this is to have are determined afterwards. All 
types of signals are defined on this principle.

The programmed project is stored in the terminal.
1-3
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1.2 Connecting the terminal to the PLC system
A terminal couple to the PLC system offers many benefits: the user does 
not need to make changes or additions to existing PLC programs; the ter-
minal does not block any of the PLC system’s inputs or outputs; and it im-
proves the clarity and accessibility of such PLC system functions as time 
control and alarm handling. 

1.3 Status display and control
The operator is very familiar with indicator lamps, as well as analog and 
digital displays for showing status as they appear today in the vast 
majority of applications. The same applies to push buttons, rotary and 
thumbwheel switches for controlling a system. Replacing them with a ter-
minal provides the operator with all status display and control systems in 
one unit. 

The operator can see and control all the information in the PLC system 
using the nomenclature of the machine. By doing so the operation of the 
complete system is not only enhanced but also simplified.
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This is possible with a terminal thanks to the fact that the interchange of 
all information takes place through so-called blocks in the terminal. 
A block can be defined as a Textblock with only text information, or a 
Graphic block with full graphics. 

The terminals have function keys for direct control. When an operator 
presses/energizes a function key during run, the digital signal in the PLC 
system linked to the function key will be switched on.

If several blocks are used, the operator can use jump objects to move 
between different blocks. In this way, a menu tree is created, allowing a 
structured application. 

1.4 Location of the terminal
The terminal should be located close to the machine, to have maximum 
usability. The operator then receives the correct information directly and 
can react quickly and efficiently.

In some cases, such as monitoring/running or maintenance, the operators 
workplace can be several kilometres from the process. Communication is 
via modem.

Several terminals can be installed, if the production line is long with a 
large number of work stations. 

A unit working in parallel can also be connected. This could be another 
terminal. It could also be a PC with the programming tool MELSEC 
MEDOC. It is then possible to program the PLC system via the terminal at 
the same time as the terminal communicates with the PLC system.
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1.5 Compact solutions
External units such as barcode readers, weighing machines, telephone 
modems and so on can be connected to the PLC system via the terminal. 
All the connection requires is that the unit can be connected to an RS-232 
interface and that the communications is by ASCII-protocol. Data enter-
ing the terminal is written directly to the PLC register.
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2 Installation of the software

2.1 MAC Programmer+
MAC Programmer+ is a program package used to develop projects for 
operator terminals from Mitsubishi Electric Europe B.V. The functions in 
the MAC Programmer+ depend on the terminal selected.

We recommend you use the mouse when using the MAC Programmer+. 
For short commands we refer to the Windows User’s Guide.

In the MAC Programmer+ you create your project with graphic blocks 
and textblocks and then transfer them to the terminal. The programming 
procedure is described in the chapter “Programming using the PC soft-
ware”.

Help texts are available for all functions. By pressing the F1 key you will 
get assistance for the current function. You can also press the help button 
in the toolbar and the shape of the cursor changes, then click on the 
function you want information about.

System requirements
MAC Programmer+ should be running on a computer with 50 Mbytes of 
free space and Microsoft Windows 95/98/NT/2000. The MAC Program-
mer+ can be used with either color or monochrome monitors.

Installing the MAC Programmer+
The MAC Programmer+ is supplied on a CD. Place the CD in your CD 
ROM drive and the setup of the programs will start automatically. If not, 
call up RUN from the Start menu and type D:\setup.exe (assuming D: is 
your CD drive name). Choose to install MAC Programmer+ by clicking on 
the name and follow the instructions.

The setup will create an icon for MAC Programmer+ and the manual in 
the MAC Programmer+ group. You will find MAC Programmer+ and the 
manual by clicking on Start and choosing Program/MAC Programmer+. 
The manual can also be read directly from the CD by clicking on Manuals.
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The menu bar
The menu bar contains a number of pull-down menus; File, Edit, View, 
Functions, Setup, Object, Transfer, Window and Help. The File menu 
contains functions which affect the whole project. In the Edit menu you 
find functions for cut, copy and paste. The View menu contains the differ-
ent editors, such as the block editor and symbol manager. In the menu 
Functions LEDs, passwords etc are defined. The basic settings for the ter-
minals are made in the Setup menu. The Object menu is only available in 
the editors and contains all the objects. The objects can also be found in the 
toolbox. The Transfer menu is used for transferring projects between the 
MAC Programmer+ and the terminal. In the Window menu you will find 
the windows functions e.g. zoom in/out, show/hide the toolbox, status 
bar etc. Furthermore you make the grid settings and state the path to a ex-
ternal program e.g. Paint. In the Help menu you will find help functions 
for the program. 

The status bar
The status bar is displayed at the bottom of the MAC Programmer+ 
window. To display or hide the status bar, use the Status Bar command in 
the Window menu.

The left area of the status bar describes actions of menu items as you use 
the arrow keys to navigate through menus. This area similarly shows 
messages that describe the actions of the toolbox button that the cursor 
points at.

The right areas of the status bar indicate which of the following keys are 
locked on:

OVR Overwrite (Insert key)
CAP The Caps Lock
NUM The Num Lock 

Coordinates, line and column, in the block editor are also displayed.
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2.2 Connecting the terminal to a personal 
computer

Use the cable recommended in the driver manual for the selected PLC sys-
tem for connection to the terminal. 

2.3 Downloading the system program
The terminal has a system program (operative system) which is stored in 
the terminal’s memory when delivered. The system program can be ex-
changed, for example when updating to newer versions. The following is 
required to transfer the system program to the terminal:

– Personal computer

– Transfer cable between the PC and the terminal.

– The System Loader personal computer program (available as an icon in 
the program group HMI Tools). See the HMI Tools manual for insta-
llation of the program group.

– File with the new system program (e.g. E900V500.BIN).

Name Continentaleurope GB Rest of the world

Cable 1 MAC-PC-CAB-R2 MAC-PROG/9-CAB MAC-PROG/9-CAB

Note!
The power should be switched off during the connecting procedure.

Terminal

Personal computer

RS-422 RS-232

Cable 1
CAB6
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Transfer in the following steps:
1. Connect the cable between the personal computer and the terminal.

2. On the E-terminal you hold the [←] and [F1] keys pressed on start up, 
when the main cable (voltage feed is connected, to set the terminal in 
sysload-position. An LED should then blink green and the screen 
should be off. On the touch terminal E910 just make sure that the 
switch on the back of the terminal is in position 1.

3. Selecting Program/HMI Tools/System Loader in the Start menu starts 
the personal computer program. No settings need to be made on the 
E-terminal.

No settings need to be made on the terminal.

Under Options, Settings you set the communication port and transfer 
speed for the communication.

Down-loading of the system program can also take place through a 
modem for remote updating of terminals. Then the baudrate must be 2400 
baud.

Note!
When downgrading a terminal it is important to make sure that the square “Overwrite 
PLC driver” is selected.
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3 Terminal functions

This chapter describes the different modes in the terminal, the keyboard 
and the information page in the terminal.

3.1 The operation modes, RUN, PROG and
SETUP

The E900 has three operating modes. The E910 do not have programming 
mode, PROG.

– SETUP mode, where the basic settings are made such as choice of PLC 
system, menu language and printer settings.

– Programming mode, where the terminal can be programmed and 
changes can be easily made at system set-up.

– Run-time mode, when the terminal is running with a PLC.

Switching between modes

Switch between PROG and RUN
Switch between programming, PROG, and run-time, RUN, by simul-
taneously pressing the [←] and [MAIN]. The possibility to switch between 
PROG and RUN from the terminal can be controlled via a password. For 
more information we refer to the chapter “Programming using the PC 
software”.

Switch between PROG and SETUP
To switch from PROG to SETUP you press [LEAVE] until the start-up 
menu is displayed, then press any key. Press [LEAVE] to return to PROG.

Switch between RUN and SETUP
Press [←] and [MAIN] simultaneously to enter programming mode, 
PROG. Then press any key when the start-up menu is displayed to enter 
the SETUP mode. To switch from SETUP mode to RUN you press [←] and 
[MAIN].

Put the switch on the back of the E910 in position 4 to enter the SETUP 
mode. When the switch is in position 0 the E910 is in Run-time mode. See 
also the section The switch on E910.
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The SETUP mode
In this section we describe functions that cannot be made via MAC Pro-
grammer+. For settings via MAC Programmer+ we refer to the chapter 
“Programming using the PC software”.

Erasing the memory
In the SETUP menu in the terminal you will find the Erase memory func-
tion. This function erases the terminal’s application memory. All blocks 
and definitions of alarms, time channels, function keys and system signals 
are erased.

Memcard maintenance
Under Memcard maintenance you select to format an installed PCMCIA 
memory card or to transfer to and from the memory card. You can format 
the memory card as a backup card or as an expansion card. Under Mem-
Card transfer you can select to transfer: project to memcard, project from 
memcard, delete memcard project, recipe to memcard, recipe from mem-
card and delete memcard recipes. For more information see the manual 
for IFC MC.

Contrast setting
The contrast settings can be made in setup mode in the menu 
Setup, Contrast settings or in run-time mode via a jump to the system 
block 997. Pressing the function key marked + makes the display brighter 
and pressing the function key marked - makes the display darker. Return 
to the previous level by pressing EXIT.

Parameter Description

Enter The memory is erased. The configuration menu is shown auto-
matically when the erasure is completed.

Prev Return to the previous level without erasing the memory.

Note!
All data stored in the terminal is lost when the memory is erased. The language 
parameter are not affected by this function. Other parameters are erased or allocated 
the default setting values.
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The Prog mode
The programming mode is the mode where the application can be modi-
fied. It is here you can change textblocks and graphic blocks, modify the 
time channels, alarms, recipes and function keys. We recommend that the 
terminal is programmed using the MAC Programmer+ software.

Edit
Editing graphic objects
The arrow keys are used when editing a graphic object to change the size 
of or move the object in 8-pixel steps. Changing/moving pixelwise is done 
by pressing [SNAP OFF] in the help line.

To move stepwise through all the objects in the editing mode press the 
[SELECT] key followed by [NEXTOBJ] in the help line. The object marked 
is inverted and the object type is shown in a square. 

When an object is marked press [EDITOBJ] to edit the object’s parameters, 
[DELOBJ] to erase the object and [LEAVE] to return. Point to an object and 
press [MOVE] or [SIZE] and make the changes with the arrow keys to 
move or change the size of the object.

Editing text objects
Mark an object by moving the cursor to the object with the arrow keys and 
press [Next] in the help line. You can scroll the text with the arrow keys if 
the Text-block holds more information than can be shown on the display. 
Press [LEAVE] in the help line to exit from a menu.

Note!
Block 0 must be defined in the project in order to be able to run the application.
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Help line
There is a help line in the terminal which contains functions linked to the 
function keys located directly under the line. The functions of the keys 
change depending on which level is active. The help lines are only shown 
in the programming mode.

Transfer
Here you manually put the terminal in transfer mode. When the terminal 
is in transfer mode it is possible to transfer the project between the termi-
nal and the MAC Programmer+. Using the function Automatic terminal 
RUN/TRANSFER switching in MAC Programmer+ the software auto-
matically puts the terminal in transfer mode.

Function Description

NEXT Used to go to the next level. Settings made are saved.

LEAVE Return to the previous level.

TOGGLE Switch alternately.

LIST Show option list.

INSERT Insert.

DELETE Delete.

HELP OFF Switch between showing and removing help line.

SELECT Mark an object.

SNAP OFF/ON SNAP ON means moving and size change in 8-pixel steps. 
OFF = 1-pixel steps.

NEWOBJ Create a new object.

PREVOBJ Show previous object.

NEXTOBJ Show the next object.

EDITOBJ Edit an object.

DELOBJ Delete an object.

MOVE Move an object.

SIZE Change the size of an object.

ENLARGE Increase the character size in an object.

REDUCE Decrease the character size in an object.
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Run
Run-time mode is where the application is running. When switching to 
run-time mode, block 0 is automatically displayed.

In the terminal the built-in keyboard is used to select and change values 
in run-time mode. 

An error message is shown on the display if a communication error 
should occur between the terminal and the PLC system, See “Appendix”. 
The terminal starts automatically when communication restarts. Key 
sequences affecting I/O that have been pressed during a communication 
error are stored in the terminal buffer and will be sent to the PLC system 
when the communication is running again.

To get a watch-dog function, where the PLC system can detect if a com-
munication error has occurred, the terminal clock can be continuously 
transferred to a register in the PLC system (see the section Date/Time for-
mat in the chapter “Programming using the PC software”). The PLC sys-
tem checks if the register is updated and if not, an alarm indicating 
communication error can be set in the PLC system.

How the different objects/functions work in run-time mode are described 
in the respective sections of this manual.
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3.2 The terminal’s keyboard

Alpha/numerical keys
From the alpha/numerical keyboard the following characters can be 
entered in dynamic text and numerical objects during run-time in the 
terminal.

0-9
A-Z
a-z
! ? < > ( ) + / * = ° % # : ’ @
National characters

Note!
The @ character can only be entered in terminals with the system program version 5.0 
or higher.

Arrow keys

Built-in function keys

Alpha/Numerical keys
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Numeric values are entered by pressing the respective key once. A to Z are 
entered by pressing the respective key 2 to 5 times and the lower case 
(small) letters a to z are entered by pressing the respective key 6 to 9 times. 
The time interval between pressing can be set (see the section Key delay 
time in the chapter “Programming using the PC software”). If the key is 
not pressed within the time interval, the cursor is moved to the next posi-
tion.

By pressing the key C1-C4 two to nine times different national characters 
are entered. This makes frequently used characters that are not standard 
on the alpha/numerical keyboard available in the terminal (see the sec-
tion Country settings in the chapter “Programming using the PC soft-
ware”).

Reserved characters
The ASCII characters 0-32 (Hex 0-1F) and 127 are reserved for internal 
functions in the terminal and may not be used in any project or file in the 
terminal. The characters are used as control characters.

Arrow keys
The arrow keys are used to move the cursor within a block, menu or 
dialog.

Built-in function keys
All keys are not available on all terminals.

The [↵] ([ENTER]) key is used to confirm settings made and go on to the 
next line/level.

The [PREV] key is used to return to the previous block. If the security level 
is changed the [PREV] key is disabled.

The [LIST] key is used to bring up the alarm list.

The [ACK] key is used to acknowledge an alarm in the alarm list.

Note!
In MAC Programmer+ all characters in the used font table (see the section Country set-
tings in the chapter Programming via MAC Programmer+) except reserved characters 
can be used as a static text. Write the wanted character by pressing the ALT key and 
at the same time write 0 (zero) on the numerical keyboard on the PC followed by the 
character code (see Font tables in the “Appendix”).
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The [MAIN] key is used to jump to block 0 in run-time mode.

The [←] key is used to delete the character to the left of the cursor.

Key sequences
There are some key sequences in the terminal with the following 
functions.

Note!
When the main block (block number 0) has been shown the [PREV] key does not work 
because the historical blocks are deleted when the main block is shown.

Note!
With the IFC 128E expansion card it is possible to put all the keys on an external key-
board. For more information see the IFC 128E manual.

Key sequence Function

[←] [MAIN] Switch between PROG and RUN.

[←] [F1] Hold this combination pressed during start up to activate the 
mode for downloading of system programs, see the Download the 
system program section.

[←] [PREV] Calls up the information page in run-time mode, see the “Infor-
mation page” section.

Hold this combination pressed during start up to activate the 
self-test function.
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The switch on E910
To enter the different modes in the E910 you set the switch on the back of 
the terminal, the switch has the following functions.

3.3 Setting the real time clock
The real time clock in the terminal is set under SETUP, Date/Time. 

Select the alternative Set Terminal clock. The date and time are now dis-
played. Press [SET] to change the settings. Enter required date and time. 
In the editing mode you move the cursor with the arrow keys. Press 
[NEXT] to return or interrupt the editing before [ENTER] is pressed.

The real time clock can also be set in run-time mode via a maneuverable 
clock object.

Switch position Function

0 Run-time mode (regular running).

1 Sysload

2 Calibrate touch.

3 Dragging cross.

4 Setup mode.

8 Activates the self test function.

9 Clear the clock RAM.
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3.4 Information page
The terminal contains an information page. The information page is acti-
vated by simultaneously pressing the [←] and [PREV] keys in run mode. 
On the touch terminal a touch key can be used/configured to call up the 
information page.

Parameter Description

STARTS Number of times the terminal has been started.

RUN Number of hours the terminal has been in operation.

CFL Number of hours the backlighting has been switched on.

DYNAMIC MEMORY Free RAM memory (working memory) in number of bytes.

FLASH MEMORY Free Flash memory (project memory) in number of bytes.

FLASH ERASE CNT Number of times each sector of the Flash memory has been 
erased. The current spare block always shows zero.

FLASH CACHEHITS Percentage of Block/Allocation cachehits in the file system.

FLASH ALLOCS Max percentage of used/active allocations per block in the 
file system.

ALARMS Number of alarms and alarm groups in the application.

TRENDS Number of trend IO and trend objects in the application.

RECIPES Number of production methods in the application.

DIGITAL IOs Number of digital IOs monitored continuously (static) and 
number in the current block (monitor).

ANALOG IOs Number of analog IOs monitored continuously (static) and 
number in the current block (monitor)

IO POLL Time in ms between two readings of the same IO. 

TIMEOUT Number of time-outs in the communication.

CHKSUM Number of check sum errors in the communication.

BYTEERR Number of byte errors in the communication.

FRAME Number of framing errors in each port.

OVERRUN Number of overrun errors in each port.

PARITY Number of parity errors in each port. 1=RS-422 port and 
2=RS-232 port.



Terminal functions
3.5 “Joystick” function
Not valid for the E910.

With this function it is possible to use the arrow keys as function keys. On 
the command line under System signals you enter the command AK and 
an address. For example you can enter AKM100 (the command AK and 
memory cell M100).

M100 then is the enable signal and the following 4 memory cells 
are according to the following control block.

If you press an arrow key when the enable signal is set, the memory cell 
corresponding to the key pressed will be set. When the enable signal is set 
the normal functions of the arrow keys are diabled.

Memory cell Description

Mn0 Enable. Arrow key detection. Disable=normal function.

Mn1 Left key

Mn2 Down key

Mn3 Up key

Mn4 Right key
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Example
The following example can be used to exit the joystick function and return 
to normal function. Make the following steps.

– create a block with 1:st man obj defined.

– enter the static text “JOYSTICK”.

– create a digital object with the following settings.

D.Signal: M100
Text 0 : OFF
Text 1 : ON
Maneuver: YES

The textblock will look like this.

JOYSTICK #––
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4 General

This section describes how the terminal is designed as well as the basics 
for using it. Furthermore there is an explanation of the general rules and 
object parameters as well as common functions which apply to the 
terminal.

4.1 Method for programming a project
Building up the application in the terminal graphically provides the oper-
ator with concise information on the operation of the system. It is impor-
tant to organize your application well. Think about which functions are 
required. Begin at the introductory level and then work down through the 
levels of detail. When an object is programmed, base this on the functions 
in your application. Each function then becomes one or more blocks de-
pending on how complex the function is. A project can contain both 
Graphic blocks and Textblocks and each block can contain static and 
dynamic objects. To achieve a structured application the block should be 
created in a hierarchy which makes working natural for the operator.

In the run-time mode it is possible to test all or parts of the application 
before running.

Block 0

Block n Block m

Block 14

Block 13

Block 12

Block 11

Block 10 Block 20

Block 0
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4.2 Efficient communication
To make the communication between the terminal and the PLC system 
quick and efficient, the following should be noted about how the signals 
are read and what that can be done to optimize the reading.

Signals affecting the communication time
It is only signals to objects in the current block that are read continuously. 
Signals to objects in other blocks are not read, that is the number of blocks 
does not affect the communication time.

Besides the signals to objects in the current block, the terminal is con-
tinuously reading the following signals from the PLC system:

Display signals
Block print-out signals
LED registers
Alarm signals
Remote acknowledge signals on alarms and alarm groups
Login signal
Logout signal
Trend registers at the sample points
Bargraph registers if using min/max indicators
New display register
Buzzer register
Backlight signal
Cursor control block
Recipe control block
Library index register
Index registers
PLC clock register if the PLC clock is used in the terminal
List erase signal
No protocol control register
No protocol on signal
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Signals not affecting the communication time
The following signals do not affect the communication time:

– Signals linked to function keys

– Time channels

– Objects in the alarm messages

How to make the communication more efficient

Group PLC signals consecutively
The signals from the PLC system are read most rapidly if all signals in the 
list above are consecutive. If, for example, 100 signals are defined, it is 
quickest to read these if they are linked to, for example, M0.0-M11.7. If the 
signals are spread out (e.g. I0.4, Q30.0, T45.3 etc.) the updating is slower.

Efficient block changes
Block changes are carried out most rapidly and efficiently through the 
block jump function on the function keys or through a jump object. "Dis-
play signals" in the block header should only be used when the PLC sys-
tem is to force the presentation of another block. The "New Display" 
register can also be used if the PLC system is to change the block. This 
does not affect communication as much as a larger number of "Display 
signals".

Using the terminal clock
An extra load is put on communication if the clock of the PLC system is 
used since the clock register must be read up to the terminal. Download-
ing of the clock to the PLC system also creates an extra load. The interval 
between downloadings should therefore be as long as possible.
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Packaging of signals
When the signals are transferred between the terminal and the PLC 
system, all signals are not transferred simultaneously. Instead they are 
divided into packages with a number of signals in each package. To 
decrease the number of packages and make the communication faster this 
number has to be considered. The number of signals in each package 
depends on the driver used. 

To make the communication as fast as possible the number of packages 
has to be minimized. Consecutive signals require a minimum of used 
packages but it is not always possible to have consecutive signals. In such 
cases the so-called waste between two signals has to be considered. The 
waste is the maximum distance between two signals you can have and 
still keep them in the same package. The waste depends on the driver 
used.

PLC system
Number of signals in each package

Analog signals Digital signals

FX CPU 32 200

A CPU 116 800

QnA CPU 60 200

A C24 58 200

QnA C24 51 864

PLC system
Waste

Analog signals Digital signals

FX CPU 20 100

A CPU 20 100

QnA CPU 20 40

A C24 20 100

QnA C24 54 864
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Operator ś pictures

Use graphic blocks for operator communication
The textblock is designed in the first place for report print-outs. They are 
slower and demand more memory than graphic blocks.

Use the 3-D effects for elegant operator pictures
Combinations of objects with frames and 3-D rectangles can be very effec-
tive. In this context the ”lighting” appears to come from the top left-hand 
corner, that is the ”shadowing” is on the under and right-hand edges of 
raised objects and on the upper right-hand edges of inset objects.

4.3 Menu structure
The terminal is divided into three modes: configuration, programming and 
run-time mode. Normally configuration and programming are carried out 
with the PC software. Each mode consists of a different number of menu 
levels depending on the function. Each level consists of a menu where you 
make a choice or state a parameter to go on to the next level (menu).

The application is built up of blocks, Graphic blocks and/or Textblocks (pri-
marily for report print-outs). Values from the PLC system are shown and 
altered in the blocks. Each block has a block number between 0 and 989 
allocated by the program. Blocks 990-999 are reserved for special purpos-
es, so-called system blocks. The terminal is object-oriented which means 
that a block can contain all the signals linked to an object for controlling 
and monitoring, a pump for example.

X X X X X

10987654321

Waste

Used

Signal
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4.4 Blocks
A block header is defined for each block. The block number, type of block, 
status word etc. are contained in the block header. The alarm, time 
channels and contrast settings functions can also be called up as blocks. 
These are called system blocks.

A maximum of 990 blocks can be defined in a project.

Note!
The block type cannot be altered for a defined block.
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4.5 Signal types i MELSEC
The PLC system’s signal types are allocated according to the table below. 
See the PLC system user manual for the complete address area.

Digital signals (ON/OFF)
The terminal can handle digital signals of the following types: For ad-
dressing other PLC systems refer to the manual for the drivers.

Signal Function A series FX series
QnA  

series

X Input Relay • • •

Y Output Relay • • •

M Internal Relay • • •

Dn.x Bit addressing in Data Regis-
ters. Bit x in Data Register n. 
Hexadecimal addressing of the 
bits, 0-F.

•

L Latch Relay • •

B Link Relay • •

F Error Relay • •

SB Link Special Relay •

V Edge Relay •

S Step Relay • •

T Timer • • •

ST Accumulated Timer •

C Counter • • •

SM Special Internal Relay •
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Analog signals (Values)
The terminal can handle analog signals of the following types.
For addressing other PLC systems refer to the manual for the drivers.

Signal Function A series FX series QnA series

T Timer • • •

ST Accumulated Timer •

C Counter • • •

D Data Register • • •

SD Special Register •

R File Register (Bank addressing) • •

W Link Register • •

SW Link Special Register •

Z Index Register •

ZR File register (Continous number-
ing)

•

Note!
32-bit counters (C200-C255) in FX systems cannot be monitored.
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4.6 Signal format
The following signal formats are available in the dialog for each object.

Format type Range

Signed 16-bit -32768 – +32767

Unsigned 32-bit 0 – +65535

Signed 32-bit -2147483648 – +2147483647

Unsigned 32-bit 0 – +4294967295

Float with expo-
nent, 32-bit

±3,4E38 Numbers larger than 1000000 are shown with expo-
nent.

Float without 
exponent, 32-bit

The Positions (including the decimal point and sign) and Deci-
mals state the valid range. E.g. 8 positions and 3 decimals lead 
to ±999,999.

BCD Float, 32-bit 0-9999,9999. Only MELSEC AnA PLC system.

BCD 16-bit 0-9999

BCD 32-bit 0-99999999

HEX 16-bit 0-FFFF

HEX 32-bit 0-FFFF FFFF
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Programming using the PC software
5 Programming using the PC software

This section describes how the terminal is programmed using the PC 
software MAC Programmer+. All the functions can be reached with the 
PC software from the menu:

5.1 Creating a project
A new project is created by selecting New in the File menu. The Project 
Settings dialog window is now shown. Here you can select the PLC 
system, type of terminal and color scheame.

Terminal:
Press Change... 

Select terminal type and version (system program) for current terminal 
type.
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Controller system:
Select here the controller system to which the terminal is to be connected. 
When you press the Change... button the following dialog is shown. The 
list shows installed drivers. Here you select brand name, protocol and 
controller model.

Update drivers from Internet
To update available drivers to the latest version or to install new drivers 
from the Internet you use the Update terminal drivers from Internet 
function in the File menu. All project must be closed before this function 
is used. The computer must be able to make an Internet connection. You 
do not need a browser. When the connection is established a list shows all 
drivers that can be downloaded from the Internet to the computer.
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The list shows the version number of available drivers and the version 
number of installed drivers. Mark the driver/drivers you want to install 
in the MAC Programmer+. The function Mark Newer will mark all driv-
ers that are available in a newer version then the one installed and the 
drivers not installed. You then select Download. Each driver is approxi-
mately 500 kb and it is ready to use when the download is completed.

Update drivers from disk
To update available drivers to the latest version or to install new drivers 
from disk, use the Update terminal drivers from Disk function in the 
File menu. All projects must be closed before this function is used. Open 
the mpd file in the map where you find the drivers. Now a list shows 
available drivers is displayed.
The list shows the version number of available drivers and the version 
number of installed drivers. Mark the driver/drivers you want to install 
in the MAC Programmer+. The function Mark Newer will mark all driv-
ers that are available in a newer version then the one installed and the 
drivers not installed. You then select Download. Each driver is approxi-
mately 500 kb and it is ready to use when the download is completed.

Color scheme:
In terminals supporting colors, you can create your own color scheme and 
store it under a unique name. The color scheme decides the default color 
of the background, menus, dialogues, objects etc. When you select an ob-
ject in the toolbox or in the menu the colors of the object are shown as de-
fined in the color scheme.

When you select Change the following dialog is displayed. Here you 
change the current color scheme or create a new one.
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The Apply button update all colors in the project, except lines, circles, rec-
tangles and arcs.

5.2 Changing project settings
Both the selected terminal and the controller system can be changed in the 
project. Choose Project settings in the File menu and press Change at the 
parameter Terminal and/or controller system.

If you update the system program in the terminal to a newer version you 
must change to the correct terminal version in the Project settings dialog. 
If this is not done the new functionality in the new terminal version cannot 
be used.

If you change the controller system in the project to a system with other 
names of the devices used, these must be changed. It is easily done by us-
ing the internal name list, see the section Name list.

1. Choose Name list in the View menu.

2. Select Undefined to insert all I/Os used in the project to the name list.

3. Select Export to export the name list to a text file. State a name and 
press Save. Define how the text file will be separated.

4. Pick up the text file in a text editor, e.g. Wordpad.

5. Change all the I/Os to devices used in the new controller system and 
save the file as a text file.
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6. Select Import in the Name list dialog and press No on the question if 
invalid I/Os should be removed.

7. Select Rebind to update all new I/Os in the project with the new 
device names.

8. Choose Project settings in the File menu and press Change.

9. Select the new controller system you want to change to and press OK 
twice.

All I/Os in the projects have now the correct devices and the change of 
PLC system is completed.

5.3 Creating a block via the Block Manager
The block manager is shown when you have created a project. Which 
blocks are included in an application are shown here. 

In the block manager there is a toolbox with the following functions.

Mark block and create block.

Add a new block.

Define block header for selected block.

Make a block jump to the block to be created with the cursor.
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Make function key block jump to the block to be created with the 

cursor.

Delete selected block.

Edit selected block.

Block manager settings.

Zoom in.

Zoom out.

Define block
When you add a block in the Block Manager the following dialog is 
shown. It is a simplification of the complete block header.

Block name:
A name for the block can be written here. The block name is shown in the 
block manager and in the block list.

Block no:
The number of the block. The defined values are entered automatically if 
a block with assigned number already exists. The block number 0 is 
shown automatically on starting up and must always be used in a project.

Block type:
Select block type, graphic or text.
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Screen size:
Select character size for textblock. The character size can not be changed 
for a defined object. 

Template:
Here you can copy a template to the block or save the block as a template.

Define the complete block header
Basic parameters valid for each single block are defined in the block 
header. Select Header in the Block Manager menu. The following 
parameters can be defined in the block header:

Block no:
The number of the block. The defined values are entered automatically if 
a block with assigned number already exists. The block number 0 is 
shown automatically on starting up and must always be used in a project.
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Block name:
A name for the block can be written here. Block name is optional.

Display signal:
A digital signal which, when activated, results in the block being shown 
on the display. If display signals are used they should be ordered consecu-
tively, for the different blocks to get the best performance. This field is not 
filled in if another method for changing blocks is used.

Print signal:
A digital signal which when activated results in the block being printed 
out on a connected printer. The display signal and printer signal can be the 
same. The printer signals should be used consecutively to printout as 
quickly as possible.

Completion signal:
A digital signal which is activated when the print out is completed. 
Normally the signal is set. If the function Reset in Block Header is marked 
then the signal is set to zero when the printout is completed.

Send mail signal:
The message is sent when the stated digital signal is set. 

Mail completion signal:
A digital signal that is activated by the terminal when the message is sent. 
Normally the signal is set. If you mark the function Reset the signal will 
be reset when the message is sent. 

Mail to address:
Enter the email address to the receiver. Select up to eight receivers from 
the list shown when you click on the ... button. The list of email addresses 
is defined in the SMTP Client Service dialog under Network Services in 
the Setup menu.

Note!
Only textblock can be sent as email message.
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Attach file:
Enter the name of a trend or recipe file to be attached to the message. If 
there is a trend file and a recipe file with the same name the trend file is 
sent. 

Security level:
A security level (0-8) for the block is stated here. The operator must enter 
a password equivalent to a given or higher security level if a security level 
> 0 is stated.

Background block no:
Here you have the possibility to load another block as a background in 
current block. For example, if you want to use the same background in 
more than one block. When the graphic block editor is active you can se-
lect if the background block shall be shown in the current block with the 
function Show Background Block in the Windows menu.

Cursor color:
Select the color of the cursor in graphic blocks.

Cursor thickness:
Select between three different alternatives.

Block type:
Select block type, graphic or text. It is not possible to change block type for 
a defined block.

Screen size:
Select the character size in the textblock. It is not possible to alter the type 
of a defined block.

Fkeys:
The local function keys (F1-F22) for the block are defined here. Enter a sig-
nal that will be activated when the function key is pressed. See the chapter 
on “Function keys”. 

Template:
Here you can copy a template to the graphic block or save the block as a 
template.
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Status:
States the display’s appearance in the run-time mode. The status word has 
no function in the system blocks. The parameters in the status word have 
the following functions.

Cursor off: States if the cursor will not be visible in the block in 
the run-time mode.

Put cursor at first man. object: States if the cursor will be on the 
first maneuverable object instead of in the top left-hand corner.

Disable main menu key: States if the [MAIN] key is to be 
blocked in the run-time mode when the block is shown on the 
display.

Disable alarm list key: States if the [LIST] key is to be blocked in 
the run-time mode when the block is shown on the display.

MORE indication: States if the + sign is to be shown in the 
bottom right-hand corner and the top right-hand corner when 
there is more of the block below and above respectively than that 
shown on the display.

Auto data entry: States if the cursor will automatically move to 
the next maneuverable object after an entry. The cursor can only 
be placed on maneuverable objects in this state.

Disable Prev Key: States if the [PREV] key and the “Return to 
previous block” function for the function keys is to be blocked in 
the run-time mode when the block is shown on the display.
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Settings for the Block Manager
Here you make the settings for the presentation in the Block Manager.

Block:
Select how data should be presented in the block.

Reference:
Select the appearance of the Block Manager.

Edit:
Select special functions for the presentation in the Block Manager.

Show terminal around the working area
To graphic blocks there is a function in the Window menu called Show 
terminal. When this function is active a picture of the current terminal is 
drawn around the working area. The picture of the terminal has pressure 
sensitive surfaces on function keys, LEDs and lead text fields. 

Define function keys
When you double click on a function key you can select to define a local 
or global function key. The editor for selected function is displayed.
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Define LEDs
When you double click on a LED the editor for defining LEDs is dis-
played. 

Create insertable strip
When you double click on a field on the insertable strip, a dialog is dis-
played where you can enter a text, select adjustment of the text and select 
font. This function makes it possible to create the whole insertable strip 
and print on plastic film and then use it in the terminal.

5.4 Programming blocks
Double click on current block or select Edit for marked block. The working 
area for the block and the tool box are now shown. The objects that can be 
created in the block are in the tool box.

Select an object by clicking on the object in the tool box, and place the 
cursor in the working area where you want the object to end up. The dia-
log window for selected objects is shown when you click. The object is 
now shown on the working area. If you have selected static text or graph-
ics, it is written directly on the working area. 

General parameters for the objects are described in the chapter “General”. 
Each type of object is explained in the chapters “Graphic presentation and 
maneuvering” and “Text-based presentation and maneuvering”. 
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5.5 The graphic block editor
This section describes the graphic block editor in the MAC Programmer+. 
The editor is based on Windows standards. 

In the graphic block editor you create graphic blocks with static and 
dynamic graphics.

How to open the graphic block editor
The graphic block editor is opened when you double click on the current 
block in the Block Manager or from the block list. 
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Mouse, keys and the cursor
The following section describes how to use mouse and keys in the 
graphic block editor. Furthermore we describe the different shapes of the 
cursor.

Mouse
Use the floating toolbox to create an object.

Click on an object to mark it.

Mark several objects by drawing a frame around the objects or by holding 
the Shift key down when you click on the objects.

Keep the mouse button down on object and drag the mouse to move it.

Keep the mouse button down on object and press the Ctrl key and drag 
the mouse to copy it.

Keep the mouse button down on object handle and drag the mouse to size 
it.

Double click on object to view parameters.

The following picture shows marked objects.
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Keys
Use Object menu to create an object.

Use arrow keys to move cursor.

Use [Ctrl] + [arrow keys] to move on pixel level.

Press [SPACE] on object to mark it.

Mark several objects by selecting Block Select in the Object menu and drag 
a frame around the objects using [SPACE] and arrow keys.

Keep [SPACE] down on object and use arrow keys to move it.

Keep [SPACE] down on object handle and use arrow keys to size it.

Press [ENTER] to view parameters on marked object.

Cursor
The cursor has four different shapes

within an object

change size of an object

in graphic working area

selection in menu or toolbox

The toolbox
In the editor you use the toolbox to create objects in the block. All func-
tions are also available in the menus. The following table describes the 
functions in the toolbox. See the chapter “Graphic presentation and 
maneuvering” for the different objects that can be used in graphic blocks.

Selection pointer mode

Area selection mode
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Symbol creation mode

Zoom in 

Zoom out

Grid

Put on top

Put to background

Line pattern

Line thickness

Character size

Background color for the block

Foreground color for the object

Background color for the object

Import/export symbols.
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Create object
Select the type of object in the toolbox and drag the object. Static graphics 
will be displayed when you click in the editor. Dynamic objects are 
defined in a dialog box before they are shown on the display.

When an object is drawn it is marked with handles and the function 
selection pointer mode is activated.

Recommendations
When the graphic block editor is active there is a command in the 
Window menu to turn Draft Move & Size on/off. It is recommended to 
turn this option on when using a slow computer. This turns off the imme-
diate updating of the sized/moved object. A check mark appears next to 
the menu item when Draft Move/Size is on.

In the File menu you will find the 3D Controls function. This functions 
means that the forms in the program will be displayed with 3D effects. 
It is recommended to turn this function off when using a slow computer.

Static graphics
The static graphic objects are line, arc, ellipse, rectangle, polygon, symbol, 
text and decorations and are used to create background graphics.

Dynamic objects
Select the type of object in the toolbox and place it in the block. Before the 
object can be shown on the display you must define the object in the dis-
played dialog. See the chapter “Graphic presentation and maneuvering” 
for further details about object settings. 

Select several objects
In the graphic block editor you can select several objects in two different 
ways.

– Click outside the object, keep the left mouse key pressed and draw a 
frame around the objects you want to select. The latest created object 
will be shown with filled handles.

– Select the selection cursor in the toolbox. Keep the [Ctrl] key pressed 
while you select the objects. The latest selected object will be shown 
with filled handles.
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Place object
To easily adjust the placing of the objects in graphic blocks there are a 
number of functions in the Layout menu. Under this menu you will find 
the functions Align, Make same size, Space evenly and Tile. The func-
tions are also available in a separate toolbox.

To use the functions two or more objects must be selected. The functions 
calculate the placing from one or two reference object. For the functions 
Align, Make same size and Tile it is the last selected/created object that is 
the reference object, see the section “Select several objects”. For the Space 
evenly function it is the uppermost and the lowermost objects that are the 
reference objects. The reference objects are not affected by the function.

Align
Under Align you have six alternatives for adjusting the objects horizont-
ally and vertically.

Left
This left-aligns the marked objects with the reference object.

Right
This right-aligns the marked objects with the reference object.

Top
This top-aligns the marked objects with the reference object.

Bottom
This bottom-aligns the marked objects with the reference object.
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Make same size
Under Make same size there are three alternatives for making the marked 
objects the same size.

Width
Adjust the marked objects so that their width is the same as the reference 
object.

Height
Adjust the marked objects so that their height is the same as the reference 
object.

Both
Adjust the marked objects to exactly the same size as the reference object. 

Space evenly
Under Space evenly there are two alternatives for adjusting the space be-
tween marked objects

Vertical
Adjusts marked objects with an even vertical spacing. The uppermost and 
lowermost objects retain their positions. At least three objects must be 
marked.

Horizontal
Adjusts marked objects with a horizontal spacing. The leftmost and right-
most objects retain their positions. At least three objects must be marked.

Tile
Under Tile there are two alternatives for adjusting objects so that they are 
edge-to-edge.

Vertical
Adjusts marked objects so that they align vertically edge-to-edge with the 
reference object.

Horizontal
Adjusts marked objects so that they align horizontally edge-to-edge with 
the reference object.
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How to group objects
In the Layout menu you can select to group several objects. The grouped 
objects are handled as an object that can be resized. Color and font can be 
changed individually for the object in the group object. When you click on 
an object in the group object the dialog for the object is displayed. Mark 
the objects you want to group and select the function Group in the Layout 
menu.

With the Ungroup function in the Layout menu you release the group ob-
ject.

Save and load group object
If you mark a grouped object and press the Library button in the toolbox 
in the graphic block editor you can save the object. When you press the 
button library without any object being marked you can load grouped ob-
jects stored on the computer. MAC Programmer+ is delivered with several 
grouped objects. The objects are stored in c:\Program\Beijers\MAC Pro-
grammer+\lib\library\.
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Create series
In the graphic block editor you can create series of objects. First create two 
rows and/or columns with the same object.

Thereafter mark the objects and select the Create series function in the 
Object menu.

A dialog is now displayed where you select to create rows or columns, the 
number of rows/columns and in which direction the series shall expand. 
MAC Programmer+ now creates a table with the assigned number of rows 
or columns.
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Symbols
You can create symbols in three ways, using the Symbol manager, with the 
functions Create symbol or copy graphics from other Windows programs 
using the clipboard. See separate chapter how to use the Symbol manager

The function Create symbol
– Select the function Create symbol.

– Drag a marking frame around the graphic you want to save as a 
symbol.

– State the name of the symbol, max 8 characters.

The symbol is now stored in the symbol directory with the stated name.

Note!
To be able to create the table the last character in the lead text must be a figure. 
The object Alarm banner is not allowed in a table.
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Copy graphics from other programs
– Use the copy function in another program (e.g. Paint). 

– Make graphic block active in the MAC Programmer+ and select Paste.

– State the name of the symbol, max 8 characters.

The symbol is now stored in the symbol directory with the stated name.

With the functions copy and paste in the MAC Programmer+ it is possible 
to copy graphics and symbols between blocks and between projects. 

5.6 The textblock editor
This chapter describes the textblock editor in the MAC Programmer+. The 
editor is based on Windows standards.

In textblock editor you build up dialogs and reports. A textblock can 
consist of static text and dynamic objects. Static text is text which is not 
changed when executing the program. Dynamic objects are objects that 
are linked to the signals in the PLC system. 

How to open the editor
The text editor is opened by double clicking on the current block in the 
Block Manager or from the block list. In the block list you select a defined 
textblock or create a new textblock. 

Mouse and keys
Click at the beginning of the text you want to mark and drag the mouse 
pointer over the text. If you are using the keyboard press on shift and 
arrow keys.

The function Cut will erase marked text. 

The character End of line is stated when you press the key combination 
[Ctrl] [Enter]. 

Double click or press [F4] on object to view parameters.

Note!
When you copy user-defined symbols between projects, the symbol itself will only be 
copied if the symbol does not already exist in the target project.
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The toolbox
In the textblock editor there is a toolbox with the following functions. 
All functions are also available in the menus. See the chapter “Text-based 
presentation and maneuvering” for the different objects that can be used 
in textblocks.

Zoom in

Zoom out

ASCII choice list. Selection of characters not available

on the keyboard

Define textblock

Static text
The textblock editor is a text editor in which you type the static text. You 
can also use the Windows functions copy/paste in or between blocks, or 
from other Windows programs e.g. Microsoft Word. This makes it easy to 
create documentation of your application.

Dynamic object
You can define a dynamic object anywhere in the text. Select the type of 
object in the toolbox or in the object menu and then you define the object 
in the dialog displayed.

The dynamic objects are signed with the character # followed by one or 
several '-' depending on the number of positions in the object. For further 
details about definition of dynamic objects, see the chapter “Text-based 
presentation and maneuvering”. 
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5.7 The symbol manager
In the symbol manager you have the possibility of importing and export-
ing symbols. You can also create and delete user-defined symbols from the 
symbol directory. In the symbol list you can see the user-defined symbols. 
The predefined symbols are not shown, since they are not changeable. 
How to create a symbol is described in the section “Symbols” in this chap-
ter.

Export symbols
Symbols can be exported in BMP format to be used in other applications. 

Import symbols
The import function makes it possible to reuse symbols from other appli-
cations.

Picture files in bmp, cmp, dex, fpx, jpg, mpt, pcd, png, tga, tif and pcx for-
mats can be imported into the symbol directory from other Windows 
applications e.g. Paint. 

MAC Programmer+ is delivered with several symbol libraries containing 
different symbols, e.g. pump symbols. The symbols are stored in c:\Pro-
gram\Beijers\MAC Programmer+\lib\bitmap\.
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Create
The Create function is used to create new symbols. When you select 
Create, you first have to enter a name of the symbol. When you click on 
OK the bitmap editor opens. The bitmap editor works as a normal draw-
ing program with the limitation according to current terminal.

Delete
When you press the right mouse button and draw with the pen, you draw 
with the background color. If the background color is white it looks like 
you delete.

Edit
The function Edit activates the bitmap editor for a defined symbol. 

Duplicate
This function is used to create a copy of current symbol with a different 
name.
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The More function
The More function is used to add more information to the symbol:

File name: States the file name if the symbol was imported from 
a file.

Date created: States the date the symbol was created.

Source: States the source of the symbol.
None: Unknown source
Bitmap file: Imported from bitmap file
Clipboard: Imported from clipboard 

(Copy & Paste function)
Graph block: Created in a graphic block

Comment: Here you add your own comment to the symbol.

The Delete function
The Delete function is used to delete a symbol from the project.

The Transparent color function
When you import a symbol you can select one color in the symbol to be 
transparent.

The function No. of Colors
In the E900 and E910 supporting colors you can select to handle symbols 
in 16 or 256 colors.
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5.8 I/O change
With the I/O change function you can change a single I/O or move a 
whole I/O area. You can change I/O in the whole project or only in the 
object that was marked when you selected the function.

You can use the function on blocks in the block list, objects in the graphic 
block and textblock editor, lines in the alarm list, lines in the function key 
editor, lines in the LED editor or lines in the cross reference list.

Select the I/O change function in the Edit menu.

Change I/O in
Select if you want to change I/O in the whole project or for selected 
objects.

Change type
Select if an I/O shall change place or if you want to move a whole I/O 
area.

From I/O, End I/O, To I/O
State the I/O to be changed and what it should be changed to or which 
I/O area you want to move.
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5.9 Change BDTP station
With this function you can change the index numbering in a BDTP client 
project in a BDTP network. For example from station 1 to station 3. Select 
the BDTP Station Change function in the File menu.

Change station in
Select if you want to change the index numbering in the whole project or 
for selected objects.

From station, To station
Enter the index number to be changed and to which BDTP station the in-
dex number is to be changed. 

Confirm each change
Select if you want to confirm the change of BDTP station for each object. 
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5.10 I/O cross reference
The cross reference function is used to document I/O in a clear way. Select 
the I/O Cross reference function in the View menu. 

In the dialog displayed you state the Start I/O and End I/O. If you leave 
the Start I/O field empty, all I/O up to the value in the End I/O field will 
be included. If you leave the End I/O field empty, all I/O from the value 
in the Start I/O field will be included. If you leave both the fields empty 
all I/O in the list will be included.

Presentation
The result of the function will be presented in a list with two levels. The 
first level shows used I/Os and how many objects that refer to respective 
I/O.

You reach the second level when you double click on the + character to the 
left of the I/O. Now the objects containing the I/O you clicked on are dis-
played. The + character will become a - character. The Print View button 
opens the print dialog and you can select to print the cross reference list as 
it looks on the display to a connected printer.
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One or several lines in the list can be copied and pasted into e.g. a 
Microsoft Word document.

5.11 Other editors
The MAC Programmer+ also has editors for handling Function keys, 
LEDs, Alarms, Alarm groups, Passwords and Time channels. These 
editors are activated from the Functions menu. The editors work in a 
similar way. The parameters are described in separate chapters in this 
manual.

Defined Function keys, LEDs, Alarms, Alarm groups and Time channels 
are displayed in a list in the editors respectively. Add a new definition 
with Append or Insert. If you want to change a definition, mark the 
alarm, make the changes and press Update. If you want to update or 
append more than one definition to the list, press Update or Append once 
and then press Enter. Thereafter Update or Append remain operational 
until changed. Erase a marked definition with Delete or Clear. End the ed-
itor with Exit. The following example describes the Alarms editor.

The alarm is numbered automatically. When you press Append the alarm 
definitions are listed last, and when you press Insert the new definition 
will always be inserted before the marked definition in the list. When you 
press Update you confirm changes made on a definition.
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5.12 The File Menu
There are functions for creating, opening, saving and closing projects in 
the File menu. Printer settings, previewing print out, creating documen-
tation headers and activating print out are also selected from here. Fur-
thermore there are functions for testing a project and altering project 
settings. With the function MELSEC I/O Naming you select if the internal 
name list should be used or if a name file from MELSEC MEDOC or 
MELSEC MEDOC plus should be imported.
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5.13 The Edit Menu
Functions for cutting, copying, pasting, undo and select all are found in 
the Edit menu.

5.14 The View Menu
Function editor for block editing, symbol handling, cross reference and 
name list are to be found in the View menu.

Block List
Blocks included in the application are shown in the block list. In the block 
list you create new blocks by pressing the New button. When you select 
New the block header is displayed. Basic parameters for the block are de-
fined in the block header.
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Block Manager
Blocks included in the application are shown in the Block Manager graph-
ically. In the Block Manager you create new blocks, define the block head-
er, define block jump with the functions in the toolbox.

Symbol Manager
Activates the symbol manager. In the symbol manager you create a library 
of symbols in BMP format. The symbols in the symbol manager are then 
available in the symbol list when you create static and dynamic symbol 
objects. It is also possible to duplicate and edit defined symbols.

I/O Cross reference
Under I/O Cross reference you document I/O in a clear way. See the 
section “I/O cross reference” in this chapter.

Name list
Under Name list you define a local name list for devices used. Devices 
used in the project without defined name can be inserted in the name list 
with the function Undefined. New devices can be added and existing 
names can be edited and updated. With the Rebind function you update 
the project with the changes done in the name list.

A name list can be exported to a text file and a text file can be imported to 
a name list. The items in the file are either separated with the character →, 
; or ,. An internal name list can be sorted. The text file may not include 
national characters. 

Note!
In the MELSEC I/O Naming function in the File menu you must choose Internal name 
list to use the name list.
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If you have created a local name list in your project you can choose I/O 
signals from this name list via the I/O button. Click on the I/O button in 
all instances where you want to enter an address. The I/O browser has in-
cremental searching. Incremental searching means that searching begins 
immediately while you are still entering characters in the name/device.

The I/O list is stated in device order or name order.

If you have linked a driver specific name file to your project you can 
choose I/O signals from this name file via the I/O button.
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Controller I/O
The button Controller I/O in the I/O browser can give you help about the 
addressing for different PLC-types.

5.15 The Functions Menu
Function editor for function keys, LED, alarm, time channels, passwords 
and message libraries are to be found in the Function menu.

Function keys
Under Function keys you define global and local function keys. See the 
chapter “Function keys”.

LED
Under LED you define the function for the LEDs. See the chapter “LEDs”.

Note!
The Controller I/O function is not supported by all drivers.
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Alarm Group
Under Alarm Group you can group alarms; for example, by danger level 
- so that they can be more realistically identified and dealt with. See the 
chapter “Alarm handling”.

Alarms
Under Alarms you define alarm messages and the signal to be connected 
which will activate the alarm. See the chapter “Alarm handling”.

Time Channels
Under Time Channels you define the time channels used to control events 
in the process at specified times. See the chapter “Time control”.

Password
Under Password the password is defined for the applicatiońs different 
access levels. See the chapter “Passwords”.

Message library
Under Message library you create message tables where values between 0 
and 65535 are linked to texts. See the chapter “Message library”.

5.16 The Setup Menu
Functions for configuration of the terminal are to be found in the Setup 
menu.
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System signals
Setting of the handshaking signals between the terminal and the PLC 
system.

Current display reg:
Data register in the PLC system which contains the number of the block 
shown on the display in the run-time mode. The data register is updated 
automatically by the terminal on changing block. This register does not 
affect the choice of textblock.

New display reg:
A PLC data register that determines which block will be shown on the 
display. D100 can be stated for example. The value 34 is entered into D100 
from the PLC program or the terminal if block 34 is to be shown on the 
display.

Buzzer reg:
A register whose value decides the sound of the buzzer. See the table be-
low. If the value i 0 then the buzzer is silent. The unit in the table is Hz.

Backlight signal:
Digital signal which determines if the display is to be switched on or off.

C D E F G A B

Contra 33 37 41 44 49 55 62

Large 65 73 82 87 98 110 123

Small 131 147 165 175 196 220 247

One 262 294 330 349 392 440 494

Two 523 587 659 698 784 880 988

Three 1046 1174 1318 1397 1568 1760 1975

Four 2093 2348 2636 2794 3136 3520 3950

Five 4186
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Cursor ctrl. block:
Start register to a control block in the terminal which writes the current 
cursor position to the data register in the PLC system.

Start register to a control block in E910 which writes the current touch 
position to the data register in the PLC system.

Register Description

Dn0 Current cursor position X (in pixels), 0-319.

Dn1 Current cursor position Y (in pixels), 0-239

Dn2 Status register
0 Normal
1 User trying to move down but there is no object there.
2 User trying to move up but there is no object there.
3 User trying to move left but there is no object there.
4 User trying to move right but there is no object there.

Register Description

Dn0 X-coordinate (in pixel), 0-319.

Dn1 Y-coordinate (in pixel), 0-239.

Dn2 Status register
0 Not pressed
1 Pressed
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Recipe ctrl.block:
Control block for loading/saving/deleting off recipe files via the PLC 
system

Current recipe reg:
States the first of four registers where the terminal put the name of the last 
loaded recipe from the system. The name can be presented in an ASCII 
object. The function takes four registers (eight characters) independently 
of the recipe name.

Library index reg:
Used for indexing message libraries. In the Message object you state the 
number of the library from which the texts are loaded. If an index register 
is defined, the content of the index register is added to the stated number 
in the object. This makes it possible to control from which library the texts 
are loaded.

Register Content Description

Dn0 Command Command register set by the PLC
Available commands:
0: No command.
1: Save recipe to the terminal.
2: Read recipe from the terminal.
3: Delete recipe from the terminal.

Dn1 Result code Handshake register set by the terminal
0: Ready for new command.
1: OK.
2: Recipe file write error.
3: Recipe file not found

Dn2 File name char. 1-2

Recipe file name in the terminal
Dn3 File name char. 3-4

Dn4 File name char. 5-6

Dn5 File name char. 7-8

Dn6 Start data register First data register to be read/written to/from 
recipe file.

Dn7 Number of registers Number of registers to read/write to/from recipe 
file.
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Commands
One or more of the following commands can be stated on the command 
line. The commands are separated by a space.

Index register
Index addressing of dynamic objects. For more information see the chap-
ter “Index addressing”.

Command Description

DGP Delete the alarm group name from the alarm print out.

NTx Timeout in ms for messages in the No protocol mode.

PDxxxxxxxx Password xxxxxxxx that protects the transfer menu. 

PSxxxxxxxx Password xxxxxxxx that will give access to all functions in the 
terminal.

RPD RUN/PROG disable. Turns off the possibility to switch between RUN/
PROG with the keys [BACKSPACE] and [MAIN]. If RPD is used you 
switch mode via the MAC Programmer+.

BR Batch Read. Puts the terminal in transparent mode communication 
when using MELSEC PLC systems.

DD Disable Delete alarms in the alarm list. When stated it is not possibble 
to delete inactive and acknowledged alarms from the alarm list.

DIMDx Data register containing a value between -63 and +63 controlling the 
display brightness. -63 means that the display i as dark as possible and 
+63 means that the display is as light as possible. Normal value is 0.

Rx Maximum number of retransmissions. x = number of attempts.

BSD Disable Baud Switching when communicating via transparent mode 
with FX2N and Q. BSD must be set in the terminal not connected to the 
PLC-system.

SW Converts text with Swedish ASCII (7 bits) characters to 8 bits IBM PC 
extended ASCII on printing.

Tx Global timeout for x milliseconds.

BFF Block Form Feed. Puts a form feed after each block at print-out.

AKMx Activates the joystick function, se the section ““Joystick” function” in 
the chapter “Terminal functions”.

NHD No header. Possible to printout graphic blocks with no header (contain-
ing block name, block number, date and time) on a laser printer.
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Country settings

Language:
Choice of system message language; British English, German, Swedish or 
American English. The default setting is Brittish English menu texts.

Character set:
The choice of character set affects the font table used in the terminal and 
which national characters that will be used. 

Different national characters (see the section “The terminal’s keyboard” in 
the chapter “Terminal functions”) are used depending on the chosen char-
acter set.

When Slavic or Russian are chosen the national characters are not used.

Character set Font table in graphic based terminals

Swedish 437

German 437

French 850

Spanish 850

Norwegian/Danish 850

Russian 866

Slavic 852

Swedish German French Spanish Nor/Dan

C1 Å Ü È Ñ Å

C2 Ä Ä É É Æ

C3 Ö Ö Ê Ó Ö

C4 å ß è Á Ø

C5 ä ü é ñ å

C6 ö ä ê é æ

C7 ö ó ö

C8 ß á ø
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Date/Time format
Setting of date and time format.

Date format:
The default format can be YY-MM-DD, YYMMDD, DD.M.YY, 
DD/MM/YY or MM/DD/YY where Y=year, M=month and D=day.

Time format:
The default format can be HH:MM:SS or HH:MM where H=hour, 
M=minute and S=second.

Clock used:
Select Terminal or Controller. Terminal means that the terminal’s built-in 
clock is used and controller means that the clock in the controller system 
is used in the terminal.

Clock → Controller:
Only valid if the clock in the terminal is used. Mark if the clock in the ter-
minal is to be transferred to the controller system.

Update interval:
State how often the terminal will transfer the clock data to the controller 
system. The value is entered in seconds and 60 is recommended. A shorter 
updating interval makes the communication between the terminal and 
the controller system slower.

Controller register:
Enter the first address of the registers that will be used to store date and 
time in the controller system.

Note!
If the controller system has a real-time clock that is activated and the terminal clock 
is transferred to the same registers in the controller system is using, the clock in the 
controller system is superior.
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Controller:
Settings controller system MELSEC A series.

Settings PLC system MELSEC FX series.

If another driver than MELSEC is used, see the manual of the PLC system 
how the date and time are stored. The terminal stores the information in 
the same order as the default settings for the PLC system.

Daylight saving:
The beginning and end of summer or Daylight saving time are defined 
here. State the day of the week, week in the month, month or hour. The de-
fault setting in the PC software is selectable between Europe, the US and 
User defined. If you do not want to use Daylight Saving Time, leave the 
two entry fields for month empty.

Online settings:
Allow change of selected function in run-time mode.

Data register 8 highest bits 8 lowest bits

D9025 year month

D9026 day hour

D9027 minute second

D9028 – weekday

Data register Presentation

D8013 second

D8014 minute

D8015 hour

D8016 day

D8017 month

D8018 year

D8019 weekday
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Terminal options

Screen save time:
The time in minutes after the last operation on the display when it will 
switch off. The default setting is 10 minutes. This function is used to opti-
mize the display’s working life. See also the section Backlight action in the 
chapter “Alarm handling”.

Key delay time: 
The time interval between pressing the same key before the cursor moves 
to the next position. Used for input of ASCII characters (A-Z etc.). See the 
section Alpha/numerical keys in the chapter “Terminal functions”.

Key beep:
States whether the terminal will beep when a key is pressed. 

Key repeat:
States whether the numerical keys, arrow keys and built-in function keys 
are to be repeated as long as the key is pressed. Function keys and input 
of ASCII characters (A-Z etc) cannot be repeated. 

Background:
Select terminal background color in the list of choices by clicking BG. 

Foreground:
Select terminal text color in the list of choices by clicking FG. 

Window:
Select the color of the windows shown on the display by clicking 
Windows. 

Trend settings
Common settings for all trends. 

Store changed samples
Select to store samples in trends only if the value has changed since the 
last sample.

Store all samples
Select to store all samples in trends even if the value has not change since 
the last sampling. The parameters are valid for all defined trends. 
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Alarm settings
General setting of the alarm list. For more information see the section on 
“Alarm handling”.

Peripherals
All communication configurations are made under Peripherals. When 
you select Peripherals the following is displayed. The display shows the 
units defined for the system. You can drag and drop the units.

Edit...
You can mark a unit or a port on the display and press Edit... or click the 
right mouse button. Then the dialog for the selected unit/port is 
displayed. 

Ports...
When you select Ports... a dialog is displayed where you can see current 
configurations. The configurations can also be changed here.
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RS-232C
When you select the RS-232C port and press Edit... or click the right 
mouse button the following dialog is displayed. You select baudrate, 
parity, number of data bits and stop bits for the port.

RS-422
When you select the RS-422 port and press Edit... or click the right mouse 
button the following dialog is displayed. You select baudrate, parity, 
number of data bits and stop bits for the port.

Expansion slot
When you select an Expansion slot and press Edit... or click the right 
mouse button you can define which expansion card you want to use and 
then make the settings for the expansion cards. For further information, 
see the manuals for the respective cards. 
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Printer
When you select Printer and press Edit... the dialog for printer settings is 
displayed. 

Printer type:
Select printer, None or e.g. HP PCL5.

Page length:
The number of lines which will be printed out before form feed. If the page 
length is set to 0 form feed never occurs. Default setting is 60.

Paper Type:
Select type of paper.

Graphic orientation:
Select the graphics orientation, portrait or landscape

Text orientation:
Select text orientation, portrait or landscape.

Graphic size:
Select size of the graphic printout.

Printer disable signal:
Digital signal for stopping the print out

New line character:
Marks the required new line character; CR/LF, CR, LF or none.
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Handshake:
Marks the required type of handshaking between the printer and the 
terminal; XON/XOFF or CTS/RTS. Refer to the printer manual for infor-
mation about suitable handshaking.

Screen dump:
Printout of the screen. Select normal or inverted printout. 

No protocol mode
When you select No protocol mode and press Edit... or click the right 
mouse button the following dialog is displayed.

No prot. ctrl. reg.:
The first control register used in the No protocol mode. The No protocol 
mode is described in chapter “Communication”.

No protocol on signal:
A digital signal for switching between No protocol and Transparent 
modes. Used for switching between No protocol and Transparent modes 
in run-time mode, for example, to ring up a computer and send a message.

Note!
The settings on the printer are used for parameters such as character set, character 
size and margins.
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5.17 The Block Manager Menu
The Block manager menu has functions for creating blocks and block 
jumps.

5.18 The Transfer Menu
The Transfer menu has functions for the transfer of projects as well as 
communication settings for transferring between a PC and the terminal. 
See the chapter “Project transfer”.

Note!
The communication settings must be the same in the PC software as in the terminal.
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5.19 The Window Menu
In the window menu there is basic functions for windows and functions 
unique for MAC Programmer+. Here we only describe the functions spe-
cial for MAC Programmer+.

Draft Move & Size
The function turns off the immediate updating of the sized/moved object. 

Show Terminal
A terminal is drawn around the working area in the graphic block editor. 
From this terminal you can reach the editors for defining LEDs, function 
keys and insertable text strings. When you double click on the respective 
function the corresponding dialog is displayed.

Show Background block
Only valid for graphic blocks. The background block is shown when edit-
ing in the graphic block editor. 

Use Block list
You can select if the software shall activate the block manager or the block 
list when you create a new project. 

Tool tips
Show explantory text for the function the cursor are pointing at.
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Use terminal font
The character set defined in Country settings in the Setup menu is used in 
MAC Programmer+. This makes it possible to edit, for example, Russian 
projects without a russian version of Windows.

Toolbar
Show the toolbar.

Status Bar
Show the status bar

Toolbox
Show the toolbox.

Align Toolbox
Show the align toolbox.

Block Manager toolbox
Show the toolbox for the block manager.

Editor
Open stated graphic editor.

5.20 The Help Menu
The Help menu contains help texts.
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6 Graphic presentation and maneuvering

In this section the graphic objects are first presented in tabular form and 
each object is then described. 

6.1 General parameters

Colors
In terminals supporting colors there are 16 colors available for objects, 
black, red, prussian blue, magenta, yellow, gray, light gray, light green, 
light red, light prussian blue, light magenta, light yellow and white. Bit-
maps can be shown in 256 colors

The colors allow the creation of more realistic objects with 3-D effects and 
shadowing. Apart from background and foreground colors for the blocks, 
the colors can also be selected for the graphic objects.

The colors for the background, text and windows are determined when 
the terminal is configured. Colors can be chosen, for example, for the 
scales and curves for graphic objects.

Scaling
The Offset and Gain parameters are used to change the scale of the register 
value to a shown value according to the following equation:

DisplayValue=Offset+Gain*RegisterValue

When the object is altered from the terminal in the run-time mode, the 
scale is changed for the shown value according to the following equation:

RegisterValue=(DisplayValue-Offset)/Gain

Scaling does not affect the defined max and min values nor the number of 
decimal places.

Note!
The functions Increment and Decrement affect the RegisterValue of the maneuverable 
object, and not the DisplayValue.
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Offset and Gain calculation
The OGC function in MAC Programmer+ is an aid for calculating the 
Offset and Gain parameters. Enter the max and min values for the PLC 
register and the max and min values for the presented value. The function 
will then calculate the correct value of the parameters Offset and Gain.

6.2 Graphic objects

Static graphic objects
Static graphic objects are used to draw graphics that are not affected by the 
process.

Note!
Static object will always be drawn behind dynamic objects in run-time mode.

Symbol Object

Arc

Ellipse, filled

Line

Polygon line

Rectangle, filled, 3-D

Key field object

Symbol 

Text
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Dynamic digital graphic objects
Dynamic digital graphic objects are linked to digital signals in the PLC 
system.

Dynamic analog graphic objects
Dynamic analog graphic objects are linked to the registers in the PLC 
system.

Note!
It is not allowed to place dynamic objects on top of each other.

Symbol Object Description

Digital symbol Switch between two symbols depending on the state of a 
digital signal.

Digital text Switch between two texts depending on the state of a 
digital signal.

Filled object Used to fill in a framed area in one of two colors depend-
ing on the state of a digital signal.

Note!
It is not allowed to place dynamic objects on top of each other.

Symbol Object Description

ASCII Handle ASCII strings in Graphic blocks. 

Analog fill Used to fill in a framed area in one of sixteen colors 
depending on the value of a register.

Diagram Used to draw X/Y diagrams based on the content of the 
PLC registers.

Multichoice Linked to a PLC register which can assume up to eight dif-
ferent states. Text of up to 30 characters can be linked to 
each state.

Multisymbol Shows one of up to eight symbols depending on the value 
in the PLC register. Also allows moving of a symbol 
across the screen.
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Other objects

Numeric Entering and presentation of values as numbers 

Slide Makes possible increasing and decreasing the value of an 
analog signal. 

S meter Creates a graphic speedometer on the display.

Bar Presents values as a bar chart.

Trend Presents values collected from the registers as a curve.

VU meter Creates a graphic VU meter on the display.

Message Used to display texts from a Message library.

Analog numeric
table

Creates a table with numeric objects.

Touch key Only E910. Used to create a pressure-sensitive surface on 
the screen.

Symbol Object Description

Jump Jump to another block.

Alarm banner Used to show a line in the alarm list.

Digital clock Object to show a digital clock.

Analog clock Object to show an analog clock.

TCP/IP 
Command 
promt

Object to send TCP/IP commands to other units. Only 
valid if the terminal is used in a TCP/IP network.

Symbol Object Description
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Alarm banner

Object used to show a line in the alarm list.

Parameter Description

List line 
number

States the number of the line in the alarm list from which infor-
mation is to be collected (1=first line, 2=second line etc.) if the 
stated alarm group is shown in the alarm list.

Positions The number of positions to be displayed.

Font size Select font size for the text in the object.

Alarm group States which alarm group will be shown on the alarm line. The object 
will be shown in the color specified for the alarm group.

Security level Select security level for the object.

Show day of 
the week

Select whether the day of the week will be shown in the alarm line.

Show date Select whether the date will be shown in the alarm line.

Show time Select whether the time will be shown in the alarm line.

Show symbol Select whether the alarm status symbols will be shown in the alarm 
line. See the chapter “Alarm handling”.

Ack possible Select whether it will be possible to acknowledge the alarm with the 
ACK key on the terminal.

Frame Select if a frame shall be drawn around the object.

BG Select background color for the object.

Note!
The foreground color of the alarm text is defined in the alarm group definition.
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Analog clock

Time object for presenting an analog clock.

Parameter Description

Seconds Select whether the clock will be shown with a second hand.

Frame Select whether the clock shall be shown with a frame.

BG Select background color for the object.

Scale Select the color of the scale in the object.

Hand Select the color of the second hand in the object.

Note!
A maneuverable Date/Time object must be defined to set the clock in the terminal 
during run-time.
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Analog fill

Objects used for filling framed areas with one of sixteen colors depending 
on the value in a register. The colors are used according to the following 
table.

For limitations and how to place an object, see “Digital fill”.

Parameter Description

Analog signal State the register whose value decides the color of the object. 
See the following table.

Register value Color Register value Color

0 Black 8 Gray

1 Blue 9 Light blue

2 Green 10 Light green

3 Cyan 11 Light cyan

4 Red 12 Light red

5 Magenta 13 Light magenta

6 Yellow 14 Light yellow

7 Light gray 15 White
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ASCII

Object for handling ASCII strings in Graphic blocks. ASCII objects pro-
vide the opportunity to present texts stored in the CPU’s data registers. 
The texts should be in IBM extended ASCII format. The text is converted 
from 8-bit IBM extended ASCII to Swedish 7-bits ASCII if SW is stated on 
the command line in System Signals.

Parameter Description

Analog signal State the register where the text for the first position is to be 
stored. 

Positions State the number of positions the text will occupy on the display. 
Each register contains two characters (occupying two 
positions). 

Font size Select font size.

Security Level Select security level for the object.

Maneuverable When selected the object can be forced from the terminal in run-
time mode.

Adjustment Select whether the object is to be left aligned or centred.

Frame Select if a frame shall be drawn around the object.

BG Select background color of the object.

Text Select the color of the text in the object.
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Bar

Objects which present whole or decimal numbers in the form of a bar 
graph.

Parameter Description

Analog signal The address of the signal. 

Minimum value The minimum value the signal can have.

Maximum value The maximum value the signal can have.

Direction Select whether the bar is to be shown to the right, left, up or down.

Scale Select whether the scale is to be shown.

Box Select whether a box is to be drawn around the bar.

Indicators Select whether the highest and/or the lowest value for the signal 
shall be shown on the axis. Indicators are set to zero when the 
terminal is switched on. Zeroing can also be carried out in the run-
time mode, see the Maneuvering Graphic blocks section. The indi-
cators only function for 16-bit numbers.

Scale division State the interval between the scale numbers to be drawn.

Scale ticks State the interval between the scale ticks displayed.

Fill Select fill color.

Offset and Gain Used to scale register value. See the section “General parameters”.

Frame Select if a frame shall be drawn around the object.

BG Select background color for the object.

Scale Select the color of the scale in the object.
6-9



Graphic presentation and maneuvering

6-10
Diagram

Objects used to draw X/Y diagrams or bar graphs based on the content of 
the PLC register. This is a real-time function. The object is normally used 
for non-time-based presentations. Time-based display with a sample time 
of <1 second can be shown if the PLC creates data collection. As an 
example we shall say the value in data register 100 is the first X-coordinate 
and the value in data register 200 the first Y-coordinate. The number of 
register pairs will be 4. The table and the figure below illustrate our exam-
ple.

X-coordinate Register Value Y-coordinate Register Value

X0 100 0 Y0 200 11

X1 101 41 Y1 201 40

X2 102 51 Y2 202 85

X3 103 92 Y3 203 62

X0,Y0 X1,Y1

X2,Y2
X3,Y3
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Parameter Description

Register pair count The number of register pairs to be drawn as dots or bars for the 
curve.

Value form Select whether the diagram shall be a bar graph or linear graph 
for the curve. A bar is drawn for each register pair in the bar 
graph. The X/Y coordinates are marked in as dots between 
which a line is drawn in a linear graph.

Maneuverable Select if the curve respective can be altered from the terminal 
in run-time mode.

Curve Select the color of the curve.

X Analog signal The PLC register which contains the first X-coordinate for the 
curve.

Y Analog signal The PLC register which contains the first Y-coordinate for the 
curve.

Y Scale division The interval between the scale numbers on the Y-axis.

Y Scale ticks The interval between the scale ticks displayed on the Y-axis.

Y Minimum value The minimum value of the Y-coordinate.

Y Maximum value The maximum value of the Y-coordinate.

X Scale division The interval between the scale numbers on the X-axis.

X Scale ticks The interval between the scale ticks displayed on the X-axis.

X Minimum value The minimum value of the X-coordinate.

X Maximum value The maximum value of the X-coordinate.

Current graph signal The register which contents decides what curve to be edited in 
run-time mode.

Current cursor 
signal

The register which contents decides which point on the curve to 
be edited in run-time mode.

X Edit step The size of the step when you press an arrow key in run-time.

Y Edit step The size of the step when you press an arrow key in run-time.

Frame Select if a frame shall be drawn around the object.

Grid When selected a grid is drawn in the diagram.

BG Select background color of the object. 

Scale Select the color of the scale for the object.

Grid color Select the color of the grid in the diagram.
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Digital Clock

Time object for presenting a digital clock.

Parameter Description

Day of the week Select whether the day of the week will be shown.

Date Select whether the date will be shown.

Time Select whether the time will be shown.

Time format Time can be shown either as AM/PM or a 24-hour clock.

Maneuverable Select whether the clock can be reset in run-time mode.

Frame Select if a frame shall be drawn around the object.

Font size Select font size for the text in the object.

Security level Select security level for the object. 0 means no security level.

BG Select background color.

Text Select the color of the text in the object.

Note!
A maneuverable Date/Time object must be defined to set the clock in the terminal 
during run-time.
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Digital fill

Objects used for filling framed areas with a selected color.

Note!
Filling areas that are too irregular can cause system failure in run-time mode. Filling 
can, in certain cases, make the screen slow.

Parameter Description

Digital signal The address of the digital signal. 

Maneuvrable When selected the object can be forced from the terminal in run-
time mode.

Security Level Select security level for the object.

On Select the color of the object when the signal is 1.

Off Select the color of the object when the signal is 0.
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Placing an object
The program calculates what is to be filled in the specified area. It is there-
fore important that the object is correctly placed. Incorrect placed fillers 
may cause errors in the application during run-time. The filled area is lim-
ited only by static objects and static parts of dynamic objects. Fill objects 
can be replaced with Digital Symbol or Multi Symbol to give better per-
formance to the project.

Good! To give the display better Bad! The display will be slow,
response, frame the text so it does because the program must make
not need to be filled. many calculations to fill in the

irregular areas between letters.

TEXT TEXTxObject’s 
placement

x

Object’s 
placement
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Digital symbol

Object that is used to switch between two chosen symbols depending on 
the state of a digital signal.

Parameter Description

Digital signal The address of the signal.

Symbol OFF Select the symbol that is to be shown when the signal is 0.

Symbol ON Select the symbol that is to be shown when the signal is 1.

Maneuverable When selected the object can be forced from the terminal in run-
time mode.

Security Level Select security level for the object. 0 means no security level.
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Digital text

Text object which is used to switch between two entered texts depending 
on the state of a digital signal. The maximum text length is 30 characters.

Parameter Description

Digital signal The address of the digital signal.

Text 0 The text that is to be shown when the signal is 0.

Text 1 The text that is to be shown when the signal is 1.

Font size Select font size.

Security Level Select security level. 0 means no security level.

Maneuverable When selected the object can be forced from the terminal in run-
time mode.

Adjustment Select whether the text is to be left aligned or centred.

Frame Select if a frame shall be drawn around the object.

BG Select background color of the object.

Text Select text color in the object.
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Jump

Object for jumping to another block. Makes it possible to build up a 
hierarchy of menus in the application. Jumping back to the previous block 
is done by pressing the [PREV] key (up to nine levels back). See chapter 
“Function keys”.

Parameter Description

Jump to block States the number of the block to which the jump is to be made.

Text Enter any text that will be displayed.

Positions The number of positions the text will take up on the display.

Font size Select font size.

Adjustment Select whether the text shall be left aligned or centred.

Frame Select if a frame shall be drawn around the object.

BG Select background color for the object.

Text Select the color of the text in the object.

Note!
If a jump is generated to a block that does not exist in run-time mode, an error message 
is shown.
6-17



Graphic presentation and maneuvering

6-18
Message

Message object presenting texts from message libraries.

For more detailed information, see the chapter “Message library”.

Parameter Description

Analog signal Analog signal controlling which text from message chosen library is 
to be shown. 

Library Select the number of a message library. Defined under Message 
Library in the Function menu.

Font size Select font size of the text.

Positions Number of positions to be displayed. 0=automatic adjustment

Security level Select security level for the object. 0 means no security level.

Maneuverable 
range

A range of maximum 64 texts can be maneuverable in run-time 
mode. State the numbers of the first and the last texts of the range. 
See the section “Maneuvering Graphic Blocks”.

Adjustment Select if the text shall be left aligned or centerd.

Frame Select if the text shall be displayed with a frame.

Note!
When using Library index register the number of positions should not be 0 since the 
automatic length adjustment does not work.



Graphic presentation and maneuvering
Multiple choice

Objects that can have several states. The object is linked to a register which 
can assume a maximum of eight states. Each state can be allocated a text, 
maximum 30 characters long.

Parameter Description

Analog signal The register that decides which text is to be displayed.

Text 0-7 The texts that are to be shown for each state of the object.

Man 0-7 When selected the object can be maneuvered to this state in run-
time mode. See the section “Maneuvering Graphic Blocks”.

Adjustment Select whether the text shall be left aligned or centred.

Frame Select if a frame shall be drawn around the object.

Font size Select font size in the object.

Security Level Select security level for the object.

BG Select background color for the object.

Text Select the color of the text in the object.
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Multisymbol

Objects that can show one of a maximum of eight different symbols 
depending on the value in a data register. The PLC register can also 
control the symbol’s location on the display.

Parameter Description

Analog signal The register that decides which symbol to be displayed. If the 
register contains the value 1 symbol 1 is displayed etc.

Move X The value which contains the X-coordinate for the object. 
Permissible values are 0-639.

Move Y The value which contains the Y-coordinate for the object. 
Permissible values are 0-479.

Symbol 0-7 Select the symbol to be displayed. If the value of the register is 0, 
then symbol 0, is displayed etc.

Note!
Move X and Move Y only need to be stated if the object is to be moved around on the 
display with the help of the PLC.



Graphic presentation and maneuvering
Numeric

Objects for entry and presentation of values in numerical form. It is used, 
for example, to create entry fields.

Parameter Description

Analog signal The address of the signal.

Positions The number of positions the entered value will take up including 
comma and minus sign.

Decimals The number of decimals with which the value shall be entered.

Minimum value The minimum limit for maneuvering.

Maximum value The maximum limit for maneuvering.

Offset and Gain Used to scale register value. See the section “General parame-
ters”.

Font size Select font size in the object.

Security Level Select security level for the object.

Adjustment Select if the input field shall be left aligned or centred.

Frame Select if a frame shall be drawn around the object.

Maneuverable Select if the object can be altered from the terminal in the run-time 
mode.

Zero fill Select if zeros are to be printed out in empty positions.

BG Select background color for the object.

Text Select the color of the text in the object. 
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Numeric table

Object for creating a table of analog numeric objects.

Parameter Description

Analog signal The first signal to be presented in the table. Only 16-bit registers 
can be used if version 4.0 or higher on the terminal are used.

X-size State the number of signals to be presented horizontally.

Y-size State the number of signals to be presented vertically.

Positions The number of positions you should enter the value with including 
comma and minus signs.

Decimals The number of decimals with which you should enter the value.

Minimum value The minimum limit for maneuvering.

Maximum value The maximum limit for maneuvering.

Offset and Gain Used to scale register value. See the section “General parame-
ters”.

Font size Select the size of the text in the object.

Security level Select the security level for the object.

Maneuverable Select whether the object can be altered in the run-time mode.
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Zero fill Select if zeros are to be printed out in empty positions.

Direction Select direction for the object, horizontal or vertical. The signals in 
the table are calculated after this direction.

Table frame Select whether the whole table shall be shown with a frame.

Adjustment Select whether the entry field shall be left aligned or centred.

BG Select background color for the object.

Text Select the color of the text in the object. 

Item frame Select if every single item in the table shall be shown with a frame.

Note!
Minimum value and maximum value are only active when maneuvering the object.

Parameter Description
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Slide

Objects which make it possible to increase or decrease the value of an 
analog signal.

Parameter Description

Analog signal The address of the analog signal.

Scale division State the interval between the scale numbers to be drawn.

Scale ticks State the interval between the scale ticks displayed.

Minimum value The minimum value the object can have.

Maximum value The maximum value the object can have.

Offset and Gain Used to scale register value. See the section “General parame-
ters”.

Security level Select security level for the object.

Maneuverable Select whether the object can be altered from the terminal in the 
run-time mode.

Direction Select whether the object shall be presented vertically or to the 
right.

Frame Select if a frame shall be drawn around the object.

BG Select background color for the object.

Scale Select color of the scale in the object.

Button Select color of the indication button in the object.

Note!
The data type formats BCD float and Float without exponent do not work for slide 
objects.
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S-meter

Objects for creating a graphic speedometer on the display.

Parameter Description

Analog signal The address of the signal.

Scale division State the interval between the scale numbers to be drawn.

Scale ticks State the interval between the scale ticks displayed.

Minimum value The minimum value the object can display.

Maximum value The maximum value the object can display.

Angle State the angle, working area, for the object. 10-360 degrees.

Offset and Gain Used to scale register value. See the section “General parame-
ters”.

Frame Select if a frame shall be drawn around the object.

BG Select background color for the object.

Scale Select the color of the scale in the object.

Needle Select the color of the needle in the object.
6-25



Graphic presentation and maneuvering

6-26
TCP/IP Command promt

A window in which TCP/IP commands can be entered and sent between 
terminals and personal computers in a TCP/IP network. In run-time, 
previous commands can be called up with the arrow keys [Up] and 
[Down].

Parameter Description

No. of columns The width of the window.

No. of rows The height of the window.

Font size Select font size in the object.

Enable acceler-
ator keys

Select whether the function keys F1-F4 should write predefined com-
mands in the window.

Accelerator 
keys

Enter any command that will be written at the command promt by 
pressing respective function key.

Frame Select the type of frame with which the window will be shown.

BG Select background color for the window.

Text Select the color of the text in the window.
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Commands for the TCP/IP Command promt.

For further information about the TCP/IP network we refer to the chapter 
“Network communication”.

Command Description

IPCONFIG Gets network parameters.

PING Testing if a host is available.

ROUTE Show, add, delete routes.

ARP Show, add, delete IP/Hardware address.
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Touch key 

Only valid for the E910. See the section “Maneuvering Graphic Blocks”.

The object is a pressure-sensitive surface whose function corresponds to a 
function key. The object is used to change pictures, control digital signals 
and so on. 

An invisible, pressure-sensitive “virtual” surface can be used to define the 
area for block changes in an overview display of, for example, a machine. 
Detailed images are linked to defined parts of the overview display. When 
the pressure-sensitive areas are pressed, the detailed images appear. 

Parameter Description

Action The type of signal the object shall affect. Predefined functions are 
described in the chapter “Function keys”. Increment, Decrement 
and Set are not available.

Digital signal The digital signal affected by the object if I/O is selected under 
Action.

Block The block that will be displayed if the object is defined as a jump 
object if block type is selected under Action.

Security level Select security level for the object.

Button type Select required type of button, circular, rectangular or invisible.

IO event States how the object shall affect the signal.
Momentary means that the signal is affected as long as the object is 
touched.
Toggle means that the signal is set to one or zero alternately when 
the object is affected.
On means that the signal is set when the object is affected.
Off means that the signal is reset when the object is affected.

BG Select background color for the object.
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Trend

Objects which graphically present collected values from analog signals.

Parameter Description

Name State the name of the object. The name must be unique for 
each object.

Curve Select the curve you want to edit (1-6).

Analog signal The analog signals the object shall sample and present the 
values for. Only 16-bit numbers can be used. For valid devices 
see the driver manual.

Color Select a color for each curve.

Offset and Gain Used to scale register value. See the section “General param-
eters”.
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Enable The digital signal which when set starts the collection of 
data. Data collection ceases if the signal is set to zero. The 
parameter does not need to be stated.

Y Min value reg. The minimum value on the Y-axis loaded from the stated PLC 
register.

Y Minimum value The minimum value on the Y-axis. (If Y Min value reg. is 
defined this is the minimum value that can be loaded from 
the register.)

Y Max value reg. The maximum value on the Y-axis loaded from the stated PLC 
register.

Y Maximum value The maximum value on the Y-axis. (If Y Max value reg. is 
defined this is the maximum value that can be loaded from 
the register.)

Y Scale States which side of the Y-axis shall be shown, to the left, 
right, both or neither.

Y Scale division The interval between the scale numbers on the Y-axis.

Y Scale ticks The interval between the scale ticks displayed.

X Sample interval States the time interval between the collection of data. Mini-
mum value is 1 second and maximum value is 100 hours.

X Stored samples States how many values shall be stored. The maximum 
number of values are 4800.

X Time range States the time interval to be shown in the trend diagram.

X Time scale division The interval between the scale numbers on the X-axis.

X Time scale ticks The interval between the scale ticks displayed.

Sample full limit State the number of samples when the samples full signal 
shall be set.

Sample full signal Select a signal which will be set when the number of samples 
reach the value stated in the parameter Sample full limit.

Frame Select if a frame shall be printed around the object.

BG Select background color for the object.

Scale Select the color of the scale in the object.

Erase trend data 
signal

The digital signal which when set will erase all historic trend 
data.

Grid Select if grid shall be displayed in the object.

Grid color Select a suitable color for the grid.

Note!
If you copy a block containing a trend object you must change the name of the trend 
object. Two trend objects may not have the same name. 

Parameter Description
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VU-meter

Object for creating a graphic VU meter on the display.

Parameter Description

Analog signal The address of the signal.

Scale division State the interval between the scale numbers to be drawn.

Scale ticks State the interval between the scale ticks displayed.

Minimum value The minimum value the signal can have.

Maximum value The maximum value the signal can have.

Offset and Gain Used to scale register value. See the section “General parame-
ters”.

Frame Select if a frame shall be drawn around the object.

BG Select background color for the object.

Scale Select the color of the scale in the object.

Needle Select the color of the needle in the object.
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6.3 Maneuvering Graphic Blocks
Not valid for the E910.

Move between the maneuverable objects with the arrow keys. Objects se-
lected are highlighted with a blinking frame.

Selecting maneuverable objects
The arrow keys are used to jump between maneuverable objects in the 
terminal during run-time. The choice of object is according to the follow-
ing principle: The cursor’s position is assumed to be the center of a cross. 
Press the right arrow and the first object found in area A according to the 
diagram below is selected. Should the system not find an object in the n
arrow field on the right, it searches in area a. The down arrow searches in 
areas B and b, the left arrow searches in areas C and c and the up arrow 
searches in areas D and d.

.

Digital objects
Digital objects, text, symbol and filled objects, switch status when 
[ENTER] is pressed. If the INC and DEC functions have been linked to 
function keys, the signal linked to the object with these keys is set and re-
set respectively.

Cursor position

d

A

a
B

b

C

c
D
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Analog objects

ASCII objects
Mark the object and enter the required text. Finish writing with [ENTER].

Message objects
Place the cursor on the object and press [ENTER]. An option list is now 
shown with all the maneuverable states. Move stepwise to the required 
state and press [ENTER] and the analog signal linked to the object is 
forcibly set.

Multichoice objects
Place the cursor on the object and press [ENTER]. An option list is now 
shown with all the maneuverable states. Move stepwise to the required 
state and press [ENTER] and the analog signal linked to the object is 
forcibly set.

Numerical objects
To maneuver numerical objects write in the value and press [ENTER]. If a 
value too high or too low is entered the max or min value for the object is 
shown. This information will also be shown if you press [ENTER] when 
the object is maneuverable.

Numerical table objects
When the table object is marked, press [ENTER] to select the first item in 
the table. Use the arrow keys to move the cursor between the items in the 
table. Change the value in the marked item and press [ENTER].

Potentiometer objects
The object is maneuvered with the arrow keys by placing the cursor on the 
object and pressing [ENTER]. The value can now be increased/decreased 
with the number that corresponds to the setting ”Scale Ticks” in the object. 
End maneuvering with [ENTER].

The object can also be maneuvered with the Increment and Decrement 
functions on the condition that they are linked to the function keys, see the 
“Function keys” chapter.
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Bar object
The min/max indicators for bar objects can be set at the current value by 
pressing [ENTER].

The max/min indicators are reset when you touch the bar.

Trend objects
Trend curves can show historic data in the run-time mode. Mark the 
required trend object and press [ENTER]. A dialog square is now shown 
and the date for the data to be presented can be chosen. ”History” is 
shown at the bottom of the square. Press [ENTER] again to return to real-
time display. Trend data is stored in the files whose names are stated 
when the trend object is defined.
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Other objects

Digital clock
The digital clock can be altered by marking the object and giving the 
required time. Finish with [ENTER].

Jump object
Mark the object and press [ENTER].

TCP/IP Command promt
TCP/IP Commands can be written on the highlighted row. Previous 
commands can be called up by pressing the arrow keys [Up] and [Down].

6.4 Using the touch screen
This section is only valid for the E910.

The E910 does not have a built-in keyboard. All maneuvering takes place 
using the touch screen. Because of its sensitivity, you should only press 
one point on the screen at any given time. Otherwise, the terminal will 
interpret the midpoint of two points pressed. 

Digital objects
Digital objects, text, symbol and filled object change status when you 
touch them.

Analog objects

ASCII objects
When you touch the object an alphanumeric keyboard will be shown on 
the screen. Touch in the required text and end with [ENTER].

Multichoice objects
When you touch the object a choice list appears. Select the required object 
by touching it.

Note!
If you use the clock in the PLC system and you want to change it, this must be done in 
run-time mode.
6-35



Graphic presentation and maneuvering

6-36
Numerical objects
When you touch the object a numeric keyboard appears. Touch the new 
value and end with [ENTER].

Numerical table objects
When you touch the item in the table object, a numeric keyboard appears. 
Touch the new value and end with [ENTER].

Potentiometer objects
Touch the button in the object and drag to maneuver the object.

Bar object
The max/min indicators are reset when you touch the bar.

Trend objects
Trend curves can show historic data in run-time. When you touch the 
object, a dialog box appears where you can choose the time interval and 
date for presented data.

Double arrow Move the trend one window.
Single arrows Move the trend 1/4 window.
- Zoom up the trend.
+ Zoom down the trend.
^ Return to default settings.

Return to real-time trend by touching the object again.
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Other objects

Digital clock
When you touch the object a numeric keyboard appears. Touch the 
required time and end with [ENTER].

Jump object
Touch the object to activate the jump.

Alphanumeric keyboard
The alphanumeric keyboard appears when you maneuver, for example, 
an ASCII object. 

Note!
If you use the clock in the PLC system and you want to change it, this must be done in 
run-time mode.

Key Description

A-Z Used to enter required text.

ESC Close down the keyboard and return to previous level.

← Delete one character to the left.

CLR Delete all characters.

DEL Delete the character on cursor position.

↵ Confirm the settings and close down the keyboard.

» Move the cursor to the right.

« Move the cursor to the left.
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Numeric keyboard
The numeric keyboard appears when you maneuver, for example, a 
numeric object. 

a-z Switch between upper case and lower case letters.

0-9 Switch between lower case letters and digits and special 
characters. 

Key Description

0-9 Used to enter required text.

ESC Close down the keyboard and return to previous level.

← Delete one character to the left.

CLR Delete all characters.

DEL Delete the character at cursor position.

↵ Confirm the settings and close down the keyboard.

» Move the cursor to the right.

« Move the cursor to the left.

Key Description
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Choice list
Choice lists will also appear on the screen. In the choice list you use the 
arrows to show the uppermost or lowermost choice. 
[CANCEL] is used to close down the list without making a selection.
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7 Text-based presentation and
maneuvering

Text-based presentation and maneuvering are used to create operator 
dialogs in text-based terminals or are suitable for generating report print-
outs of various kinds. These can be daily reports, status reports etc. For an 
example of what a report looks like see the “Report print-outs” chapter. 
Text objects in tabular form are shown in this section. Every object is then 
described separately.

7.1 General parameters

Scaling
The Offset and Gain parameters are used to change the scale of the register 
value to a shown value according to the following equation:

DisplayValue=Offset+Gain*RegisterValue

When the object is altered from the terminal in the run-time mode, the 
scale is changed for the shown value according to the following equation:

RegisterValue=(DisplayValue-Offset)/Gain

Scaling does not affect the defined max and min values nor the number of 
decimal places.

Offset and Gain calculation
The function OGC in MAC Programmer+ is an aid for calculating the Off-
set and Gain parameters. Enter the max and min values for the PLC regis-
ter and the max and min values for the presented value. The function will 
then calculate the correct value of the parameters Offset and Gain.

Note!
The functions Increment and Decrement affect the RegisterValue of the maneuverable 
object, and not the DisplayValue.
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7.2 Text object

Dynamic text object

Symbol Object Description

Analog Presents values in numerical form.

Date/time Setting of date and time. 

Digital Switch between two texts depending on the state of a 
digital signal.

Multiple-choice Links to a PLC register which can assume up to eight dif-
ferent states. A text of 30 characters can be linked to 
each state.

Jump Jump to another block.

Bar graph Presents values as a bar graph.

Text Handles ASCII strings.

Message Object showing texts in a message library
.
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Analog object

Object which presents values in numerical form as whole or decimal 
numbers.

Parameter Description

Analog signal The address for the signal.

Positions The number of positions used by the object. Characters such as 
minus sign or decimal points must also be counted.

Decimals The number of decimal places which represent the object. 

Maneuverable States if the object can be altered in run-time.

Minimum value The minimum value you can enter for an object.

Maximum value The maximum value you can enter for an object.

Offset and Gain Used to change scale of the register value. See the section 
General parameters.

Note!
Minimum value and maximum value are only valid when maneuvering the object.
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Bar graph object

Presents values in the form of a bar graph. The bar will be horizontal so 
that the maximum number of positions are marked when the value has 
reached its maximum level.

Parameter Description

Analog signal The address for the signal.

Positions The number of positions which the signal uses.

Direction States whether the bar will be presented to the right or left.

Minimum value The minimum value for the object.

Maximum value The maximum value for the object.

Offset and Gain Used to change scale of the register value. See the section 
“General parameters”.
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Date/time object

Object for setting date and time. Date and time objects collect data from 
the real-time clocks in the terminal or the controller system.

Parameter Description

Day of the week States if the day of the week will be shown. Requires two 
positions.

Date States if the date will be shown. Use the form given in Date/time 
format in configuration.

Time States if the time will be shown. Use the form given in Date/time 
format in configuration.

Maneuvrable Select if the object can be altered in run-time mode.

Note!
A maneuverable Date/Time object must be defined to set the clock in the terminal 
during run-time.
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Digital text

Object that can assume two states, zero or one.

Parameter Description

Digital signal The address for the signal.

Text 0 The text shown when the signal is zero.

Text 1 The text shown when the signal is one.

Maneuverable Select if the object can be altered in run-time mode.
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Jump object

Object for jumping to another block. Makes it possible to build up a 
hierarchy of menus in the application. Jumping back to the previous block 
is done by pressing the [PREV] key (up to nine levels back). See chapter 
“Function keys”.

Parameter Description

Current block States the number of the block left.

Jump to block States the number of the block to which the jump is to be made.

Note!
If a jump is generated to a block that does not exist in run-time mode an error message 
is shown.
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Message object

Message object presenting texts from message libraries.

For more detailed information, see the chapter “Message library”.

Parameter Description

Analog signal Analog signal controlling which text from chosen message library to 
be shown. For valid devices see the driver manual.

Library Select message library. Defined under Message Library in the 
Function menu.

Positions Number of positions to be displayed. 0=automatic adjustment.

Maneuverable 
range

A range of maximum 64 texts can be maneuverable in run-time 
mode. State the numbers of the first and the last texts of the range. 
Sse the section “Maneuvering Textblocks”.

Note!
When using indexed message libraries the number of positions should not be 0 since 
the automatic length adjustment does not work.
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Multiple choice object

The object is linked to up to three digital signals which together can 
assume eight different states. A text of 30 characters can be linked to each 
state.

Parameter Description

Analog signal This register decides which text is to be presented. For valid 
devices see the driver manual.

Text 0 - Text 7 The texts that will be shown for each state of the object.

Man 0 - Man 7 States whether it is possible to maneuver this status in run-time 
mode. See the section “Maneuvering Textblocks”.
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Text object

Object for handling ASCII strings. It is possible to present the text stored 
in the registers of the controller system. Texts should be in ASCII format. 
The texts can be altered in run-time mode from the terminal by opening 
and closing the entry field with [ENTER].

The text is converted from 8-bit IBM extended ASCII to Swedish 7-bits 
ASCII if SW is stated on the command line in System Signals.

Parameter Description

Analog signal The register where text for the first position is stored. 

Positions Each register contains two characters (occupying two positions). 
The basic setting is 8 positions which is equivalent to four registers.

Maneuverable Select if the object can be forcibly set in the run-time mode.
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7.3 Maneuvering Textblocks
textblocks consist of text lines with static and dynamic objects. The 
dynamic objects show the current status for those signals to which the ob-
ject is linked. Certain dynamic objects are maneuverable which means 
that you can change their status and values in run-time mode. 

To alter a maneuverable object, use the arrow keys to move the cursor to 
the right position so that the object is marked. Textblocks can be scrolled 
vertically but not horizontally

Digital objects
Digital objects are maneuvered by marking the required object. Then 
press [ENTER] to alter the status of the object.

Analog objects

Analog and Date/Time
The objects are maneuvered by placing the cursor on the right object. After 
this the new value is written in. Finish with [ENTER].

Before [ENTER] is pressed, new value entry can be aborted by leaving the 
field with [↑] or [↓]. The old value will then be retained.

Text objects
Maneuver a text object by moving to the object and pressing [ENTER]. An 
entry field is then shown. The entry field is either on the first or last line 
depending where the object is on the display. Scrolling of the entry field 
takes place if the text is longer than the width of the display. Press [EN-
TER] when writing is complete.

Message objects
Maneuver a message object by moving to the object with the arrow keys 
and press [ENTER]. An option list is now shown with all maneuverable 
states on the display. Move to the required state, press [ENTER] and the 
analog signal linked to this state is forcibly set.
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Multichoice objects
Maneuver a multichoice object by moving to the object with the arrow 
keys and press [ENTER]. An option list is now shown with all maneuver-
able states on the display. Move to the required state, press [ENTER] and 
the analog signal linked to this state is forcibly set.

Jump object
Move to the object and press [ENTER].

Bargraph object
The indicators for min and max value can be set to the actual value for the 
bargraph object by first selecting the object and then pressing [ENTER].
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8 Historical trends

This section describes historical trends. This function means that analog 
values from the PLC system are collected and presented in a trend object 
while running. The presentation is in the form of a curve. The values col-
lected are stored in the terminal’s project memory. 

It is possible to define several independent trend curves in the same or 
different blocks. The total number is limited by the project memory and 
the RAM of the terminal. The use of other objects and functions addect the 
total number of trends in a project, for example, the number of alarms. 

Such things as the time interval between collection of data and how many 
values are to be stored are defined in the trend object.

Historic trend data

Project memory
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8.1 Calculate the trend size
If you want to know how much of the project memory the trend data will 
occupy the following calculation must be made.

S = TOS + AK (28 + (645 * ((AS / 100) + 1))

S=The number of bytes.

TOS=TrendObjektSize, if all parameters for a trend object are changed the 
TOS will be 320 bytes.

AK=The number of defined curves in the trend object.

AS=The number of Samples is rounded up to the nearest hundred.

Presentation in run-time mode
Trend curves can show historic data in the run-time mode. Mark the 
required trend object and press [ENTER]. A dialog square is now shown 
and the date for the data to be presented can be chosen. ”History” is 
shown at the bottom of the square. Press [ENTER] again to return to real-
time display. Trend data is stored in the files whose names are stated 
when the trend object is defined.

Note!
Even the RAM of the terminal can cause a limit to the number of trends in a project. 
The limit is dependent on other objects and functions used in the project.



Historical trends
8.2 Defining trend objects
Trend objects are defined as other dynamic objects in a block. The object 
can be linked to one to six analog signals. Unlike other objects, trend ob-
jects must be given a name with 1 to 8 characters. The first character must 
be a letter or a number. The standards for naming files in MS DOS are ap-
plied. The following parameters are defined for a trend object. Valid cha-
racters are 0-9, A-Z and _. The standards for naming files in MS DOS are 
applied. The following parameters are defined for a trend object. Under 
Terminal options in the Setup menu you can decide if trends are going to 
be stored when changed or if all samples shall be stored. For more infor-
mation see “The Setup Menu”.

Parameter Description

Name State the name of the object. The name must be unique for 
each object.

Curve Select the curve you want to edit (1-6).

Analog signal The analog signals for which the object shall sample and 
present the values. Only 16-bit numbers can be used.

Color Select a color for each curve.

Offset and Gain Used to scale register value. See the chapter “General”.
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Enable The digital signal which when set starts the collection of 
data. Data collection ceases if the signal is set to zero. The 
parameter needs not be stated.

Y Min value reg. The minimum value on the Y-axis loaded from the stated PLC 
register.

Y Minimum value The minimum value on the Y-axis. (Ignored if Y Min value reg. 
is defined).

Y Max value reg. The maximum value on the Y-axis loaded from the stated PLC 
register.

Y Maximum value The maximum value on the Y-axis. (Ignored if Y Max value 
reg. is defined.) 

Y Scale States which side of the Y-axis shall be shown, to the left, 
right, both or neither.

Y Scale division The interval between the scale number on the Y-axis.

Y Scale ticks The interval between the scale ticks displayed.

X Sample interval States the time interval between the collection of data. Mini-
mum value is 1 second.

X Stored samples States how many values shall be stored. The maximum 
number of values are 13000.

X Time range States the time interval to be shown in the trend diagram.

X Time scale division The interval between the scale number on the X-axis.

X Time scale ticks The interval between the scale ticks displayed.

Sample full limit State the number of samples when the samples full signal 
shall be set.

Sample full signal Select a signal which will be set when the number of samples 
reaches the value stated in the parameter Sample full limit.

Frame Select if a frame shall be prited around the object.

BG Select background color for the object.

Scale Select the color of the scale in the object.

Erase trend data 
signal

The digital signal which when set will erase all historic trend 
data.

Grid Select if grid shall be displayed in the object.

Grid color Select a suitable color for the grid.

Note!
If you copy a block containing a trend object you must change the name of the trend 
object. Two trend objects may not have the same name. 

Parameter Description
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8.3 Transferring trend data
Trend data and recipes can be transferred to and from a personal compu-
ter with the File Transfer program (an icon in the program group HMI 
Tools) for calculating statistics and other types of presentation and stor-
age.

Trend files and production methods can for example be opened directly in 
Excel for statistical calculations. Values can also be changed and thereafter 
transferred by copying or saving files in the unit. See the manual for HMI 
Tools.

Trend files
The name of the trend files is given for each trend when the trend objects 
are defined. The file will be allocated the extension .SKV. The format for 
each line in the trend file is as follows; 
DDDD;TTTT;AAAA;BBBB;CCCC;DDDD;EEEE;FFFF:

The oldest value is shown on the first line of the file and the latest on the 
last line. The .SKV format can be imported directly to Microsoft Excel. You 
can use the diagram manager to create statistical diagrams in Excel. It is 
not possible to alter something in the file and then send it back to the ter-
minal. The picture below shows an example of how it can appear in Excel.

Format Description

DDDD Date format given in Setup.

TTTT Time format given in Setup.

AAAA Trend curve 1.

BBBB Trend curve 2 (if defined).

CCCC Trend curve 3 (if defined).

DDDD Trend curve 4 (if defined).

EEEE Trend curve 5 (if defined).

FFFF Trend curve 6 (if defined).
8-5



Historical trends

8-6



Message library
9 Message library

With the message library function you create message tables where values 
between 0 and 65535 are linked to texts. The function is used for presen-
tation of each step in a sequence control. Another use is presenting error 
codes. An analog signal generates the error codes which are linked to texts 
in a message library. The function can also be used for operator communi-
cation. 

The message library is one or several message tables containing up to 512 
text strings each. Each text string can have a length of 40 characters.

Parameter Description

Library State a number of the message library.

Description State a name of the message library.
9-1



Message library

9-2
You edit a message library by marking a library and click on Edit. Several 
editing windows can be displayed at the same time.

Example
The following example shows how the function may be used. In a 
sequence control we want to display a text for each step in the sequence. 

Parameter Description

Text no State a number of the text, 0-65535.

Text Freely defined text which is displayed when current signal 
includes the text number for the text.

D0=0

D0=1

D0=2

D0=3

Put article on the conveyer

Fit detail X

Fit detail Y

Take article off the conveyer
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Start by creating a message library named Line1.

1. Select Message library in the View menu.

2. Define a number, in this case 0, and a name of the library, in this case 
Line1.

3. Click on Add.

A message library named Line1 has now been created. Thereafter you de-
fine the texts in the library. 

4. Mark the library, line1, and click on Edit.

In this dialog you define text number and text. In the field Text no you 
state a value of the analog signal linked to the message object. In the field 
Text state the text displayed in the message object.
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When the message library is defined, you create a message object in the 
project. Message objects can be defined in both text and graphic blocks.

5. Select the Message object in the toolbox. Place the cursor where you 
want to place the object and click. 

6. State the analog signal to control which text is to be displayed.

7. In the field library you select message library.

8. Select if the object should be maneuverable and between which texts it 
may be changed.
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10 Alarm handling

This section describes alarm management. The function is used to call the 
operators attention to events in the process that need immediate attention. 
This function is divided into alarm groups, alarm messages and an alarm 
list. The alarms can be divided into groups, for example, to create an order 
of priorities. The alarm messages are definitions of the signals that will ac-
tivate an alarm as well as the alarm message for each signal. The alarm list 
contains alarms caused in the run-time mode.

Alarm list
18.2.97 20:11:40 Conveyor 2 empty
18.2.97 20:35:09 Queue full
19.2.97 03:29:12 Low pressure
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10.1 Alarm grouping
Alarms in E900 can be divided into 16 groups and i E910 into 7-11 groups 
depending on selected font size. Each group can be allocated a certain 
color. Alarms can be sorted into groups in the alarm block. It is not nece-
ssary to define the alarm groups.

Defining alarm groups
Alarm groups are defined under Alarm groups in the Functions menu. 
The attribute for alarms in this group are decided in the following dialog 
box.

Parameter Description

Group name Any name for the alarm group.

Summary notify Active - Digital signal which is set to unity when there is an 
active alarm in the group.
Unack - Digital signal which is set to unity when there is an 
unacknowledged alarm in the group.

Remote acknowledge Digital signal which acknowledges all the alarms in the group 
simultaneously.

Colors States the colors for active, acknowledged, inactive alarms 
as well as the normal state for the alarm.
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10.2 Alarm messages
Alarm messages are defined under Alarms in the Functions menu. The 
alarm message is entered here with a maximum of 60 characters. More 
characters can be shown if a smaller font size is used in the alarm list. The 
message can contain dynamic data (just like a Textblock) which can be 
digital or analog. You can define 100-300 alarms depending on the appli-
cation.

Parameter Description

Alarm text An alarm text.

Signal The digital signal which when activated generates the alarm 
is stated here.

Alarm when signal is Select On if a set signal should cause an alarm. Select Off if 
a reset signal should cause an alarm.

Acknowledge notify Digital signal affected when the alarm is acknowledged. Nor-
mally the signal is set.

Reset The above signal is set to zero when the alarm is acknow-
ledged if Reset is marked.

Remote acknowledge Digital signal which acknowledges the alarm when activated.

Alarm group States the alarm group for the definition.
10-3



Alarm handling

10-4
10.3 Configuring the alarm list
General settings for the alarm list are made in Alarm settings in the Setup 
menu. Alarms take different amounts of space in the alarm list depending 
on the length of the alarm text and the number of objects in the alarm 
message.

S=19 * AO + NC

S = The number of bytes.
AO = The number of objects in the alarm message.
NC = The number of characters in the alarm message.

Info block State a block number of a text or graphic block. This makes 
it possible to give the operator a “help page” containing infor-
mation about the alarm and possible actions. 0 means that 
no blocks are linked to the alarm. If the information block is 
a textblock it will be included if the alarm is sent as an email 
message. See the section “Alarms in run-time mode”.

Mail to address When an alarm is activated an email can be sent to a 
predefined receiver. The alarm text is then the subject. See 
the section “SMTP Client” in the chapter “Network functions 
in the terminal”.

Ack. required States if the alarm should be acknowledged or not. A cross in 
the square means that the alarm must be acknowledged and 
no cross means that the alarm functions as an indicator 
alarm, that is as a form of information.

History States when the alarm shall be taken out of the alarm list. A 
cross means that the alarm remains in the list until the alarm 
list is full. No cross means that the alarm is taken out of the 
list when it is acknowledged and is no longer active. If the 
Acknowledge parameter is not marked then the alarm is 
taken out of the list as soon as it is not active.

To printer Whether the alarm message should be printed out directly if 
the alarm status changes is stated here.

Parameter Description
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Parameter Description

Active signal States the digital signal which the terminal set when there is an 
active alarm.

Unack signal States the digital signal which the terminal set when there is an 
unacknowledged alarm.

List erase signal States the digital signal which when set erases all not active 
alarms in the alarm list.

Reset Means that the signal stated on List erase is set to zero when 
the alarm list is erased.

List size States the list size in number of kbytes. Note that the real size of 
the alarm list is twice the stated size. The performance of the 
project is effected negatively if list sizes over 10 kbytes is used.

Alarm symbol States when the alarm symbol should be shown, see table below. 
■ALARM■ is shown in the Textblock and a red bell, , in the 
top right-hand corner of the display is shown in the Graphic 
block.

Backlight action State when the background light shall be turned on for an alarm.
0n means that the backlight is turned on when the alarm symbol 
is shown. Default setting.
Off means that the backlight is not affected by alarms.
Timer means that the backlight is on when a new alarm is acti-
vated and turns off when the time for the screen save is out.

Alarm cursor In the E900 and E910 the cursor color can be changed in the 
alarm list. 
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10.4 Alarms in run-time mode
Alarms are shown in the Textblock with the text ■ALARM■ in the upper 
right-hand corner of the display (you can select not to have this during 
configuration). A red bell blinks in the upper right-hand corner of the dis-
play for alarms in Graphic blocks. 

The alarm is presented in an alarm list with the predefined alarm texts. 
The alarm list contains the latest alarms which are listed by alarm group 
according to definition and with the latest alarm at the top of the list. The 
alarm list’s size in number of kbytes is selected during configuration. The 
alarm list is shown on jumping to the alarm block. The status for the alarm 
is shown for each alarm as well as the time when the alarm was activated, 
deactivated or acknowledged depending on the display mode selected.

Alarms can have the following status.

Alarms can be shown in the following format.

Option
Alarm symbol shows when

active unacknowledged

NO

UNACK •

ACTIVE •

ALL • •

Symbol Status

* Active, Not acknowledged

$ Not active, Not acknowledged

- Active, Acknowledged

<blank> Not active, Acknowledged

Display format Description

S The time when the alarm was activated

E The time when the alarm was inactivated

A The time when the alarm was acknowledged
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To get to the alarm block you can either press [LIST], define a jump to 
system block 990 or allow the controller system to produce a list via the 
Display signal for block 990.

To acknowledge an alarm place the cursor on the line where the alarm is 
and press [ACK]. Alarms can be printed out directly as they occur or 
change status if a printer is connected. This should be stated when the 
alarm is defined. The alarm is printed out with date, time, status and the 
alarm text.

Return to the previous block by pressing [LIST] on the terminal.

The current content of the alarm list can be printed out by giving the 
Printer signal for block 990.

Block linked to alarms
Text or graphic blocks can be linked to alarms. This means that when the 
operator presses the INFO key at an alarm in the alarm list, a block linked 
to the alarm is shown. This block can contain information about the alarm 
and recommended actions. It is only possible to press the INFO key if 
current alarm is linked to a block. Return to the alarm list by pressing 
[PREV] on the terminal.
10-7
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Graphic alarm page in run-time mode
The page is graphic and can be modified by the user. The function keys 
can be linked to the functions in order to enlarge or reduce the text on the 
alarm page as well as the function for flipping through the pages. Further-
more there is the possibility to select the display of date and time.

Alarms can be sorted into groups and you can select which group is to be 
shown. Status is shown with different colors, the color defined when set-
ting the alarm group.You select alarm group with the left and right arrow 
keys. 

E900

Switch on/off the
date and time stamp

Alarm symbol Alarm message Current alarm line

Alarm info

Decrease the font size

Alarm groups

Increase the font size
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11 Recipes

This chapter describes the function recipe handling. The recipes function 
means that all dynamic data in a block, that is signals and their values, can 
be saved in the file in the run-time mode. The operator can then download 
the file to the PLC system. The PLC system then starts to work with the 
loaded values. By using the recipe handling function, a large number of 
parameter settings can easily be reused. The user creates a recipe library 
containing files with different parameter settings. This function makes 
time-critical production more efficient. An example is when you often 
shift between similar products such as when producing a unit in different 
colors. The recipe files can be created from the terminal or from the PLC 
system or from a PC with the HMI Tools software.

Recipe files are stored in the terminal. To use recipes, the functions for 
storing, loading and erasing recipes must be linked to function keys, see 
the chapter “Function keys”.

The diagram below shows the principle for managing recipes.

The personal computer is used to 
program the terminal. The per-
sonal computer is used for exam-
ple as back-up for production 
recipes or to create new recipes 
via the File Transfer in HMI Tools 
program.

The recipe block can access values 
from the PLC system which via the 
terminal are stored as a recipe.

The Load recipe function can be defined in 
any block, for example a block that is used 
to start running.

Load the recipe in the PLC 
system with the Load 
recipe function.

Create new recipe files 
with the RECWR func-
tion.

Recipe file
M1001
M1020
D0 25
D1 100
D10212
D1031123
11-1
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11.1 Calculate the recipe size
Use the following equation to calculate how much of the project memory 
the recipe will occupy.

S = 90 + n (2 ∗ IOGi + 28)

S = number of bytes. If S calculated will be less than 360, S will be set to 
360.

n = the number of IO series

IOGi = the number of IO in each IO series

Example
Our recipe consists of three I/O series, D0-D109 (110), D200-D499 (300) 
and M0-M99 (100).

The calculation will be:

Calculate the sums of the different series:

1104 = (2 * 110 + 28) + (2 * 300 + 28) + (2 * 100 + 28)

Then calculate the sum:

S = 90+ 1104

S = 1194 bytes

11.2 Creating a recipe with the terminal
Which block or blocks are to be used to save the recipe is decided when 
the application is programmed. All those signals that are to be included in 
the recipe are defined in the block that will be saved as a recipe. All 
dynamic values in the block are stored in the recipe file. All digital and all 
analog objects except trend objects can be used as recipe parameters.

A jump is made in run-time mode to the block which contains the recipe 
parameters. Enter the required values in the dynamic object and press the 
function key that is linked to RECWR. The name of the file is given in the 
entry field shown. The recipe name may not contain national characters. 
The recipe file is stored in the terminal.



Recipes
E900

11.3 Transferring a recipe to the PLC system
The recipe is transferred to the PLC system in run-time mode with the 
RECRD function. This means that the signals and their values stored in 
the file are transferred to the PLC system. When the function key for 
RECRD is pressed a list of available recipe files to choose from is shown. 
Select one and press [ENTER]. The PLC system will then run with the 
downloaded values.

E900
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11.4 Erasing a recipe
Any named recipe can be erased in run-time mode from the terminal 
memory with the RECDEL function. Press the function key connected to 
RECDEL. Available recipe files to choose from are now shown. Select the 
file to be erased and press [ENTER]. Confirm the erasure by pressing 
[ENTER] or abort by pressing [PREV].

11.5 Using recipes in a personal computer
The terminal is treated as a unit in the personal computer with the 
Transfer program (in the HMI Tools program group). This means that the 
personal computer can be used for making safety copies of files in the ter-
minal for example recipe files. New recipes can be created in the personal 
computer and be copied to the terminal.

The files are stored in the .SKV format in the personal computer which can 
be brought up in Excel. Files can be edited in Excel and then used in the 
plant again.

The file must end with the instruction END. See the example below.

M100 ;1
M102 ;0
D0 ;25
D50 ;12
END

For further information we refer to the manual for HMI Tools.
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11.6 Loading and saving recipes via the 
PLC program

By using a control block in the PLC system you can load, save and delete 
recipe files in the terminal. The files created by the PLC program are com-
patible with the recipe files saved in the terminal. This means that recipe 
files saved by the PLC program can be loaded in the terminal and vice 
versa. The control block is described in the following table. 

In the Setup menu, System signals you define the first register in the 
control register area. This register and the six following registers are used 
as a control register. 

Save recipe
n
n+1
n+2
.

Register Value

Terminal PLC system

PLC program

123

Data

Ctrl

Recipe file 1

.

.

n+m

53447
0

76789

n
n+1
n+2
.

89

.

.

n+m

7699
1

76789

Register Value

Recipe file x

0
1
.
.
.

n 123
n+1
n+2
.
.

n+m.
.

Ctrl reg 0
Ctrl reg 1
.
.

Ctrl reg 7.
.

Register Value

53447
0

265346

Load recipe
Delete recipe
Names of
recipe files

Recipe
registers

Control
block

MOV

MOV
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To perform commands, the following handshake procedure must be 
carried out:

10.The handshake register must be 0. If it is not, make sure that the 
command register is set to 0. 

11.Write the command in the command register. 

12.Wait for completion or error code in the handshake register.

13.Set the command register to 0. After this, the terminal will set the 
handshake register to 0.

Recipe names
The following characters can not be used in recipe names:

! ? < > ( ) + / * = ° % # : . [space] , -

Register Content Description

Dn0 Command Command register set by the PLC
Available commands:
0: No command
1: Save recipe to the terminal.
2: Read recipe from the terminal.
3: Delete recipe from the terminal.

Dn1 Result code Handshake register set by the terminal.
0: Ready for new command.
1: OK.
2: Recipe file write error.
3.: Recipe file not found.

Dn2 File name char. 1-2

Recipe file name in the terminal.
Dn3 File name char. 3-4

Dn4 File name char. 5-6

Dn5 File name char.7-8

Dn6 Start data register The first data register to be read/written to/from 
recipe file.

Dn7 Number of registers Number of registers to read/write to/from recipe 
file.
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Example
The PLC wants to save D100 to D149 as recipe name “RECIPE1” when M0 
is activated. The control block starts at D10. The PLC program should be 
as follows.

Limitations
Recipe created in the PLC system can include maximum 1000 registers. 
Only data registers can be used.

=   0    D11
K

=   1    D11
K

ASC RECIPE      D12

MOV   100    D16

MOV   50     D17

MOV   1      D10

MOV   0      D10

RST      M0

K

K

K

K

0

34

M0

1

M0
11-7



Recipes

11-8



Passwords
12 Passwords

This section describes how to use security levels and passwords in the 
terminal. This function makes it possible to create a security system for the 
terminal. The operators can be given different accessibility to the system.

Blocks, function keys and maneuverable objects can be allocated a
security level. Each security level is given a password. The user must log 
in with a password for the security level concerned or a higher one to gain 
access to the various levels. It is not essential to use this function.

12.1 Defining security levels
Blocks, function keys and maneuverable objects can, when they are 
defined, be allocated a security level. A security level (0 to 8) is given in 
the dialog box for the object. Everyone will have access if the 0 security 
level is used.
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12.2 Defining passwords
The password is defined for security levels 1 to 8 under Passwords in the 
Functions menu.

Parameter Description

Password sec level 
1-8

Enter the password and any comments for security levels 1-8.

Confirm question Enter a question that should be confirmed by the operator before 
maneuvering is enabled. The function does not work when a func-
tion key or touch key is defined with a password.

Login signal State here the digital signal which when set generates the entry 
field for logging in. The entry field for logging in can also be 
linked to a function key, see the “Function keys” chapter.

Logout signal State here a signal which when set logs out the current user. 
This function can also be linked to a function key, see the 
“Function keys” chapter.

Current level reg State a register where the terminal put the current password 
level (0-8).
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12.3 Logging in
Logging in is either controlled from a function key or through a digital 
signal from the PLC system. The entry field for logging in is shown if the 
function key linked to the function Login to specified security level is 
pressed or the digital signal is activated. State the password here. The 
password is linked to the security level, see above. If the security level is 
changed to a higher level the [PREV] key will be disabled.

12.4 Password for transfer
On the command line under System signals in the Setup menu you can 
state the command PDxxxxxxxx where xxxxxxxx is the password. The 
operator then have to enter a password to have access to the functions in 
the Transfer menu.

12.5 Password for all terminal functions
On the command line under System signals in the Setup menu you can 
state the command PSxxxxxxxx where xxxxxxxx is the password. When 
the operator enter the password he has access to all functions in the 
terminal, even the functions protected with other passwords.

Login timeout State here the time in minutes during which the terminal can 
remain unused before the user is automatically logged out. If 0 is 
used no logging out takes place.

Password run→ 
prog

Here you can state a password which must be entered when 
switching from RUN to PROG manually. The function is not used 
when switching from PROG to RUN or when Auto RUN/TRANS-
FER switching from the MAC Programmer+ is used. 

Parameter Description
12-3
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12.6 Altering passwords in run-time mode
Passwords can be altered in run-time mode with the Change login pass-
word function. When the function key linked to Change login password 
is pressed a dialog is shown where the passwords for each security level 
can be altered.

Note!
It is not possible to state the security level for block 0.

Note!
After logging out the [PREV] key and the “Return to previous block” function for the 
function keys is ignored to provide unauthorized to enter block that have password.
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13 Report print-outs

This section describes how to make a report print-out from the terminal. 
For production follow-up it is simple to create different types of reports 
such as daily reports and event reports. The illustration below shows the 
principle for generating a daily report.
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13.1 Connection to a printer

The printer should have a serial interface and be equipped with IBM 
character set (850). The settings for the printer are set under Peripherals 
in the Setup menu in the terminal. Refer to the printer manual for the cor-
rect configuration.

13.2 Text block printouts
The reports are created as Text blocks with static and dynamic text. The 
report has a maximum width of 150 characters. In the text block you enter 
a free text, for example, table header and other static text which will al-
ways be printed. To get dynamic values from the process in the report you 
define dynamic objects, presenting the value for the signal the object is 
linked to. See the chapter “Text-based presentation and maneuvering”. 
Via time channels it is possible to decide when the report is to be printed.

Note!
A printer with parallel interface can be connected if the IFC PI expansion card is used.

Terminal

Printer

RS-422 RS-232



Report print-outs
13.3 Graphic block printout
In the E900 and E910 it is possible to print graphic blocks to a Epson FX-
80 compatible printer. It is also possible to use a HP PCL5/PCL5E/PCL6 
compatible printer to print graphic blocks. Graphic blocks can only be 
printed when it is displayed (screen dump). Only black and white graph-
ics are supported.

If the NHD command is entered on the command line under System sig-
nals in the Setup menu you will get a printout of graphic blocks without 
header (containing block name, block number, date and time).

Note!
Epson FX-80 graphic do not support gray scales.

Note!
The printer needs at least 5 MB internal memory to print graphic blocks.
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13.4 Defining the print-out
The Print signal parameter in the block header gives the signal which 
when set activates the print-out. A Completion signal is also given here, 
which is set by the terminal when the print-out is completed. This signal 
is instead set to zero if Reset is marked. 

13.5 Printer settings
The settings for the printer must be made under Peripherals in the Setup 
menu. Under Peripherals you select Printer and then press Edit.... For 
more detailed information concerning the printer refer to the manual for 
the printer used. If you select Standard text the printer must support IBM 
extended ASCII character set. If graphic blocks are printed, the printer 
must support Epson FX-80 or HP PCL graphics. If you use the IFC PI 
expansion card it is possible to print on a HP writer.
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Parameter Description

Printer type Select printer, none or installed printer, e.g. HP PCL5.

Page length The number of lines to be printed out before form feed. Form 
feed never takes place if the page length is set to 0.

Paper type Select paper type according to installed printer.

Graphic orientation States if the graphic printout should be portrait or landscape 
if a PCL5 compatible printer is used.

Text orientation States if the report printout should be portrait or landscape if 
a PCL5 compatible printer is used.

Printer disable signal State a digital signal which when set ends the printout. The 
port where the printer is connected will then be free to use 
for e.g. transparent mode.

New line character End of line character; CR/LF, CR, LF or none.

Handshake States whether handshaking between the printer and 
terminal will take place with XON/XOFF or CTS/RTS.

Screen dump Possibility to printout the screen, normal or inverted.
13-5



Report print-outs

13-6
13.6 Setting a communication port
Settings for the communication port must be made under Peripherals. 
Under Peripherals you select RS-232 or RS-422 and then press the Edit... 
button. See the manual for the printer concerned for the correct setting. 

13.7 Control codes to printer
It is possible to type control codes to a printer in textblocks. You type %% 
followed by a number between 1 and 31, which are control codes to the 
printer. For example %%12, which is paper feed, for further description of 
control codes we refer to the manual for the printer used.

One command must be followed by a blank character. If you have set a 
transverse (paper) feed this must be at the end of the line. The characters 
%% must not occur in the text. It is possible to have more than one 
command/control code on one line.

Parameter Description

Baudrate Select the transfer rate for communication. Must be the 
same as the external unit.

Parity Select parity. Must be the same as the external unit.

Databits Select number of data bits. Must be the same as the external 
unit.

Stopbits Select number of stop bits. Must be the same as the external 
unit.
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14 Time control

Time control is a function for setting and resetting digital signals relative 
to the real-time clock. This function is used for controlling events in the 
process at specific times through the terminal. The time channels replace 
the time relays and the 7-day clock.

14.1 Defining the time channels
The time channels are defined under Time channels in the Functions 
menu.

Parameter Description

Interval name Enter any text for the time channel.

Signal A digital signal which is set during the stated time period is 
stated here.

Interval The day and time for the interval is stated here. Four intervals 
can be defined for each time channel.
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In the figure on previous page we have defined one time channel. The 
time channel has the text Night temperature and is linked to the signal 
Y30. The signal will be set Monday to Friday 17.30 to 05.00, Friday 17.30 
to 24.00 and Saturday to Sunday between 00.00 and 24.00. During these 
periods the temperature in the building will be decreased.

14.2 Presentation in run-time mode
The page with the time channels is shown when system block 991 is acti-
vated either through a jump object or a digital signal linked to the block. 
The time channel’s values can be read and/or changed. The option Time 
channels in the Online settings menu must be set to YES in order to alter 
the time channel’s value in run-time mode. 

To read or change values for a time channel you move the cursor to 
required line and press [ENTER]. Press [DONE] to exit from the time 
channel’s definition. Exit from the time channel menu with [PREV]. The 
block from which the time channel block was activated is then shown.
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15 System monitor

The system monitor is a block where the operator can view or change the 
value for controller signals in run-time. The value is presented as a 
decimal, hexadecimal and ASCII value.
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16 Index addressing

Without index addressing, an object will always be tied to the same 
register. Only the value in that register can be displayed in the object. 

With index addressing, however, it is possible during operation to select 
the register which is to be addressed, and thereby the value to be 
displayed. This is done by adding the value in the index register to the 
address of that register which represents the analog signal in the object. 
This can generally be formulated as follows: 

Displayed value=contents of Register(object address+contents of Index Register)

If the contents of the Index Register is 2 and the address of the register 
specified in the object is 100, the value shown in the object will be 
retrieved from register 102. If the value in the Index Register changes to 3, 
the object’s value will be retrieved from register 103 instead. 

For each project you define which registers are to be index registers. Do 
this under Index Registers in the Setup menu. Up to eight different index 
registers can be used in each project and each index register can be used 
in more than one object.

The object used in the project will specify if index addressing is to be used, 
and the relevant index register. This is done when the object dialog selects 
I1 to I8 in the entry field to the right of the specified analog signal for the 
object. In the example below, D100 is the analog signal, and I1 is the 
relevant index register. 

The following example shows three motors which are controlled by a 
block. The correct torque and speed for the motors are stored in six 
different registers. In one block, it will be possible to select one of the 
motors and the correct torque and speed for that particular motor should 
thus be shown in the block. If another motor is chosen, its correct torque 
and speed should be selected and displayed. This functionality is possible 
with index addressing. 
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Register D0 is defined as Index register 1 at Index Registers in the Setup 
menu. The value in this register determines the motor for which the 
torque and speed are displayed. 

If the value in D0 is 1, torque and speed are shown for Motor 1. If the value 
is 2, torque and speed are shown for Motor 2, and so on. The value in 
register D0 is controlled by a multiple choice object where the texts, Motor 
1, Motor 2 and Motor 3 are specified. These three choices are also made 
maneuverable.

Motor 1

Torque in register D101
Speed in register D201

Motor 2 Motor 3

Torque in register D102
Speed in register D202

Torque in register D103
Speed in register D203
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Torque and speed are shown in two numerical objects. In the object for 
torque, D100 is specified as the analog signal, and I1 as the index register. 

In the object for speed, D200 is specified as the analog signal, and I1 as the 
index register. 

With the maneuverable multiple choice object, it becomes possible during 
operation to choose Motor 1, 2 or 3. Depending on the choice, a value of 1, 
2 or 3 is marked in register D0. This value is added to the addresses for the 
objects that show torque and speed. These will thus display the values in 
registers D101, D102 or D103, and D201, D202 or D203 respectively.
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Note!
Suffixes other than index register can be specified. The index register will not be count-
ed twice if a 32-bit register is used.

Multiple choice object
Analog signal D0

Numeric object
Analog signal D100
Index register D0

Numeric object
Analog signal D200
Index register D0
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17 Communication

17.1 Transparent mode
The programming/printer port on the terminal is used in the transparent 
mode to connect a unit working in parallel with the PLC system. This unit 
can be another terminal or a personal computer with, for example, the 
programming tool for the controller system or a superior operating sys-
tem.

The transparent mode works together with the MELSEC CPU port and 
MELSEC A-series communication ports with C24 protocol. For further 
information see the C24 manual.

Connecting a personal computer or other computer 
system
Personal computers with the MELSEC MEDOC programming tool or 
other computer system are connected directly to the terminal’s 
programming/printer port.

Terminal with MELSEC MEDOC connected to the programming/printer port

Settings in the terminal and MELSEC MEDOC
The following settings must be made in the terminal and MELSEC ME-
DOC for the transparent mode to work.

TerminalFX-system

MELSEC MEDOC

RS-232

RS-422
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The terminal
The printer parameters are set in the Setup menu under the menu option 
Peripherals.

The parameters should be 9600 baud, 7 data bits, 1 stop bit and even parity 
if the terminal is connected to an FX system.

The parameters should be 9600 baud, 8 data bits, 1 stop bit and odd parity 
if the terminal is connected to a A-CPU or a QnA-CPU.

The parameters should be 19,200 baud, 8 data bits, 1 stop bit and no parity 
if the terminal is connected to one of the A-series or QnA-series serial 
communication modules.

MELSEC MEDOC
The transfer parameters should be changed to 19,200 baud, 8 data bits, 1 
stop bit and no parity when transferring via the A-series communication 
ports. This is done under Transfer in Setup. The Interface should also be 
changed from CPU to C24 under Transfer.

The transfer parameters should not be changed in MELSEC MEDOC for 
other projects. See the Installation manual for cable connections.

The settings also apply for other PC-based monitoring systems such as 
SCADA and MELSEC MEDOC plus.

Connecting two terminals in transparent mode
Several terminals can be connected to the same PLC system with the trans-
parent mode function. In this section we describe how to connect two ter-
minals. Several terminals are connected in an analog way.

Cable connection
When connecting two terminals to a PLC system the first terminal is con-
nected according to the description in the Installation manual. Between 
the two terminals, a cable is used according to the figures below. The cable 
is connected between the free port on the first terminal and the corre-
sponding port on the second terminal. If the distance is more than 15 me-
ters using RS-232 communication a signal amplifier must be used.
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Settings in the first terminal
In MAC Programmer+ the communication settings is made in the Setup 
menu under Peripherals. Settings for the port connected to the PLC 
system is stated in the usual way. Settings for the port connected to the 
other terminal can be freely chosen.

Settings in the second terminal
In MAC Programmer+ the communication settings are made in the Setup 
menu under Peripherals. The PLC system should be placed on the port 
that is used to connect the second terminal to the first terminal. The set-
tings for this port shall be the same as stated in the first terminal on the 
port where the second terminal is connected. If any of the FX2N or QnA 
PLC systems are used the BSD command must be stated on the command 
line under System Signals in the Setup menu.

3
16

2
15
7
8

2
15

3
16
7
8

25-pin D-sub Male 25-pin D-sub Male

RS-422 RS-232

3

2

5

2

3

5

9-pin D-sub Female 9-pin D-sub Female

Cable between two terminals using RS-232

Cable between two terminals using RS-422
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Transfer speed
The transfer speed can vary between 600 and 19,200 baud. The highest 
transfer speed between the terminals is recommended to obtain the best 
results. The speed of communication decreases with the number of 
terminals connected according to the following table.

Connecting three terminals in transparent mode
A third terminal can be connected to Terminal 2 in the network using a 
cable according to the figures above. The settings in the third terminal 
should be analog to the settings in the second terminal.

Number of 
terminals

Access time to the PLC

Terminal 1 Terminal 2 Terminal 3 Terminal 4

 1 100% - - -

 2 50% 50% - -

 3 50% 25% 25% -

 4 50% 25% 12.5% 12.5%

RS-422 RS-232 RS-422

Terminal 1 Terminal 2 Terminal 3
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17.2 The terminal as communication
interface (No Protocol Mode)

The No protocol mode is used to connect different PLC systems or connect 
external units such as bar code readers or weighing scales to the PLC 
system. The PLC system controls what is to be sent to the communication 
port. Data coming in to the communication port is written to the PLC 
register. Communication takes place with the transfer of the PLC register 
area according to the control block below.

Communication
handling

Any unit Terminal
Data register PLC program

Send buffer 
data

Recieve 
buffer data

Ctrl

0

1

100

101

.

.

Start send buffer

RX Message length

RX End code pattern

Command for receiving

Start receive buffer

Command for send
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Right click on No protocol mode in Peripheral Configuration under 
Peripherals in the Setup menu.

Register Description

Ctrl reg 0 Start register for the transmission data buffer. The first register in 
the buffer area contains the total number of bytes to be transmitted. 
The following registers contains the data to be transmitted. The 
maximum buffer size is 127 registers = 254 bytes.

Ctrl reg 1 Command register for transmission. Set to 1 by the PLC system 
when transmission is required. Set to 0 by the terminal when trans-
mission is complete.

Ctrl reg 2 Start register for the reception data buffer. The first register in the 
buffer area contains the total number of bytes received. The follow-
ing register contains the data received. The maximum buffer size is 
127 registers = 254bytes.
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In the Setup menu, Peripherals you drag the icon No Protocol mode to 
the communication port you want to use. Right click to define which reg-
ister will be the first control register in the transfer area. This and the five 
following registers are used as control registers. 

The PLC system can switch between no protocol and transparent/printer 
modes in the run-time mode using a digital signal. State the digital signal 
in the dialog under No protocol on signal.

Ctrl reg 3 Command register for reception.
- Set to 0 by the PLC system when it is ready to receive.
- Set to 1 by the terminal when the message is available.
- Set to -1 (FFFF) on error message (e.g. too short).
- Set to 2 by the PLC system when clearing of the port buffer is 
required.
- Set to 3 by the terminal when clearing of the port buffer has been 
carried out.
The port buffer is automatically cleared on start up and when 
switching between transparent mode and no protocol mode, i.e. the 
register receives the value 3.

Ctrl reg 4 End code (1 or 2 bytes) on the message received.

Ctrl reg 5 Length of the message received. End code is used if 0.

Register Description

Register t0

Register r0

Number of bytes
Data

Number of bytes

Ctrl reg 0
Ctrl reg 1

Ctrl reg 2

Ctrl reg 3

Register r0

Register r1

Register r2

Reception data bufferTransmission data buffer

Control block

Data

Register t0

Register t1

Register t2
�
�
�

�
�
�
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Example of using the No Protocol Mode
The following example describes the use of the no protocol mode for a 
weighing system. The diagram below shows a three-step block schedule 
for communication.

The terminal functions as the master towards the weighing system, that is 
it continually asks the weighing system for the current weight. The dia-
gram below shows the connections between the PLC system, terminal and 
weighing system.

0

1

2

Wait state

Queries current 
weight

Await current weight

Receiving complete

Transmission completed

Transmission startM100

M11
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The protocol appears as follows

Terminal

| STX | ? | CR | LF |

Weighing system

| STX | Weight in kg | CR | LF |

The PLC program appears as follows:
17-9



Communication

17-10



Communication
17-11



Communication

17-12



Communication
17.3 Modem connection
A modem can be used for making a connection to a personal computer. 
The settings for the connection are made in the Modem Setting dialog un-
der Peripherals in the Setup menu. Select Modem and click Edit or click 
the right mouse button to show the dialog.

Control block reg:
The communication is established using three control registers in a control 
block. The first register in the control block is defined at Control block reg 
in the dialog. The function of the control registers is described in the table 
below.
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Register Description

Ctrl reg 0 Contains the command describing how the PLC system shall call up 
and establish connection.
0 Wait for command.
1-10 Call up with the phone number entered in the field Phone

No 1-10. Maximum 40 characters. 
11 Call up with a phone number stored in the PLC system.

This phone number is stored as an ASCII string 
beginning in the third control register and then some
following registers. The string can contain maximum 40
characters, i.e. 20 registers. All registers do not have
to be used. The last register that shall be read must
contain the ASCII code 0.

101-110 An init string is sent to the modem. Enter Hayes
modem commands in the fields Phone No 1-10. 
Command 101 sends the string in the field Phone No 1
etc.

111 An init string stored in the PLC system is sent to the
modem. Enter Hayes modem commands beginning in
the third control register. See Command 11 for details.

255 Hang up command.

Ctrl reg 1 The second control register is used as a status register. This 
register contains the result of the modem command. The status reg-
ister can contain the following:
Status codes
0 Command executed successfully.
1 Dial in progress.
2 Modem established a connection.
3 Modem detected a ring signal.
Error codes
101 No connection (when hanging up).
102 Modem detected lost carrier.
103 Unspecified error from modem.
104 Modem gets no dial tone.
105 Busy when dialling.
106 No answer when dialling.
107 No reply from modem.
255 Unknown error/status.

Ctrl reg 2 The terminal can call up with a phone number stored in the PLC 
system. This phone number is stored as an ASCII string beginning in 
the third control register and then some following registers. The 
string can contain maximum 40 characters, i.e. 20 registers. All 
registers do not have to be used. The last register that shall be read 
must contain the ASCII code 0.
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Init:
Modem init string.

Timeout
Number of seconds before the line is disconnected at inactivity. Default is 
30 seconds. Times between 5 and 600 seconds can be stated. 

Dial mode:
Select between Pulse and Tone.

Phone No 1-10:
Complete phone number for call up. Maximum 40 characters.
17-15



Communication

17-16



Network communication
18 Network communication

This chapter describes how the E900 communicate in a network. The net-
work communication takes place via TCP/IP (Transport Control Proto-
col/Internet Protocol). TCP/IP is a standardized set of protocols 
developed to allow cooperating computers to share resources across a net-
work. The operator terminals can be connected in a network in many 
different ways. The connection can either be Ethernet or serial. If Ethernet 
is used the IFC ETTP or IFC ETCX expansion cards are required in all 
terminals. IFC ETTP is used to connect the terminals with twisted pair and 
IFC ETCX is used to connect the terminals with a coaxial cable. If twisted 
pair is used an Ethernet HUB is required. For further information about 
TCP/IP please refer to the RFC’s published on the Internet. You will find 
them for example at this address:
ftp://ftp.sunet.se/pub/internet-documents/rfc.

Information and description of concept and words used can be found on 
the webb address http://www.whatis.com.

The terminal network is a Client/Server network and works as follows. 
Only clients can access data on the network. Servers only provide access 
for other clients. A terminal can be both a client and a server to be able to 
provide access and also access other terminals. Up to 20 different clients 
can access data from the same server. A client can access data from up to 
16 different servers.

Each terminal requires an IP address. IP addresses from 192.168.0.0 to 
192.168.254.254 are recommended for internal networks.

With the terminal you can use standardized Internet tools such as 
browser, mail server and FTP client. You can create a web site in a PC and 
load it to the terminal. The Web page can contain real-time data from the 
PLC system or the terminal. Via Internet and a browser you can change 
values, set signals, acknowledge alarms etc via script.

The terminal can also send email for special events such as alarm and 
status report.
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18.1 Examples of possible networks

Example 1
This Ethernet network is designed for one controller together with several 
terminals.

Terminal 1 (192.168.1.1) 
Terminal 1 must be a server. Clients can access the controller through the 
server.
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Terminal 2 (192.168.1.2) 
Terminal 2 must be a client. A client can access the controller connected to 
a server. 
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Terminal 3 (192.168.1.3) 
Terminal 3 must be a client. A client can access the controller connected to 
a server. 

A PC can be connected for transferring projects to the terminals. The PC 
can be connected either via an Ethernet card or to one of the serial ports 
on one of the terminals using CAB5 or CAB6. The Ethernet card is recom-
mended.
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Example 2
This Ethernet network is designed for several controllers and operator 
terminals in one network. The controllers in this example use different 
protocol drivers.

The following Client/Server and Driver configuration gives the following 
access. This example uses two drivers, driver X and driver Y.

Terminal 1 (192.168.1.1) 
Terminal 1 is a client with driver X and can therefore access all the servers 
with the same driver. It can also access its local controller 1. This results in 
access to controller 1 only. It cannot access controller 2 because of different 
drivers and not 3 because the terminal 3 is not a Server.

Terminal 2 (192.168.1.2) 
Terminal 2 is not a Client and cannot access any other stations in the net-
work. It can access its local controller 2. This results in access to controller 
2 only

Terminal 3 (192.168.1.3) 
Terminal 3 is a Client with driver X and can therefore access all Servers 
with the same driver. It can also access its local controller 3. This results in 
access to controller 1 and 3. Terminal 3 cannot access controller 2 because 
of different drivers.
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Terminal 4 (192.168.1.4) 
Terminal 4 is a client with driver Y and can access all servers with the same 
driver. This results in access to controller 2 only. Terminal 4 cannot access 
controller 1 because of different drivers and not 3 because it is not a server.

Data between the controllers can be exchanged with a small controller 
program or using function keys. See “BDTP Client” and “BDTP Server”.

Example 3
This Ethernet network is a normal configuration where a PC is included. 
This allows the computer to access any terminal on the network and trans-
fer a project. The PC can be connected either via an Ethernet card or to one 
of the serial ports on one of the terminals using CAB5 or CAB6. The Ether-
net card is recommended. The example assumes that the same driver is 
used. To change PLC system we refer to the sections “BDTP Client” and 
“BDTP Server”.

Terminal 1 (192.168.1.1) 
Terminal 1 is a client and can therefore access all the servers. It can also 
access its local controller 1. This results in access to controllers 1 and 2.
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Terminal 2 (192.168.1.2) 
Terminal 2 is a client and can therefore access all the servers. It can also ac-
cess its local controller 2. This results in access to controllers 1 and 2.

Terminal 3 (192.168.1.3) 
Terminal 3 is a client and can therefore access all the servers. It can also ac-
cess its local controller 3. This results in access to controllers 1 and 2.

Terminal 4 (192.168.1.4) 
Terminal 4 is a client and can therefore access all the servers. This results 
in access to controllers 1 and 2.

Data between the controllers can be exchanged with control registers. See 
“BDTP Client” and “BDTP Server”.

Note!
When a project is transferred to a terminal this station will stop communication momen-
tarily. If the terminal is a Server all the clients requesting data from this Server will re-
ceive an error message. 
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Example 4
When only two stations are to be used a connection can be established 
with serial communication. This setup uses the built-in serial port to 
connect to the second terminal. No Ethernet card is required.

One or two controllers can be used with this "network". Both the controller 
systems in the network use the same driver and both the terminals have 
access to both the controller systems 1 and 2.
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Terminal 1 (192.168.1.1) 
Terminal 1 is a client and can therefore access the other server. It can also 
access its local controller 1. This results in access to controller 1 and con-
troller 2.
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Terminal 2 (192.168.1.2) 
Terminal 2 is a client and can therefore access the other server. It can also 
access its local controller 2. This results in access to controller 1 and con-
troller 2.
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18.2 Network communication via ETHERNET
You need one of the IFC ETTP or IFC ETCX expansion cards in the 
terminals to connect the terminals to a TCP/IP network via ETHERNET. 
IFC ETTP is used for connection via pair twisted cable and IFC ETCX is 
used for connection via coaxial cable.

How to make a connection
Install the IFC ETTP or IFC ETCX card according to the manual for each 
card. Select Peripherals in the Setup menu. Mark the selected expansion 
slot and click the right mouse button. Select network card. Mark TCP/IP 
connection and keep the left mouse button pressed. Then drag the mouse 
to the selected expansion card and release the mouse button.
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Settings
The settings for the serial connection are made in the dialog shown when 
the connection is selected and you press Edit.... 

Connection name
Enter any name for the connection. The parameter does not need to be 
stated.

Host configuration
Manual means that the settings of the TCP/IP parameters made in the 
dialog are used. The other alternatives mean that the terminal provides 
one or several of the TCP/IP parameters from a network server.

IP-adress
State the IP address of your node. For information about which IP address 
to use please refer to your network manager or to the RFC’s from the 
Internet committee. If you are using a local network between the terminals 
we recommend you use the ip-addresses 192.168.0.0 – 192.168.254.254.

Subnet mask
State your network identity.

Gateway
State the network unit in the local network that can verify the identifiers 
for the other networks on Internet.

Primary DNS and Secondary DNS
State the network servers containing information about a part of the DNS 
data-base.
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ETHERNET connections
The section below shows three examples of ETHERNET connections 
between two terminals. 

Connection between two terminals via twisted pair (TP)

The cable has RJ45 connectors. The cable is a CAT5 (cross coupled) pair 
twisted cable, screened or not screened.

TCP/IP settings in the nodes

Note!
If the communication does not work properly, and the LED marked Link on the IFC ETTP 
card does not light, connections 3 and 6 are probably switched.
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Connection between more than two terminals via twisted pair (TP)

The maximal length between the terminal and the HUB is 100 m. The 
number of terminals per HUB is limited by the number of connections on 
the HUB. The cable has RJ45 connectors. The cable is a CAT5 pair twisted 
cable, screened or unscreened.

TCP/IP settings in the nodes
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Connection via coaxial cable

The coaxial cable RG58 is used in the network. There must be bus endings 
of 50 Ohm. Several coaxial cables can be connected with repeaters to get 
longer networks. The network will then consists of different segments.

The maximum length of a segment is 185 m and the maximum number of 
units/segment is 30. Four repeaters can be serially connected, which 
means that five segments may be serially connected. Only three of the seg-
ments can have units connected. This means that there must be at least 
two empty segments in the network. The RG58 network cables must be 
gruounded on one side. For more information see RFC on the Internet.
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TCP/IP settings in the nodes

18.3 Serial network communication

How to make a connection
Select Peripherals in the Setup menu. In the dialog Peripheral configur-
ation you mark TCP/IP connection and keep the left mouse button 
pressed. Then drag the mouse to RS-232 or RS-422 and release the mouse 
button.

Note!
The settingof parity on the port connected to the TCP/IP connection must be NONE.

Node 1 Node 2
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Settings
The settings for the serial connection are made in the dialog shown when 
the connection is selected and you press Edit.... 

Connection name
Enter freely a name for the connection. The parameter does not need to be 
stated. 

Serial protocol
For serial communication you can select the protocol PPP. 

User name
State the user name used at login.

Password
State the password used at login.

Connect signal
Digital signal which establishes the connection when it is set and discon-
nects when it is reset. 

Connected signal
Analog register which can have the following status.

0 Disconnected (PPP Client)
1 Waiting for a connection (PPP Server)
2 Connected as a PPP Client
3 Connected as a PPP Server
7 Connection error
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Use logon script
The function is used to automatize a serial login. The script will look 
different depending on which server and modem you connect to. The 
terminal supports the following commands.

1. WAIT: Text , x Wait for the text Text for x seconds. x must not be 
stated

2. SEND: Text Sends the text Text

3. LABEL: Label Label becomes a reference point in the script.

4. ONERR: Label Jumps Label when an error occurs in previous
command.

5. MESSAGE: Message Shows a message box with the message Message.

6. END: End the script.

7. SLEEP: x Sleeps in x seconds.

8. COUNTER: y Count up a counter each time the script passes
“COUNTER:”. If the value y is reached an error
occurs. This error is handled by “ONERR:”.

Variables:

%USERNAME Compare with the names in accounts.

%PASSWORD Compare with the passwords in accounts.

Example 1:

WAIT: login:, 10
SEND: KALLE
WAIT: password:,10
SEND: HELLO



Network communication
Example 2:

The following script sends the text “CLIENT”. If the transmission failed a 
message box with the text “Send Failed” is displayed. If the transmission 
succeded we wait for the text “CLIENTSERVER” for 10 seconds. If this 
does not appear a message box with the text “Receive Failed” is displayed.

SEND: CLIENT
ONERR: Send Failure
WAIT: CLIENTSERVER,10
ONERR: Receive Failure
END:
LABEL: Send Failure
MESSAGE: Send Failed
END:
LABEL: Receive Failure
MESSAGE: Receive Failed
END:

Example 3:

The following script sends the text “login:” and then waits for the receiver 
to send a user name. This is checked to see if the name matches a user 
name in accounts. Then the script sends the text “password:” and wait for 
the receiver to send a password. This is checked in accounts to see if the 
password matches the password for the user name sent.

SEND: login:
WAIT: %USERNAME
SEND: password:
WAIT:%PASSWORD

Normally no script is needed. If you connect to a Windows NT server the 
script shall be as follows.

PPP - Login verification method
Select method to assure the user identity. Does not normally need to be 
changed. This parameter is only used for PPP connection. 

Act as Client/Server
For PPP connection you select if the terminal shall act as a PPP client or 
PPP server. The terminal can both call and be called.
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Advanced
Under Advanced you can define further parameters.

Use VJ compression of IP header
Compression of the IP header. Does not normally need to be changed. This 
parameter is used only for PPP connection.

Request/Provide remote address
Requests/provides the IP address for the remote node. Shall be 0.0.0.0 if 
you want to request the IP address from the remote node. This parameter 
is only used for PPP connection.

Request/Provide local address
Requests/provides the local IP address. Shall be 0.0.0.0 if you want to re-
quest the IP address from the remote node. This parameter is only used 
for PPP connection.

Set remote address as gateway
Mark if you want the remote node address to be a gateway, a connection 
port to another network. Default is OFF. The parameter is only used for 
PPP connection. 

Note!
If the remote/local provides addresses changes when the terminal is a server or both 
server and client the new addresses will be stored. Is the terminal a client the addres-
ses will be set to 0.0.0.0. If you change the terminal to be a server or both a server and 
a client the addresses stored is used.

Note!
If the parameter “Set remote address as gateway” is not marked and you use a sub net-
work the communication in the network will fail. It also means that email may be trans-
ferred from the terminal but you cannot login to the terminal from, for example, a FTP 
client or a browser.

Remote
192.168.1.2
Local
192.168.1.1

Remote
0.0.0.0
Local
0.0.0.0

Node 1 Node 2
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Modem
The parameters under Modem setup are stated if the connection shall take 
place via a modem. You also need a special cable which must be according 
to the following figure.

Enable modem
Mark if you use modem.

Disconnect if idle (min)
Disconnect the connection if inactive for stated number of minutes. 0 me-
ans that the connection never will be disconnected.

Telephone number
State the telephone number to be called. 

Modem setup string
A setup string which initializes the modem. For further information 
please refer to the documentation for the modem.

2

3

5

2

3

7

7

8
8
4

9-pin female 25-pin male
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TCP/IP
Parameters for the TCP/IP connection.

IP-adress
State the IP address of your node. For information about which IP address 
to use, please refer to your network manager or to the RFC’s from the In-
ternet committee. If you are using a local network between the terminals 
we recommend you use the addresses 192.168.1.1 – 192.168.1.254.

Subnet mask
State your network identity.

Gateway
State the network unit in the local network that can verify the identifiers 
for the other networks on the Internet.

Primary DNS and Secondary DNS
State the servers containing information for a part of the DNS data- base.
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Serial connection

A PPP connection between two terminals

PPP Client PPP Server

2

3

5

3

2

5

The settings under TCP/IP, IP Address, Subnet mask and Gateway 
have no meaning. PPP will change these parameters.
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A PPP connection between a terminal and a personal computer

Settings in the terminal

PC settings
The figures below shows the settings in the different dialogs when creat-
ing a serial PPP connection between a PC and a terminal. In this document 
we assume that the user has installed a Generic Null modem and defined 
a port for serial cable for Dial-up networking. 

PPP Server
PC with
Windows 
NT/95/98
Generic Null 
modem installed

MAC-PROG/9 CAB
CAB5

The settings under TCP/IP, IP 
Address, Subnet mask and 
Gateway have no meaning. 
PPP will change these 
parameters. Note that if PAP is 
selected as Login verification 
method User name and Password
must be stated.

Valid for Windows NT. 
Mark the “Use logon script”
box before use logon script.
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Select the function New connection according to the following path:

Start\Programs\Accessories\Dial-up Networking\New connection

The following dialog is shown. Enter the settings according to the follow-
ing figure.

Click on the file tab Server and enter the following settings.
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Click on the file tab Script and enter the following settings.

Click on the file tab Security and enter the following settings.

Click on the file tab X 25 and enter the following settings.



Network communication
The settings have now been entered. To establish communication you se-
lect the Dial-up networking function. Enter the defined post name and se-
lect Dial-up.

In the following dialog you shall confirm the call-up. Press OK.
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18.4 Network services
Under Network/Services in the Setup menu you select the services the 
terminal shall provide from the network. Select current function and click 
on Edit...

Application transfer server
Function for transferring a project via TCP/IP. Press Edit and enter the 
number of the port that will enable the transfer. Does not normally need 
to be changed. 

BDTP (Beijer Data Transport Protocol)
BDTP (Beijer Data Transport Protocol) replaces the old MAC network. The 
BDTP server will listen for I/O request from the BDTP client. The terminal 
can be client, server or both. The client can receive data from max 16 serv-
ers. The IP addresses of the servers are stated in the BDTP client.

Network communication via BDTP is used to connect more than two 
terminals to a PLC system and simultaneously maintain good perform-
ance. An example of use is production lines, where you need one terminal 
at each workstation. 
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The figure below shows an example of a network.

BDTP Server

PLC system

BDTP Client BDTP Client BDTP Client

PLC system PLC system

BDTP Client

X0

1
2
3
4
5

.

.

.

.

.

BDTP Server1>X0

1>X0

192.168.1.x192.168.1.x

192.168.1.x

192.168.1.x

192.168.1.x

192.168.1.x

x=1–254
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BDTP Client
In the network service BDTP Client you define IP addresses for those BDT 
servers from which the client can retrieve information. When you press 
Edit the following dialog is shown.

BDTP Server port
State the communication port to which the BDTP server/network is con-
nected. Does not normally need to be changed.

Default BDTP Server
Here you can specify a default BDTP server. If you do not specify the ad-
dress, the client will get the value from the default server.

Data register
Values in data registers can be transferred between one client and different 
servers in a network. Under Data register you state the first register in the 
register block in the client to be transferred to/from the stated server. The 
type of register must not be the same in the client and the server.
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Control block
Under Control Block you state the first register in the control block in the 
client. The control block takes five registers as follows.

Register Content Description

Ctrl reg 1 Command Command register which is set in the client. Available 
commands:
0: No command.
1: Transfer register values from the client to the 
server stated in control register 3.
2: Transfer register values from the server stated in 
control register 3 to the client.

Ctrl reg 2 Handshake Handshake register which is set by the client.
0: Ready for a new command.
1: OK
2: Transfer failed.

Ctrl reg 3 Server index The number of the server in the network handling the 
transfer.

Ctrl reg 4 Index register The value in the index register is added to the address 
of the register stated under Data register. If zero is 
stated in the register, the block will start with the 
address stated under Data register. 

n
n+1
n+2

.

Register Value
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.

.

n+m

53447
0

265346

Ctrl reg 1
Ctrl reg 2

Ctrl reg 5

0
1
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.

.

.

.

.
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.
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0
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1

.

.
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Register Value

Registers to 
transfer

Data register Data register
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The transfer handling must take place according to the following:

1. The handshake register must be 0. If it is not, make sure that the 
command register is set to 0. 

2. Write the command in the command register. 

3. Wait for completion or error code in the handshake register.

4. Set the command register to 0. After this, the terminal will set the 
handshake register to 0.

Synchronize clock with server
State if the clock in the client shall be synchronized with the selected 
server. Select server by stating the number of the server in the entry field. 
If the clock in the client is changed locally, the change is transferred to the 
server selected.

BDTP Server Address
Under BDTP Server Address you define the addresses to the servers from 
which the client can retrieve information. The addresses will be indexed 
in the order they are stated.

When the object is defined in the project you must specify the source 
server for the address. in the objects address field specify the following:

server index>device

If, for example, 2>D15 is entered in the address field the value for the 
object is loaded from register D15 in server 2.

It is possible to change the server index in a client project with the BDTP 
Station change function. See “Change BDTP station”.

Ctrl reg 5 Number of 
registers

The number of registers the values of which shall be 
transferred to/from the stated server.

Register Content Description
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BDTP Server
Handles the request from clients. Press Edit and state port. Does not nor-
mally need to be changed.

Data register
Values in data registers can be transferred between one server and 
different clients in a network. Under Data register you state the first reg-
ister in the register block in the server to be transferred to/from the client 
stated. The type of register must not be the same in the client and the serv-
er. For further information about data transfer see the “BDTP Client” sec-
tion.

Note!
It is only possible to control data transfer from clients.
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Clock Server
State if the clients in the network shall synchronize with the clock in 
current server. See also the “BDTP Client” section. This function is only 
valid for older terminal versions.

FTP Server
With this function it is possible to fetch and leave files to and from the 
terminal. The FTP server in the terminal allows transfer in passive mode 
(PASV). Passive mode should be used if you do not connect the terminal 
point-to-point. You do not always know what is between the client and 
the server, for example, router-based fire wall or gateways. By using pas-
sive mode you eliminate several errors. Browsers always use this mode. It 
is possible to use passive mode at point-to-point connection. National 
characters are not supported in file names. 

Select FTP Server under Network services and click on Edit... to enter the 
settings for the function. 

Control Port number
Default is 21 and should not be changed.

Data Port number
Default is 20 and should not be changed.

Request Login
Here you state if the user must login to get access to the FTP server. Users 
are defined under Accounts. If you select that no user need to login all us-
ers has full access to the FTP server. 

Pre Login Text
A text shown before request of user is shown.
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Post Login Text
A text showing when the user has logged in.

Connection Timeout
The time the FTP connection may be inactive before the server disconnects 
the connection. Default is 10 minutes. 

Accounts
Under Accounts you define user accounts with which you decide if the 
user will have access to the FTP server. 

If no password is defined for the account you can enter any password or 
leave the entry field empty when logging in.

FTP Access (Read)
The user may use the FTP server (read).

FTP Write
The user may write to the FTP server. Requires Access.
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SMTP Client
This function makes it possible to send email from the terminal. Trend and 
recipe files can be sent as attached files to the message. Max 20 messages 
can be sent at the same time. Select SMTP Client under Network services 
and click on Edit... Then you enter the following settings. 

Server port
Connection port 25.

Mail server
The IP adress or the alias name (DNS server) for the SMTP mail server. If 
you enter an alias name you must enter the IP address to the DNS server 
in the TCP/IP Network Connection dialog under Network in the Setup 
menu.

My Domain Name
The domain name of the terminal or any other domain name used to login 
on the SMTP server.

My Email Address
Enter your email address. The name is shown as sender for the receiver. 
Please enter a real email address so that the mail server can return any 
error messages. 
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Send via Connection
State the connection used for sending. Note that Connection 1 must be 
used before Connection 2 can be used.

Recipients
A predefined list of max 16 receivers. A receiver address can be max 60 
characters long.

Alarm via email
Alarms can be printed in the same way as they can be sent as email. The 
whole alarm list will be sent if you send block 990 (see Block Mail Report).

Mail to address
Enter the receiver of the message. Select up to eight receivers from the pre-
defined list in the SMTP Client Service dialog.

Info block
If you state an information block and it is a textblock it will be included in 
the message. For more information see “Alarm handling”.
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Report via email
Textblock can be printed in the same way as they can be sent as email. 

Block name
If you enter a name of a textblock it will be sent as a message/subject. 

Send mail signal:
The message is sent when signal stated is set.

Mail completion signal:
A digital signal that is activated by the terminal when the message is sent. 
Normally the signal is set. If you mark the Reset function the signal will 
be reset when the message is sent. 

Note!
Only textblock can be sent. Only the alarm block,990, of the system blocks is sent as 
email. Trend and recipe files are sent as attached files. 
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Mail to address:
Enter the email address to the receiver. Select up to eight receivers from 
the list shown when you click on the ...-button. The list of email addresses 
is defined in the dialog SMTP Client Service under Network Services in 
the Setup menu.

Attach file:
Enter a name of a trend or recipe file to be attached with the message. If 
there are a trend file and a recipe file with the same name the trend file will 
be attached. The file name may not contain national characters.

Email via system block
By making a jump to the Mail system block, 993, you can write and send 
a mail during run-time. 

E900

E910

Send E-mail to
Enter the receiver. You can enter the address or select from the global list 
shown when you click the LIST button on a terminal with keyboard or on 
the MAIL button on a terminal with touch screen.
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Subject
Enter the subject for the message. Max 50 characters. The text in the 
message can be max 10 rows of 50 characters. 

Terminal Controller
Used for RUN/TRANSFER switching via TCP/IP. Press Edit and enter 
the number of the port to be stated to enable transfer. The port number 
does not normally need to be changed. Mark Request authentication if 
user name and password must be stated before transfer..

Transparent mode
Used for communication in Transparent mode (see also the chapters 
“Communication” and “Network functions in the terminal”) in terminal 
networks. Press Edit and enter the number of the port stated to enable the 
communication. The port number need not normally be changed. Select 
protocol, UDP or TCP.
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WWW Server
With this function you can configure the WWW-server in the terminal. A 
Web server is a program that, using the client/server model and the World 
Wide Web’s Hypertext Transfer Protocol (HTTP), serves the files form 
Web pages to Web users (whose computers contain HTTP clients that for-
ward their request). See the chapter “Network functions in the terminal”.

Port number
Default is 80 and should not be changed. 

Account name
By selecting an account name you protect the HTML pages with a pass-
word. Accounts are defined under Network.. Accounts in the Setup 
menu.

Account name
Shows the Account name entered in previous dialog.
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Password
Enter a password. All HTML pages are protected with this Account 
name/password.

To protect a single page with another Account name/Password you enter 
the following in the header of the HTML page. 

<HTML>
<HEAD>
<META name=”superuser” content=”12345”*
</HEAD>

Here you place the rest of the HTML code.

</HTML>

* “superuser” is the user name and “12345” is the password.

Note!
The code above must be found in the header. The Name and Content parameters must 
correspond to an Account name and a Password. 
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18.5 Network accounts
Accounts define who may connect to services available at terminals 
requiring logon. The function is used to create access control. You create a 
name and password for different users who will have access to different 
network services. Account name and password may not contain national 
characters.

According to the figure the account name Connection X has access to all 
network functions that requires login.
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19 Network functions in the terminal

This chapter describes how the FTP server, SMTP client, applet and WWW 
server functions work in the terminal. For settings in the respective func-
tions we refer to the chapter “Network communication”. 

19.1 FTP server
FTP (File Transport Protocol), a standard Internet protocol, is the simplest 
way to exchange files between computers (terminals) on the Internet. FTP 
is an application protocol that uses the Internet’s TCP/IP protocols. FTP is 
commonly used to transfer Web page files from their creator to the com-
puter that acts as their server for everyone on the Internet. It is also com-
monly used to download programs and other files to your computer from 
other servers.

Some directories show files with the file length 0. This means that the file 
contains dynamic data i.e. the size of the file change. This means that the 
file is not empty even if the length is 0. The terminal does not use a date 
on the files which means that the time shown is not relevant. The file name 
may not contain national characters. The FTP server in the terminal can 
handle three connected clients.

The ROOT directory
In the root directory you will find the following directories ALARMS,
HTML, RECIPE and TRENDS. Only the libraries that the user has access 
to are shown. You will also find the file info.txt containing information 
about the terminal here. 

Note!
All files in the different directrories in the ROOT directory charge the project memory. 
Information about project memory available can be found in the info.text file located in 
the ROOT directory.
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The file info.txt
The file contains information about the terminal according to the follow-
ing example:

E900
Boot version: 4.01
Firmware version:V5.00
Build number: 124
Driver: FX-SERIES (CPU) V1.12.0
Dynamic memory: 304237 bytes free
Project memory: 184700 bytes free

Nothing can be deleted from the root directory, even if you have write 
access. If you delete the directories HTML or RECIPE, the content of the 
directories is deleted but the directories are still there. 

The ALARMS directory
The directory is only shown if there are any alarms defined in the terminal 
and the terminal is in run-time mode. The alarm groups are shown as SKV 
files with the length 0. This does not means that there are not any alarms. 
The files can only be read. To read a file it must be opened with the at-
tribute READ, READWRITE will cause error.

File format
Each alarm is stored in a row ending with <carriage return><linefeed>.

Syntax

status;activedate;activetime;inactivedate;inactivetime;ackdate;acktime;alarmtext

All fields are always there. If the alarm is not acknowledged the fields for 
date and time are empty. 

The HTML directory
The data files handled by the Web server are stored here. You can create 
subdirectories. The start file must always be named index.htm.

File format
The file format depends on the type of file. We use standardized file for-
mats such as HTML etc.
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The RECIPE directory
The different recipes are shown as SKV files with the length 0 which does 
not mean that the recipe is empty. You can both read and write files in this 
directory. But you may not create a directory. 

File format
Each recipe value are stored in a row ending with <carriage return><line-
feed>.

Syntax

device;value;datatype;length

The file ends with

END<carriage return><linefeed>

If the data type is array (AR) one value is shown on each line. The first line 
will be shown as above. The following lines will only contain

;value

Data types for analog devices

Type Description

tom Signed 16-bit

+ Unsigned 16-bit

L Signed 32-bit

L+ Unsigned 32-bit

RB BCD flyttal

RF Float with exponent

SB BCD 16-bit

LB BCD 32-bit

SH Hexadecimal 16-bit

LH Hexadecimal 32-bit

RD Float

AR Array of signed 16-bit

ST String of characters

BI Bit 0 or 1
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The TRENDS directory
This directory is only available if there are trends defined in the terminal 
and the terminal is in run-time mode. The trend files are shown as SKV 
files with the length 0. The files can only be read. To read a file it must be 
opened with the attribute READ, READWRITE will cause error. Curve 1 
in a trend must be used, otherwise the trend is not valid. 

File format
Each sampling is stored in a row ending with <carriage return><line-
feed>.

Syntax

date;time;value1;value2;value3;value4;value5;value6;OFF

End the file with

END<carriage return><linefeed>

Only used curves in the trend are transferred, i.e. no empty fields. 

OFF is in the sample in the following cases and indicates a pause in the 
sampling. 

– When the terminal enters run-time mode. A copy of the latest stored 
sample is added. The copy has OFF indication. As soon as valid values 
reach the terminal new values without OFF indication are stored. 

– When the signal Trend-enable is used. If the signal is reset a sample is 
indicated with OFF. When the signal is set a new value is stored without 
OFF indication. 

– When you transfer stored trend values via FTP or HMI tools, a sample 
will be stored with OFF indication. When the transfer is ready a new 
value is stored without OFF indication. 
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19.2 SMTP client
SMTP (Simple Mail Transfer Protocol) is a TCP/IP protocol used for send-
ing and receiving email. However, since it is limited in its ability to put 
messages in a queue at the receiving end, it is usually used with one of two 
other protocols, POP3 or IMAP, that let the user save messages in a server 
mailbox and download them periodically from the server. In other words, 
users typically have a program that uses SMTP for sending email and ei-
ther POP3 or IMAP for receiving messages that have been received for 
them at their local server. 

Mail-server

SMTP client

E-terminal

PC

POP3 client
e.g. Microsoft
Outlook Express

POP3SMTP
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19.3 Terminal reflection – applet
An applet is a little application program. On the World Wide Web, using 
Java, the object-oriented programming language, an applet, is a small 
program that can be sent along with a Web page to a user. Java applets can 
perform interactive animations, immediate calculations, or other simple 
tasks without having to send a user request back to the server.

From a PC it is possible to reflect the terminal in a browser, e.g. Microsoft 
Internet Explorer or Netscape Navigator. This is done by an application 
program presenting a picture of the terminal on the screen. The picture is 
updated at continuous time intervals according to stated requests. It is 
possible to affect by clicking with the mouse on the buttons in the terminal 
picture or using the keyboard. On a touch screen terminal you click direct-
ly on the screen. 

The Applet application is a jar-file in the terminal file system, in the HTML 
directory, and is transferred to the terminal via FTP. The file is unpacked 
when the Web page it is linked to is activated, see the following example. 
The communication with the terminal is done with the Terminal control 
function (port 6001 predefined). The port number can be configured in the 
source code for the Web page via a parameter in the applet application. It 
is also possible to change the background color behind the terminal pic-
ture on the Web page. You connect to the WWW server in the terminal by 
entering the IP address in the browser. When the Web page is loaded you 
will find a terminal symbol with the text Terminal Interaction. The applet 
application starts when you click on the symbol. Now a login dialog is 
shown. If the login is defined for the Terminal control function entered, 
user parameters are verified with the users defined under Accounts. 
Otherwise you do not need to state anything in this dialog. 

Example
<applet

code=TERMAPPL.class
archive=”e900appl.jar”
width=117
height=101>
<param name=TermCtrlPort value=”6001”>
<param name=Background value=”DB66FF”>

</applet>
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19.4 Web server
A Web server is a program that, using the client/server model and the 
World Wide Web’s Hypertext Transfer Protocol (HTTP), serves the files 
form Web pages to Web users (whose computers contain HTTP clients 
that forward their requests). Every computer (terminal) on the Internet 
that contains a Web site must have a Web server program. 

SSI script (server-side include)
A server-side include is a variable value (for example a file) that a server 
can include in an HTML file before it is sent to the requestor. If you create 
a Web page, you can insert an attached statement in the HTML file that 
looks like this: 

<!--#echo var=”LAST_MODIFIED”-->

To show values from the terminal on Web pages we support the following 
SSI script. 

Note!
If the “background value” parameter is used the value filed must be filled in with a RGB 
color code. The value field must not be empty.

Name Parameters Description Example

get_ipaddr.fn None Shows the IP 
address for the 
Web server. 
Used in CGI 
script

<!--#exec cgi=”get_ipaddr.fn”-->

get_domainna
me.fn

None Shows the Web 
server domain 
name

<!--#exec cgi=”get_domainname.fn”--
>
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get_date.fn Date for-
mat e.g. 
MM/DD/
YY
YY-MM-DD
If no for-
mat is state 
the termi-
nal setting 
is used

Shows the 
date in the 
terminal 

<!--#exec cgi=”/get_date.fn MM/
DD/YY”-->

get_time.fn Time format 
e.g. 
HH:MM:SS
HH:MM
If no for-
mat is 
stated the 
terminal 
setting is 
used

Shows the time 
in the terminal

<!--#exec cgi=”/get_time.fn 
HH:MM”-->

get_device.fn X, Y, Z
X=device
Y=presenta-
tion format 
(see sepa-
rate table)
Z=length

Shows the 
device value 
from the PLC-
system.

<!--#exec cgi=”/get_device.fn D5”-->
<!--#exec cgi=”/get_device.fn 
D5LH”-->
<!--#exec cgi=”/get_device.fn M7”--
>
<!--#exec cgi=”/get_device.fn 
D9ST,30”-->
<!--#exec cgi=”/get_device.fn 
D0AR,10”-->

get_diag.fn None Shows the 
diagnostic 
page of the 
terminal 

<!--#exec cgi=”/get_diag.fn”-->

get_mode.fn None Shows the 
mode of the 
terminal: RUN/
PROG/SETUP/
TRANSFER

<!--#exec cgi=”/get_mode.fn”-->

Name Parameters Description Example
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Presentation format for get_device.fn

Name Length Description Example

None None Shows the 
value as signed 
16-bit

<!--#exec cgi=/get_device.fn D1”-->

+ None Shows the 
value as 
unsigned 16-bit

<!--#exec cgi=/get_device.fn D3+”-->

L None Shows the 
value as signed 
32-bit

<!--#exec cgi=/get_device.fn D7L”-->

L+ None Shows the 
value as 
unsigned 32-bit

<!--#exec cgi=/get_device.fn D2L+”-->

RB None Shows the 
value as 32-bit 
float BCD 
(MELSEC, 
SIMATIC)

<!--#exec cgi=/get_device.fn D10RB”-->

RF None Shows the 
value as 32-bit 
IEEE float

<!--#exec cgi=/get_device.fn D8RF”-->

RD None Shows the 
value as 32-bit 
IEEE float with-
out exponent

<!--#exec cgi=/get_device.fn D1RD”-->

SB None Shows the 
value as 16-bit 
BCD

<!--#exec cgi=/get_device.fn D3SB”-->

LB None Shows the 
value as 32-bit 
BCD

<!--#exec cgi=/get_device.fn D7LB”-->

SH None Shows the 
value as 16-bit 
HEX

<!--#exec cgi=/get_device.fn D2SH”-->

LH None Shows the 
value as 32-bit 
HEX

<!--#exec cgi=/get_device.fn D1LH”-->

AR Number of val-
ues to be 
shown

Shows the 
value as signed 
16-bit

<!--#exec cgi=/get_device.fn 
D5AR,10”-->
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Automatic updating
Normally the Web page is not automatically updated. By adding the fol-
lowing, however, you create automatic updating. 

<META HTTP-EQUIV=”Refresh”CONTENT=”5”>

CONTENT states how often the page will be updated (in seconds).

Example of a Web page with SSI script
<HTML>
<HEAD>
<META HTTP-EQUIV=”Refresh”CONTENT=”1”>
</HEAD>

<!--#exec cgi="/get_ipaddr.fn"--><BR>
<!--#exec cgi="/get_domainname.fn"--><BR>
<BR>
Some IO:<BR>
<!--#exec cgi="/get_date.fn MM/DD/YY"--><BR>
<!--#exec cgi="/get_time.fn HH:MM"--><BR>
D5 = <!--#exec cgi="/get_device.fn D5"--><BR>
M7=<!--#exec cgi="/get_device.fn M7"--><BR>
D9 (string) = <!--#exec cgi="/get_device.fn D9ST,30"--><BR>
D0-D9 =<!--#exec cgi="/get_device.fn D0AR, 10"--><BR>
D8013 = <!--#exec cgi="/get_device.fn D8013"--><BR>

</HTML>

ST Number of 
characters in 
the string

Shows a num-
ber of regis-
ters as string

<!--#exec cgi=/get_device.fn D9ST,30”-
->

Name Length Description Example
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CGI script (common gateway interface)
The common gateway interface (CGI) is a standard way for a Web server 
to pass a Web user’s request to an application program and to receive data 
back and forward it to the user. When the user requests a Web page (for 
example, by clicking on a highlighted word or entering a Web site ad-
dress), the server sends back the requested page. When a user fills out a 
form on a Web page and sends it in, it usually needs to be processed by an 
application program. The Web server typically passes the form informa-
tion to a small application program that processes the data and may send 
back a confirmation message. This method for passing data back and forth 
between the server and the application is called the common gateway in-
terface (CGI). It is part of the Web’s HTTP protocol. 

To change values in the terminal we support the following CGI script:

Name Parameters Description Example

set_date.fn Date format 
e.g. MM/DD/
YY
YY-MM-DD
If no format is 
stated the ter-
minal setting is 
used

Used together 
with FORM to 
set the date in 
the terminal.

<FORM ACTION="http://<!--
#exec cgi="/get_ipaddr.fn"-->/
set_date.fn" METHOD="POST">
<INPUT SIZE=10
MAXLENGTH=10
NAME="YY:MM:DD">
<INPUT TYPE="submit" 
VALUE="Submit">
</FORM>

set_time.fn Time format 
e.g.
HH:MM:SS
HH:MM
If no format is 
stated the ter-
minal setting is 
used

Used together 
with FORM to 
set the time in 
the terminal.

<FORM ACTION="http://<!--
#exec cgi="/get_ipaddr.fn"-->/
set_time.fn" METHOD="POST">
<INPUT SIZE=10
MAXLENGTH=10
NAME="HH:MM:SS">
<INPUT TYPE="submit" 
VALUE="Submit"> 
</FORM>
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set_device.fn XY
X = device
Y = presenta-
tion format 
(see separate 
table)
e.g. D0L+
D5SH

Used together 
with FORM to 
set an device 
in the PLC sys-
tem.

<FORM ACTION="http://<!--
#exec cgi="/get_ipaddr.fn"-->/
set_device.fn" 
METHOD="POST">
<INPUT SIZE=10
MAXLENGTH=10
NAME="D0L">
<INPUT TYPE="submit" 
VALUE="Submit"> 
</FORM>

set_mode.fn RUN
PROG
SETUP
TRANSFER

Used together 
with FORM to 
set the termi-
nal mode.

<FORM ACTION="http://<!--
#exec cgi="/get_ipaddr.fn"-->/
set_mode.fn" METHOD="POST">
<SELECT NAME="MODE">
<OPTION VALUE="RUN">Run
<OPTION VALUE="PROG">Prog
<OPTION 
VALUE="SETUP">Setup
<OPTION VALUE="TRANS-
FER">Transfer
</SELECT>
<INPUT TYPE="submit" 
VALUE="Submit">
</FORM>

Name Parameters Description Example
19-13



Network functions in the terminal

19-14
Presentation format for set_device.fn

push_key.fn (see separate 
table)

Used to simu-
late pressing a 
on the termi-
nal. 

<FORM ACTION="http://<!--
#exec cgi="/get_ipaddr.fn"-->/
push_key.fn" METHOD="POST">
<SELECT NAME="F2">
<OPTION VALUE="SET">Set
<OPTION 
VALUE="RESET">Reset
<OPTION VALUE="TOGGLE">Tog-
gle
</SELECT>
<INPUT TYPE="submit" 
VALUE="Submit"> 
</FORM>
<FORM ACTION="http://<!--
#exec cgi="/get_ipaddr.fn"-->/
push_key.fn" METHOD="POST">
<INPUT SIZE=1
MAXLENGTH=1
NAME="Key">
<INPUT TYPE="submit" 
VALUE="Submit">
</FORM>

Name Description

None Sets the value as signed 16-bit

+ Sets the value as unsigned 16-bit

L Sets the value as signed 32-bit

L+ Sets the value as unsigned 32-bit

RB Sets the value as 32-bit float BCD (MELSEC, SIMATIC)

RF Sets the value as 32-bit IEEE float

RD Sets the value as 32-bit IEEE float without exponent

SB Sets the value as 16-bit BCD

LB Sets the value as 32-bit BCD

SH Sets the value as 16-bit HEX

LH Sets the value as 32-bit HEX

ST Sets a number of registers as a string

Name Parameters Description Example
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Parameters for push_key.fn

Parameter Description Example

KEY Can state the 
values: 
A-Z
0-9
ACK
LIST
MAIN
PREV
BACKSPACE
ENTER
UP
DOWN
LEFT
RIGHT

<FORM ACTION="http://<!--#exec cgi="/
get_ipaddr.fn"-->/push_key.fn" 
METHOD="POST">
Key = <SELECT NAME="Key">
<OPTION VALUE="ENTER">Enter
<OPTION VALUE="A">A
<OPTION VALUE="B">B
<OPTION VALUE="1">1
<OPTION VALUE="2">2
<OPTION VALUE="3">3
<OPTION VALUE="UP">Up
<OPTION VALUE="DOWN">Down
<OPTION VALUE="LEFT">Left
<OPTION VALUE="RIGHT">Right
<OPTION VALUE="PREV">Prev
</SELECT>
<INPUT TYPE="submit" VALUE="Submit"> <P>
</FORM>

F1-F22 Can state the 
values: 
SET
RESET
TOGGLE

<FORM ACTION="http://<!--#exec cgi="/
get_ipaddr.fn"-->/push_key.fn" 
METHOD="POST">
<SELECT NAME="F2">
<OPTION VALUE="SET">Set
<OPTION VALUE="RESET">Reset
<OPTION VALUE="TOGGLE">Toggle
</SELECT>
<INPUT TYPE="submit" VALUE="Submit">
</FORM>
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Example on a Web page with SSI and CGI script:
<HTML>

<FORM ACTION="http://<!--#exec cgi="/get_ipaddr.fn"-->/
set_date.fn" METHOD="POST">

Set date here (YY:MM:DD):

<INPUT SIZE=10

       MAXLENGTH=10

       NAME="YY:MM:DD"

       VALUE="<!--#exec cgi="/get_date.fn"-->">

<INPUT TYPE="submit" VALUE="Submit"> <P>

</FORM>

<FORM ACTION="http://<!--#exec cgi="/get_ipaddr.fn"-->/
set_time.fn" METHOD="POST">

Set time here (HH:MM:SS):

<INPUT SIZE=10

       MAXLENGTH=10

       NAME="HH:MM:SS"

       VALUE="<!--#exec cgi="/get_time.fn"-->">

<INPUT TYPE="submit" VALUE="Submit"> <P>

</FORM>

<FORM ACTION="http://<!--#exec cgi="/get_ipaddr.fn"-->/
set_device.fn" METHOD="POST">

D0 =

<INPUT SIZE=10

       MAXLENGTH=10

       NAME="D0"

       VALUE="<!--#exec cgi="/get_device.fn D0"-->">

<INPUT TYPE="submit" VALUE="Submit"> 

</FORM>

</HTML>
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Save HTML files with FTP
To save HTML files in the terminal you use a standard FTP client software 
(see the section FTP server).

The files are stored in the HTML directory in the terminal.

The name of the files must be in DOS 8.3 format i.e. the name can contain 
max 8 characters and the extension must be HTM.

Note! 
The file INDEX.HTM must be available.
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19.5 Recommendations and limitations for 
network communication

To make the communication between terminals and controller systems in 
a terminal network (BDTP network) quick and efficient, it is important to 
optimize the transfer of signals in the network. Read the chapter “Efficient 
communication” and follow the rules described to optimize the network 
functionality in the terminals. The maximum number of signals that can 
be transferred in a terminal network are 3000.

Example 1
A terminal network consist of three clients and one server. Each client has 
access to 1000 signals which means that the server provides the clients 
with 3000 signals. This is valid even if the address areas for the signals in 
each client are in accordance with each other. Accordingly it is not possible 
to transfer more signals in this terminal network.

Example 2
The server collect all addresses the clients are asking for. Therafter the 
server asks for the status of the controller system that is to be distributed 
to respective client.

Example

A terminal network (BDTP network) consists of one server and five cli-
ents. Each terminal contains 50 alarms with the same address. For the 
server, this means that 50 addresses must be checked with the controller 
system. The server shall then distribute 50 alarms to respective client 
(5x50). This means that the server distribute 250 alarms.
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Transparent mode
To be able to make the Transparent mode function (see also the chapter 
“Communication”) work in a terminal network with communication via 
the TCP/IP protocol the following demands must be met.

– The driver and its programming tool must support communication in 
Transparent mode. For information we refer to the manuals for the 
driver and controller system and also the chapter “Communication” in 
this manual.

– A PC program for COM port to TCP/IP redirection must be used in the 
PC communication with the controller system in Transparent mode via 
the TCP/IP network.

The programming tools MELSEC MEDOC and MELSEC MEDOC plus for 
PLC systems from Mitsubishi Electric support Transparent mode commu-
nication in TCP/IP network with MELSEC PLC systems according to the 
following table.

No protocol mode
The No protocol mode function (see the chapter “Communication”), 
when the terminal is used as communication interface, is not recommend-
ed to be used in terminal networks (BDTP networks). A BDTP network is 
a network where many signals are transferred between the server and cli-
ents. When the terminal is used as a communication interface, control reg-
isters and control signals are transferred and they affect the 
communication time and the performance of the network. See also the sec-
tion Efficient communication in the chapter “General”.

Programming tool PLC system

MELSEC MEDOC All MELSEC PLC-system except QnA-CPU and QnA-C24

MELSEC MEDOC plus MELSEC A C24, MELSEC FX-series
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Packing of signals
To make the communication between terminals and controller systems in 
a terminal network (BDTP network) quick and efficient it is important to 
optimize the transfer of signals in the network. Read the section Efficient 
communication in the chapter “General”and follow the rules described to 
optimize the network functionality in the terminals. This is valid for all 
stations in a terminal network. If you do not use packing of signals, the 
time between updates of stations in the network will increase.

Alarm handling
The terminal network is a Client/Server network. Servers provide data, 
for example, alarm signals to Clients. Many different signals affects the 
communication time between terminals and controller systems in the net-
work. This means that it is expedient to limit the number of signals affect-
ing the communication. For more information see the section Efficient 
communication in the chapter “General”. The number of alarm signals in 
the network cannot exceed what one server can handle in the network. 
One server can handle between 100 to 300 alarms, depending on applica-
tion and terminal, consequently the network cannot contain more than 
100 to 300 alarms. 



LEDs
20 LEDs

The E900 has 20 LEDs built in, ten are located near the function keys and 
ten are independent. The LEDs are connected to a registers defined under 
LED in the Functions menu. The content of the register determines the 
color and any blinking of the LED according to the following table.

20.1 External LEDs in E900 VT

Register value 
(Hex)

Register value 
(Dec)

Blinking 
frequency (Hz)

Color

00 0 - None

01 1 - Green

02 2 - Red

11 17 5 Green

12 18 5 Red

21 33 2.5 Green

22 34 2.5 Red

31 49 1.2 Green

32 50 1.2 Red

41 65 0.6 Green

42 66 0.6 Red
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The terminal E900 VT has 28 external LEDs, supported by the built in ex-
pansion card IFC 64E. This expansion card is automatically selected at slot 
1 when the terminal E900 VT is chosen in project settings in the File menu.

This extra built-in LEDs can only be connected to digital I/O signals, bit 
devices, and can not get analog values from the terminal.

To type in the desired start I/O for the LEDs, right click on IFC 64E in Pe-
ripheral configuration under Peripherals in the Setup menu.

The expansion card IFC 64E handles 32 LEDs, the terminal E900 VT only 
use 28. There are 32 digital signals reserved consecutive from the startad-
dess. The LEDs are grouped together in 4 groups with 7 LEDs in each 
group, which results in that the last signal in each group of 8 is not used. 
If the start address is M1 then address M8, M6, M24 and M32 are not used 
for the extra LEDs, they are yet reserved for the interface (IFC 64E) and 
should not be used for anything else. See also this following example.



LEDs
Start I/O: M50
Last occupied I/O: M81
I/O for last LED: M80

M50 M58

M66 M74 M80
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21 Function keys

This section describes how to use the function keys. A function key is 
linked to a signal (e.g. M100) or a function by writing in its address after 
each key. The signal linked to a function key is activated according to the 
function linked to the key when it was defined.

E900 has 22 function keys (F1 to F22) built in.

E900

21.1 Definitions
There are two ways of defining the function keys; globally or locally. Global 
function keys are defined and used in the whole application, that is they 
apply in all the blocks. Local function keys are defined and used in a sin-
gle block. A global definition is always available in the run-time mode as-
suming that the block shown on the display does not have a local 
definition for the function key in question. Local definitions have a higher 
priority than global ones. Function keys are defined under Function keys 
in the Functions menu. Local function keys are defined in the block head-
er for current block under F-keys.

Note!
It is only possible to affect two signals linked to function keys at the same time. If more 
than two function keys are pressed at the same time it is only the two pressed first that 
are affected. 

F1

F2

F3

F4

F9

F5

F6

F7

F8

F10 F11 F12 F13 F14 F15 F16

7
ABCD

8
EFGH

9
IJKL

4
MNOP

5
QRST

6
UVWX

1
YZ!?

2
C1-C4

3
<> ()

-
+/*=

0
%#:

.
·o

↵←
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Function Description

IO The signal activated with the function key.

Event How the key affects the current digital signal.
Momentary means that the signal is set as long as the key is 
active. 
Toggle means that the signal is set and reset respectively 
when the key is activated.
Set means that the signal is set when the key is activated 
and remains set.
Reset means that the signal is reset when the key is acti-
vated and remains reset.
Grouped means that all signals linked to a function key with 
current group number are reset. The group number is entered 
under Value. A group can contain max 8 function keys. 
Set Analog means that the analog signal linked to the func-
tion key is given the value entered under Value.
Inc Analog means that the analog signal linked to the func-
tion key shall increase the value with the value entered under 
Value. 
Dec Analog means that the analog signal linked to the func-
tion key shall decrease the value with the value entered 
under Value.

Set analog object to Sets selected analog object to entered value.

Increment analog 
object with or set dig-
ital object

Increases the value of an maneuverable analog object with 
entered value or sets a selected digital object.

Decrement analog 
object with or reset 
digital object

Decreases the value of an maneuverable analog object with 
entered value or sets a selected digital object.

Set digital object 
momentarily

Sets selected digital object as long as the key is pressed.

Jump to block Jumps to the block with number nnn.

Security level Function keys can be defined with a security level. The secu-
rity level means that the operator must log in with a pass-
word for the same or a higher security level to be able to use 
the function key.

Fxx The function key linked to one of the functions.
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Other functions for Function keys

Function Description

Load recipe Load recipe from the memory of the terminal.

Save recipe Save recipe into the memory of the terminal.

Delete recipe Erase recipe from the memory of the terminal.

Login to specified 
security level

Logging in.

Logout Logging out.

Change login pass-
word

Change password.

Scroll one page up Scrolling the pages in text blocks and in the alarm list.

Scroll one page down Scrolling the pages in text blocks and in the alarm list.

Zoom up text size Increase the text size in the alarm list.

Zoom down text size Reduce the text size in the alarm list.

Save recipe on mem-
ory card

Save recipe on the memory card defined as backup.

Load recipe from mem-
ory card

Load recipe from the memory card defined as backup.

Erase recipe on mem-
ory card

Erase recipe from the memory card defined as backup.

Save project on mem-
ory card

Save project on the memory card defined as backup.

Load project from 
memory card

Load project from the memory card defined as backup.

Erase project on mem-
ory card

Erase project from the memory card defined as backup.

Acknowledge alarm Acknowledges alarms in the alarm list.

Show alarm list Shows the alarm list (block 990).

Jump to info block 
connected to the 
alarm

Jump to a block connected to the alarm. See the chapter 
“Alarm handling”.

List alarm groups Select from which alarm group alarms will be shown in the 
alarm list.

Return to previous 
block

Show the previous block, works for nine levels. When return-
ing to block 0 you cannot jump to the previous block using 
this function. If login in run-time is done on a higher security 
level than current level this function cannot be used for block 
jump.
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21.2 Jump to block with the function keys
This function makes it possible to use the function keys for jumping to 
blocks without using the Display signal. When the key is defined, locally 
or globally, you select Jump to block in the list of options. Changing block 
via function keys is the easiest way to change block. This method does not 
use any digital signal in the controller system.

21.3 External function keys in E900 VT

Junp to main block 
(block0)

Show the start block, block number 0.

Show object info Shows the min. and max. values for analog objects in the 
Textblock in the run-time mode.

Enter Correspond to the Enter key.

Show diagnostics 
page

Shows the information page. See the chapter “Terminal func-
tions”.

TCPIP Connect Initiate contact at serial connection.

TCPIP Disconnect Disconnect serial connection.

Function Description
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The terminal E900 VT has 28 external function keys, supported by the 
built-in expansion card IFC 64E. This expansion card is automatically se-
lected at slot 1 when the terminal E900 VT is chosen in Project settings in 
the File menu.

These extra function keys can only be connected to digital I/O signals, bit 
devices, and can not be used as the other, ordinary function keys.

To type in the desired start I/O for the function keys, right click on IFC 64E 
in Peripheral Configuration under Peripherals in the Setup menu.

The expansion card IFC 64E handles 32 function keys, the terminal E900 
VT only use 28. There are 32 digital signals reserved consecutive from the 
start address. The function keys are grouped together in 4 groups with 7 
keys in each group, which results in that the last signal in each group of 8 
is not used. If the start address is M1 then address M8, M6, M24 and M32 
are not used for the extra function keys, they are yet reserved for the inter-
face (IFC 64E) and should not be used for anything else. See also this fol-
lowing example:



Function keys
Start I/O: M50
Last occupied I/O: M81
I/O for last LED: M80

M50 M58

M66 M74 M80
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22 Expansion cards

In the terminals there is a possibility to connect different expansion cards 
to increase the communication possibilities.

22.1 IFC PBDP
With the IFC PBDP expansion card the terminal can be connected to and 
communicate as a slave with a Profibus network. For information about 
how to set up the card, see the manual for the product. For information 
about how to configure a Profibus network, see the manual for Profibus 
network. 

22.2 IFC MC
With the IFC MC expansion card you can connect a PCMCIA memory 
card to the terminal. You can select to use the memory card to expand the 
project memory, use it as back up or for moving files between terminals. 
For further information refer to the manual for IFC MC.

22.3 IFC 128E
IFC 128E is an expansion card for connection of external function keys or 
switches. Up to 128 external function keys/switches can be used. For 
further information see the manual for the product.

22.4 IFC ETTP and IFC ETCX
The IFC ETTP and IFC ETCX expansion cards are cards for network com-
munication using TCP/IP via a twisted cable or coaxial cable. For further 
information, see the manual for IFC ETTP and IFC ETCX.
22-1



Expansion cards

22-2
22.5 IFC PI
IFC PI is an expansion card which makes it possible to connect a printer in 
parallel with the terminal. The RS-232 port on the expansion card cannot 
be used for external communication. For further information see the man-
ual for IFC PI.

22.6 IFC GA
IFC GA is an expansion card which makes it possible to connect a bus con-
nection module, A7GT-BUS-EUN/A7GT-BUS2-EUN, to the terminals 
E900 T, E900 VT and E910 T. IFC GA supports bus connection on PLC type 
MELSEC AnA, AnS, AnSH, AnU, QnA and QnAS. For further informa-
tion see the manual for IFC GA.
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23 Project transfer

The project must be transferred from the PC to the terminal in order to be 
used in the terminal. 

Connect the PC with MAC Programmer+ to the terminal via the cable 1/
CAB5 or CAB6 cable, see the table below. 

Name Continentaleurope GB Rest of the world

Cable 1 MAC-PC-CAB-R2 MAC-PROG/9-CAB MAC-PROG/9-CAB

Terminal

Personal computer

RS-422 RS-232

Cable 1/CAB5

Terminal

Personal computer

RS-422 RS-232

CAB6
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23.1 Terminal settings
The transfer parameters are set in the terminal in configuration mode un-
der Setup, Port Parameters, MP.

23.2 Transfer settings
The transfer is controlled from the MAC Programmer+. In the menu 
Project Transfer you can select what is to be transferred. 

Note!
The communication settings must be the same in the PC software as in the terminal.

Parameter Description

Percent com-
plete

Shows the status of the transfer during transfer.

Byte count Shows the number of bytes transferred during transfer.

Time elapsed Shows elapsed time since one of the function’s sent, received or ver-
ified was activated.
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Status Shows which part of the project that is transferred. For example 
Setup, block, alarm groups, symbols and function keys. 

Info Display the defined driver that will be sent to the terminal.

Retries When the transfer fails, the PC software makes a number of retries 
before the transfer is shut down.

Terminal ver-
sion

When contact is established with the terminal, current terminal type 
and program version are displayed here.

Test project on 
send

Automatically tests the project during transfer.

Automatic
terminal 
RUN/Transfer 
switching

The terminal is automatically put in transfer mode and will return to 
the previous mode after transfer.

Check termi-
nal version

Checks the terminal version and gives a warning if the project and 
the terminal do not match.

Send complete 
project

Select if you want to transfer the whole project.

Partial send 
options

None: No blocks are sent to the terminal.
All: All blocks are sent to the terminal.
From To: State an interval of blocks to be sent to the

terminal.
Alarms: Select if alarms shall be sent to the terminal.
Symbols: Select if symbols shall be sent to the terminal.
Time channels Select if time channels shall be sent to the 

terminal.
LED’s Select if LEDs shall be sent to the terminal.
Message library Select if message library shall be sent to the 

terminal.
Setup Select if the setup shall be sent to the terminal.
Function keys Select if function keys shall be sent to the terminal.
Passwords Select if passwords shall be sent to the terminal.

Delete Trend data: Delete all stored trend data in the terminal.
Recipe data: Delete all stored recipe data in the terminal.

Download 
driver

Never: Driver will never be downloaded.
Always: Driver will always be downloaded.
Automatic: Driver will be downloaded to the terminal when the

driver in the terminal and the driver defined in 
current project are not the same.

Send current 
time

The clock in the personal computer will be sent to the terminal.

Send Transfer the project to the terminal according to current settings.

Parameter Description
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The communication parameters are set under Comm Settings in the 
Transfer menu or by choosing Settings in the Project Transfer dialog. 

Receive The PC software loads the project in the terminal. Current project in 
the PC software will be overwritten.

Verify Compares the project in the PC software with the project in the ter-
minal.

Stop Interrupt the transfer.

Settings Select if TCP/IP transfer or Serial transfer. If you select TCP/IP 
transfer no further settings are necessary. If you select Serial trans-
fer the parameters described in the table below must be stated.

Parameter Description

Use TCP/IP 
transfer

Select if the project shall be transferred via TCP/IP.

Use serial 
transfer

Select this if you want to use serial transfer of the project.

Port Select communication port.

Baudrate Baudrate (bits/second).

Timeout Number of milliseconds between retries.

Retries Number of retries before the transfer is shut down.

Parity Select type of parity control.

Databits Select number of data bits. Must be 8 bits.

Parameter Description
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23.3 TCP/IP transfer
When transferring via TCP/IP you need to select Use TCP/IP transfer in 
the Comm Settings dialog in the Transfer menu. When you press Send in 
the Project transfer dialog the following dialog is shown.

Host address
State the IP address of the terminal you want to transfer to.

Terminal Control port
State the TCP/IP-port number for RUN/TRANSFER switching. Need not 
normally be changed. Default is 6001.

Transfer port
State the TCP/IP-port number for transferring. Need not normally be 
changed. Default is 6000.

Stopbits Select number of stop bits.

Speed set
manually

Used when communication is via a modem. You must set the 
baudrate in the terminal and PC software manually and they must be 
the same.

Note!
Communication can fail if other programs are running under Windows at the same time 
as the transfer takes place. Failure is avoided by shutting down the other programs.
During block transfer, links to relevant symbols are included. If the symbols are not 
transferred, problems may occur.

Parameter Description
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User ID
State a user name used during RUN/Transfer switching authentication. 
Not needed if the terminal is already in transfer mode.

Password
State a password used during RUN/Transfer switching authentication. 
Not needed if the terminal is already in transfer mode.

Save password in project
Saves the password and user ID so that you do not need to enter it next 
time.

23.4 Serial transfer
When serial transfer is used you need to select Use serial transfer in the 
Comm Settings dialog in the Transfer menu. When you press Send in the 
Project Transfer dialog the project will be sent to the terminal.
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23.5 Transfer via modem
Settings when using modem communication between a PC and an opera-
tor terminal.

Modem settings
Make the settings on the modem connected to the operator terminal as 
follows:

AT &F E0 Q1 &D0 &K0 &W

Make the settings on the modem connected to the PC as follows:

AT &F &D0 &K0 &Q0 &W

The table below describes the modem commands.

Command Description

AT Inform the modem that a command follows. Each command shall 
be proceeded by AT.

&F Load the default settings

E0 Echo off

Q1 Command answer off

&D0 The modem ignores the DTR signal

&K0 No flow control

&Q0 Direct asynchronous mode

&W Save settings

Note!
If other programs are running under Windows at the same time as project transfer it may 
occur communication error. Avoid the error by closing down other programs. Links to 
symbols in the blocks are transferred with the blocks.
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Communication at selectable speed
1. Configure the modem.

2. Make the communication settings in the Comm settings dialog under 
Transfer in MAC Programmer+.

3. Set Baudrate, parity, data bits, stop bits and select Speed set manually.

4. Set the communication parameters in the terminal in the same way as 
in the MAC Programmer+ (Setup – Port parameters – MP)

5. Set the terminal in Transfer mode.

6. Use HMI Tools Modem program to make the call up.



Project transfer
7. Then you select Transfer in MAC Programmer+.

Do not select Automatic terminal RUN/TRANSFER switching.
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Automatic transfer
1. Configure the modem.

2. Make the communication settings in the Comm settings dialog under 
Transfer in MAC Programmer+. The baudrate must be 2400 baud.

3. Use HMI Tools modem program to make the call up.



Project transfer
4. Then you select Transfer in MAC Programmer+.

Note!
If Auto terminal RUN/TRANSFER switching is used the baudrate must be set to 2400 
baud.
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24 Technical data

E900 T

Parameter Data

Front panel Width 367 x Height 274 x Depth 6.0 mm

Mounting depth Excl. D-sub: 90 mm
Incl. D-sub: 110 mm.

Front panel seal IP 65

Rear panel seal IP 20

Keyboard material Membrane keyboard with polyester snap discs. Overlay film 
of Autotex 2 F200 with print on reverse side. 1 million opera-
tions. 

Reverse side material Yellow-crome-plated steel plate.

Weight Excl. D-sub: 3.5 kg

Serial port RS-422 25-pin D-sub contact, chassis mounted female with standard 
locking screws 4-40 UNC.

Serial port RS-232 9-pin D-sub contact, chassis mounted male with standard 
locking screws 4-40 UNC.

Expansion slots 2 built-in expansion slots.

Display TFT display, 640x480 pixel, 256 colors, graphic and text. 
Back light: lifetime 25000 h at an ambient temperature of 
+25°C.

Active area of display B x H, 211.2 x 158.4 mm

Memory Flash memory, 2 Mb.

Real-time clock ±10 PPM + error because of ambient temperature and supply 
voltage. Total max error 1 min/month= 12min/year. Mini-
mum life: 10 years of the battery for the real-time clock.

Supply voltage 100-240 VAC

Current consumption 
at rated voltage

Max: 0.35 A.

Ambient temperature +0° to +50°C.

Storage temperature -20° to +60°C.

Relative humidity Max 85% non-condensing.

EMC tests on the 
terminal

The terminal conforms with the essential protection require-
ments in article four of the 89/336/EEC directive. Noise 
tested according to: EN50081-2 emission and EN50082-2 
immunity. 
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E900 VT

Parameter Data

Front panel Width 335 x Height 430 x Depth 6.0 mm

Mounting depth Excl. D-sub: 90 mm
Incl. D-sub: 110 mm.

Front panel seal IP 65

Rear panel seal IP 20

Keyboard material Membrane keyboard with polyester snap discs. Overlay film 
of Autotex 2 F200 with print on reverse side. 1 million opera-
tions. 

Reverse side material Yellow-crome-plated steel plate.

Weight Excl. D-sub: 4.0 kg

Serial port RS-422 25-pin D-sub contact, chassis mounted female with standard 
locking screws 4-40 UNC.

Serial port RS-232 9-pin D-sub contact, chassis mounted male with standard 
locking screws 4-40 UNC.

Expansion slots 1 built-in expansion slot.

Display TFT display, 640x480 pixel, 256 colors, graphic and text. 
Back light: lifetime 25000 h at an ambient temperature of 
+25°C.

Active area of display B x H, 211.2 x 158.4 mm

Memory Flash memory, 2 Mb.

Real-time clock ±10 PPM + error because of ambient temperature and supply 
voltage. Total max error 1 min/month= 12min/year. Mini-
mum life: 10 years of the battery for the real-time clock.

Supply voltage 100-240 VAC

Current consumption 
at rated voltage

Max: 0.35 A.

Ambient temperature +0° to +50°C.

Storage temperature -20° to +60°C.

Relative humidity Max 85% non-condensing.

EMC tests on the ter-
minal

The terminal conforms with the essential protection require-
ments in article four of the 89/336/EEC directive. Noise 
tested according to: EN50081-2 emission and EN50082-2 
immunity. 
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E910 T

Parameter Data

Front panel Width 290 x Height 247x Depth 5.0 mm

Mounting depth Excl. D-sub: 109 mm
Incl. D-sub: 130 mm.

Front panel seal IP 65

Rear panel seal IP 20

Keyboard material Membrane keyboard with polyester snap discs. Overlay film 
of Autotex 2 F200 with print on reverse side. 1 million opera-
tions. 

Reverse side material Yellow-crome plated steel plate.

Weight Excl. D-sub: 3.3 kg

Serial port RS-422 25-pin D-sub contact, chassis mounted female with standard 
locking screws 4-40 UNC.

Serial port RS-232 9-pin D-sub contact, chassis mounted male with standard 
locking screws 4-40 UNC.

Expansion slots 2 built-in expansion slots.

Display TFT display, 640x480 pixel, 256 colors, graphic and text. 
Back light: lifetime 25000 h at an ambient temperature of 
+25°C. Touch screen

Active area of display B x H, 211.2 x 158.4 mm

Memory Flash memory, 2 Mb.

Real-time clock ±10 PPM + error because of ambient temperature and supply 
voltage. Total max error 1 min/month= 12min/year. Mini-
mum life: 10 years of the battery for the real-time clock.

Supply voltage 100-240 VAC

Current consumption 
at rated voltage

Max: 0.35 A.

Ambient temperature +0° to +50°C.

Storage temperature -20° to +60°C.

Relative humidity Max 85% non-condensing.

EMC tests on the ter-
minal

The terminal conforms with the essential protection require-
ments in article four of the 89/336/EEC directive. Noise 
tested according to: EN50081-2 emission and EN50082-2 
immunity. 
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24.1 Membrane keyboard

Solvent resistance and enviromental data for Autotex 2
Autotex 2 withstands exposure of more than 24 hours duration under DIN 
42 115 Part 2 to the following chemicals without visible change:

Ethanol Formaldehyde 37%-42% 1.1.1. Trichloroethane 
(Genklene)

Cyclohexanol Acetaldehyde Ethylacetate

Diacetone alcohol Aliphatic hydrocarbons Diethyl ether

Glycol Toluene N-Butyl acetate

Isopropanol Xylene Amylacetate

Glycerine White spirit Butycellosolve

Methanol Fromic acid <50% Ether

Triacetin Acetic acid <50% Sodium hypchlorite 
<20% (Bleach)

Dowanol DRM/PM Phosphoric acid <30% Hydrogen peroxide 
<25%

Acetone Hydrochloric acid <36% Potassium carbonate

Metyl ethyl ketone Nitric acid <10% Washing powders

Dioxan Trichloracetic acid 
<50%

Fabric conditioner

Cyclohexanone Sulphuric acid <10% Ferric chloride

MIBK Cutting oil Ferrous chloride

Isophorone Diesel oil Dibutyl Phthalate

Ammonia <40% Linseed oil Dioctyl Phthalate

Caustic soda <40% Paraffin oil Sodium carbonate

Potassium hydroxide 
<30%

Blown castor oil

Alkalicarbonate Silicone oil

Bichromate Turpentine substitute



Technical data
Autotex withstands DIN 42 115 Part 2 exposure of <1 hour duration to gla-
cial acetic acid without visible change.

Autotex is not resistant to the following chemicals:

Autotex withstands 24 hours exposure to the following reagents at 50°C 
without visible staining:

Potassium ferrocya-
nide/ferricyanide

Universal brake fluid

Acetonitrile Decon

Sodium bisulphate Aviation fuel

Petrol

Teepol

Water

Sea water

Concentrated mineral acids

Concentrated caustic solution

High pressure steam at over 100°C

Benzyl alcohol

Mehylene chloride

Top Job Grape Juice Ariel Ajax

Jet Dry Milk Persil Vim

Gumption Coffee Wisk Domestos

Fantastic Lenor Vortex

Formula 409 Downey Windex
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Very slight discoloration was noted under critical viewing conditions with 
the following materials:

Enviromental data

Minimum use temperature
Tactile embossed Autotex has been tested to 0.5 million switch operations 
at -40°C (-40°F) without loss of function.

Maximum use temperature
Low moderate humidity: 85°C

High humidity (>90% RH): 40°C

Outdoor use
In common with all polyester based films, Autotex is not suitable for use 
in conditions of long-term exposure to direct sunlight.

Tomato juice

Tomato ketchup

Lemon juice

Mustard
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E900 Outline
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E900 Text strip
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24.3 Character tables

Code page 437
The first characters, 0-127, are the same as in code page 850.
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Code page 850
Characters 0-127. Note that the characters 0-30 does not work.
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Code page 850

Characters 128-255
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Code page 866
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25 Appendix

Error codes in PLC drivers

FX, ACPU and C24

QCPU driver

Error code Description

Comm Error Communication error.

File Reg Err xxxx An object tries to read a file register not configured in PLC 
parameters.

Illegal dev [x] Trying to read an invalid device type (D, X, Y...). Only C24.

Error code Description

Comm Error xxxx Communication error, see the table below.

SYSTEM ERROR
Comm Error

Communication error during start-up.

Item Content Reply status

Common Errors Sum check error (periphery only) 4000H

Cannot handle RT 4001H

Cannot handle SRT 4002H

Impossible global request command 4003H

Command not usable during system protect 4004H

Data range larger than buffer size 4005H

No password release 4006H

CID differing from CPU data 4007H

Device setting Cannot handle device name 1030H

Device range over 4031H

Cannot handle device modification 4032H

No random write possible on the designated Y 
because it is used by the system

4033H

Improper device 4034H
25-1
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Protect Hardware protection active 4050H

No execution possible because memory pro-
tect switch is ON

4051H

Others Data error 4080H

Item Content Reply status
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Index

A
Acknowledge notify,  10-3
Acknowledge required,  10-4
Alarm banner object,  6-5
Alarm editor,  5-31
Alarm group,  10-2
Alarm history,  10-4
Alarm info. block,  10-4,  10-8
Alarm message,  10-3
Alarm remote acknowledge,  10-3
Alarm,  10-1

Alarm list,  5-46
Define alarm group,  10-2
Define alarm list,  10-4
Define alarm message,  10-3
Graphic alarm page,  10-8
Maneuvering,  10-6

Align,  5-18
Alpha/numerical keyboard,  3-6
Analog clock object,  6-6
Analog fill object,  6-7
Analog objects,  6-3
Analog signals,  4-8
Append,  5-31
Arrow keys,  3-7
ASCII object,  6-8

B
Background block,  5-51
Backlight,  5-38
Bar graph object,  6-9,  7-4
Block

Create,  5-5
Block header,  5-12
Block Manager,  5-5

Settings,  5-11

Block,  4-6
Edit,  5-33
Programming,  5-12

Built-in function keys,  3-7

C
Clock

Digital,  6-12
Clock,

Analog,  6-6
Color scheme,

Change/create,  5-3
Colors,  6-1
Command line,  5-41
Communication error,  3-5
Communication,  3-5

Transparent mode,  17-1
Connect to a printer,  13-2
Contrast settings,  3-2
Coordinates,  2-2
Copy graphics,  5-22
Create insertable strip,  5-12
Create object,  5-17
Create series,  5-21
Cross reference,  5-30

Presentation,  5-30

D
Date format,  5-43
Date object,  7-5
Define block header,  5-7
Diagram object,  6-10
Digital clock object,  6-12
Digital objects,  6-3
Digital signals,  4-7
Digital symbol object,  6-15
Digital text object,  6-16,  7-6
I



Index

II
E
Editing graphic objects,  3-3
Erase memory,  3-2
Error message,  3-5
Expansion card,  22-1
External keyboard,  3-8

F
Filled object

Digital,  6-13
Function keys,  5-31,  21-1

Define,  21-1
Global,  21-1
Jump to block,  21-5
Local,  21-1

Functions menu,  5-36

G
Gain,  6-1,  7-1
Graphic alarm page,  10-8
Graphic block printout,  13-3
Graphic blocks,  4-5
Graphic objects,

Alarm banner,  6-5
Analog clock,  6-6
Analog fill,  6-7
Analog,  6-3
ASCII object,  6-8
Bar graph,  6-9
Diagram,  6-10
Digital clock,  6-12
Digital symbol,  6-15
Digital text,  6-16
Digital,  6-3
Filled object,  6-13
Jump,  6-17,  7-7
Maneuvering,  6-32
Message,  6-18
Multiple choice,  6-19

Multisymbol,  6-20
Numeric table,  6-22
Numeric,  6-21
Slide,  6-24
Speedometer,  6-25
Static objects,  6-2
TCP/IP command object,  6-26
Touch key,  6-28
Trend,  6-29
VU meter,  6-31

Graphicblock editor,  5-13
3D-Controls,  5-17
Create object,  5-17
Create series,  5-21
Cursor,  5-14,  5-15
Draft Move & Size,  5-17
Group object,  5-20
Keys,  5-14
Mouse,  5-14
Open,  5-13
Place object,  5-18
Recommendations,  5-17
Static graphics,  5-17
Toolbox,  5-15
Ungroup object,  5-20

Grid,  5-16
Group object,  5-20

H
Help line,  3-4
Historical trends,

Run-time mode,  8-2
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I
I/O change,  5-28
I/O Cross reference,  5-30
IFC MC,  22-1
IFC PBDP,  22-1
Indexaddressing,  16-1
Information page,  3-10
Insert,  5-31
Insertable strip,  5-12
Install driver,  5-2,  5-3
Internet,  5-2

J
Joystick function  3-11
Jump object,  6-17,  7-7
Jump to block,  21-5

K
Key delay time,  5-45
Key repeat,  5-45
Key sequences,  3-8
Keyboard

Alpha/numerical,  3-6

L
LEDs,  5-31,  20-1

Define,  20-1
Levels  4-6
Library index register,  5-40

M
MAC Programmer+,  2-1,  5-1

Edit menu,  5-33
File menu,  5-32
Functions menu,  5-36
Install,  2-1
Setup menu,  5-37
System requirements,  2-1

Trasfer menu,  5-50
View menu,  5-33
Window menu,  5-51

Maneuver objects,
Analog objects,  6-33,  7-11
Digital objects,  6-32,  7-11

Maneuverable objects,  6-32
Maneuvering graphic blocks,  6-32
Maneuvering textblocks,  7-11
Menu bar,  2-2
Menu structure,  4-5
Message library,  9-1
Message object,  6-18,  7-8
Method for programming,  4-1
Modem connection,  17-13
Modem transfer,  23-7
Multiple choice object,  6-19,  7-9
Multisymbol object,  6-20

N
Name list,  5-34
National characters,  3-6
Network communication via IFC 
ET,  18-11
Network communication,  18-1
No protocol mode,  17-5
Numeric objects,  6-21
Numeric table object,  6-22
Numeric values,  3-7

O
Offset,  6-1,  7-1
OGC,  6-2,  7-1
Operation mode,  3-1

PROG,  3-3
RUN,  3-5
SETUP,  3-2
Switch,  3-1

Operatorś pictures,  4-5
III
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IV
P
Passwords,  5-31,  12-1

Change,  12-3
Define,  12-1
Logging in,  12-3
Security levels,  12-1

PLC system,  5-2
Popup keyboard,  6-35

Control block,  5-39
PREV,  3-7
Print alarms,  10-4
Printer

Connection,  13-2
Printer settings,  5-48,  13-4
Profibus-DP,  22-1
Programming mode,  3-3
Project,

Close,  5-32
Create,  5-1,  5-32
Open,  5-32
Programming,  4-1,  5-1
Save,  5-32
Transfer,  5-50,  23-1

R
Real-time clock,

Set,  3-9
Recipe,  11-1

Create,  11-2
Erase,  11-4
Files,  11-1
HMI Tools,  11-4
Transfer,  11-2
Use recipe in a PC,  11-4
Via the PLC-program,  11-5

Report print-outs,  13-1
Define printout,  13-1
Define,  13-4
Port parameters,  13-6

Printer settings,  13-4
Reserved characters,  3-7,  5-24
RS-232,  5-47
RS-422,  5-47
Run-time mode,  3-5

S
Scaling,  6-1,  7-1
Security level,  3-7,  12-1

Define,  12-1
Password,  12-1

Select maneuverable objects,  6-32
Serial network communication,  
18-16
Serial transfer,  23-6
Setup mode,  3-2
Show terminal,  5-11
Signal format,  4-7,  4-9
Slide object,  6-24
Speedometer object,  6-25
Static graphics,  5-17
Static objects,  6-2
Status bar,  2-2
Switch between modes,  3-1
Switch between PROG/SETUP,  3-
1
Switch between RUN/PROG,  3-1
Switch between RUN/SETUP,  3-1
Symbol handling,  5-33
Symbol manager,

Create,  5-26
Delete,  5-27
Duplicate,  5-26
Edit,  5-26
Export,  5-25
Import,  5-25
More,  5-27

Symbols,
Create,  5-22

System blocks,  4-6
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System program,
Down-loading,  2-3

System signals,  5-38

T
TCP/IP command object,  6-26
TCP/IP communication,  18-1
TCP/IP transfer,  23-5
Technical data,  24-1
Terminal as communication inter-
face,  17-5
Text objects,

Analog object,  7-3
Bar graph object,  7-4
Date/time object,  7-5
Digital text,  7-6
Dynamic objects,  7-2
Message,  7-8
Multiple choice object,  7-9
Text object,  7-10

Textblock editor,
Define,  5-24
Dynamic object,  5-24
Keys,  5-23
Mouse,  5-23
Open,  5-23
Static text,  5-24
Toolbox,  5-24

Textblock printout,  13-2
Textblocks,  4-5

Maneuvering,  7-11
Tile,  5-19
Time channels,  5-31,  14-1

Define,  14-1
Maneuvering,  14-2

Time control,  14-1
Time format  5-43
Time object,  7-5
Tool box,  5-12
Touch key object,  6-28

Transfer,
Project,  23-1

Trend object,  6-29
Trend,  8-1

History,  6-34
HMI Tools,  8-5
Transferring trend data,  8-5
Trend files,  8-5
Trend object,  8-1

U
Ungroup object,  5-20
Update drivers,  5-2,  5-3
Update,  5-31

V
VU-meter object,  6-31

W
Watch-dog,  3-5
Window menu,  5-51
Working area,  5-12
V
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